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Kroll Windows 10 User Manual 
Kroll Windows 10 is an advanced prescription management solution that gives pharmacies the 

tools to handle the complexities of modern prescription dispensing. Version 10 offers a 

powerful, visually appealing approach to prescription dispensing that improves the 

productivity, efficiency, and security of your pharmacy’s operations. 

This user guide is intended for new Kroll users and explains how to navigate the software, how 

to create and manage patient, drug, and prescriber records, and how to fill and manage patient 

prescriptions. Visit http://www.kroll.ca/user-guides.html for detailed information about specific 

modules within the software. 

Logging in and out of Kroll 

This section explains how to log in and out of the Kroll Windows application. You must have 

user credentials assigned to you before proceeding. 

Logging in 

 Double-click the Kroll icon located on your desktop. 1.

 The Kroll start screen will appear. Enter your login credentials in the Initials and Password 2.
fields and click OK. 

 

NOTE: The Kroll Session Manager will be added to your Windows taskbar.  

  

http://www.kroll.ca/user-guides.html
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Logging out 

 Select File > Exit, or click the X in the top right corner of your screen. 1.

 

 A prompt will appear asking if you are sure you want to exit. Select Yes. 2.

 Another prompt will appear asking if you want to print the Dayend Label. Select Yes to print 3.
the label. 

Sample Dayend Label:  

 

a) If you answer Yes to the Dayend Label prompt, another prompt will appear asking if 
you want to get the Network Totals. Select Yes to generate the Adjudication Totals 
From Network report. 
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Sample Adjudication Totals From Network report: 
 

 

NOTE: It is not necessary to print the Dayend Label or Network Total for each session; one 
printout of each report will include all Rxs filled that day. 
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Users and Groups 

In order for pharmacy users to login and use the Kroll software, they must have a user account 

with assigned permissions. This section explains how to add and manage user accounts. 

Adding a New User 

 From the Alt-X Start screen, go to Edit > Users and Groups. 1.

 

 The Edit Users and User Groups screen will appear. Click Ins from Users tab. 2.
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 The User Information screen will appear. 3.

 

 Complete the User Information form and click Save. 4.

 Password never expires: when enabled, the password never expires. 

 Force password change on next login: when enabled, the user is forced to change the 
password on next login. 

NOTE: Users are forced to specify a user group when creating a new user. A ‘You must 
specify at least one User Group’ message is displayed when users attempt to save a new 
user without specifying a user group.  

You will be added to the Users list on the Edit Users and Groups screen. 

Editing a User Profile 

 Call up the Edit Users and User Groups screen.  1.

 Select the user you want to edit and click F2. 2.

 Make the necessary changes to the User Information screen and click Save. 3.

Deleting a User Profile 

 Call up the Edit Users and User Groups screen. Select the user you want to edit and click 1.
Del. 

 A prompt will appear asking if you are sure you want to delete this user. Select Yes. 2.
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Adding a New User Group 

 From the Alt-X Start screen, go to Edit > Users and Groups. 1.

 The Edit Users and User Groups screen will appear. Select the User Groups tab and click 2.
Ins. 

 

 The User Group Edit Form will appear. Enter a Group Name and a Privilege Level. 3.

 

 To add users to the group, click Ins. Select the user(s) you want to add to the group. To add 4.
multiple users, click each user name and press the space bar. The selected users’ names will 
appear in bold text. Click OK. 

 

 The selected users will be added to the User Group Edit Form. Click Save. 5.
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Editing a User Group 

 Call up the Edit Users and User Groups screen and click the User Groups tab.  1.

 Select the User Group you want to edit and click F2. 2.

 Make the necessary changes to the User Group Edit Form and click Save. 3.

Deleting a User Group 

 Call up the Edit Users and User Groups screen and click the User Groups tab.  1.

 Select the user group you want to delete and click Del. 2.

 A prompt will appear asking if you are sure you want to delete the user group. Select Yes. 3.

NOTE: You must remove all users from a user group before deleting it. 

Changing User Passwords 

 From the Alt-X Start screen, go to File > Users > Change Password. 1.

 

 Enter your login credentials and click OK. 2.

 The Change Password form will appear. Enter your new password in the New Password and 3.
Verify New Password fields and click OK. 
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Pharmacist and Assistant Association 

Assistants working within the dispensary must be associated with a pharmacist in order to 

process prescriptions. Third Party Payer claim and Drug Information System (DIS) information 

submission requires assistants to be associated with the acting pharmacist in order for the 

pharmacist license number to be submitted as a part of the transmission. 

Associating Assistants with Pharmacists 

 From the Alt-X Start screen, go to File > Users > Associate Pharmacist. 1.

 

 The Pharmacist Association Form will appear. Place a checkmark next to the assistant(s) 2.
you want to associate and have the pharmacist enter his or her credentials in the 
Pharmacist Initials and Password fields. Click Associate. 
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Disassociating Assistants from Pharmacists 

 From the Alt-X Start screen, go to File > Users > Disassociate Pharmacist. 1.

 Have the pharmacist enter his or her login credentials and click OK. 2.

 

All assistants will be disassociated from the specified pharmacist. 

Start Screen 

The Start Screen is displayed when a user successfully logs into a Kroll session. Note that 

multiple sessions can be opened on one terminal, but it is not recommended to have more than 

3 sessions per terminal as this may slow down computer processing times.  
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Function Keys 

The Function Keys (i.e. F3, F5, F7, F9, F11, and F12) are located directly below the menu 

options. These keys are explained in detail in later sections of this user manual. 

 

Universal Search Field 

The Universal Search Field is used to search for patients, drugs, prescribers, and prescriptions. 

It is located right below the F3 - Patient button in the upper left corner of the ALT+X Start 

screen.  

Enter search criteria for a patient, drug, prescriber or Rx, and press the corresponding function 

key to obtain search results that match the criteria entered. For example, you can enter a 

patient’s phone number and press F3 - Patient to search for patient records with that phone 

number, or enter a DIN and press F5 - Drug to search for the associated drug record.  
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You can also enter a prescription number (Rx) or transaction number (Tx) into the Universal 

Search Field and choose one of the options from the left navigation pane: 

 
 
Modify Rx 
Modify the most recent Tx in the Prescription Chain without generating a new transaction 

number when possible (e.g. Add missing repeats to a prescription). 

Reprint Rx 
Displays options for you to reprint vial labels, hardcopies, Kroll Care, privacy labels, and receipts 

for the most recent Tx in the Prescription Chain.  

Cancel Rx 
Allows users to reverse a prescription.  

Modify Specific Rx # 
Modify a Tx that is NOT the most recent Tx in the Prescription Chain. 

Reprint Specific Rx # 
Displays options for you to reprint vial labels, hardcopies, Kroll Care, privacy labels, and receipts 

for an Rx that is NOT the most recent Tx in the Prescription chain. 

Counsel Rx 
Displays the Counseling screen for the Rx number entered in the search field.  
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Menu Options 

The menus located across the top of the window (File, Edit, Reports, Cards, etc.) can be 

accessed by clicking on the word with the mouse, or by pressing ALT and the underlined letter 

(e.g., ALT+F to access the File dropdown menu). 

 

File/Edit 
The File and Edit menus contain commands used for configuring and managing the Kroll 

Pharmacy Software. Since a large majority of system configurations will be centrally 

maintained, users will rarely have to access these two menus unless otherwise specified. 

Reports 
The Reports menu contains a comprehensive list of Kroll reports. This menu is organized into 

categories for quick access to desired reports. Reports will be discussed in more detail in later 

sections of the User Guide. 

Utilities 
The Utilities menu contains supplementary features of the system including Drug Ordering, 

Interactions Checking, Patient Merge, Drug Merge, Quick Price, Print Free Form Labels, etc.  

NH 
The NH menu contains commands to create new nursing home forms, edit the existing nursing 

home forms, print MAR/TMR reports, manual batch filling, packaging, viewing cycles and 

adding Rxs to manual batch. 

Cards 
The Cards menu is a reiteration of the function keys (i.e. F3, F5, F7, F9, F11, and F12). Clicking 

on one of the commands in this menu is equivalent to pressing the associated function key on 

the keyboard.  

Session 
The Sessions menu allows users to open and manage multiple Kroll sessions from one terminal. 

See section on “Getting Started – Managing Multiple Sessions”.  
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Help 
The Help menu provides access to on-screen help and diagnostic tools.  

Version 10 
Selecting Version 10 menu will display the ‘About Kroll Dispensary’ form. This form displays the 

Kroll Contact details, Version, Release Date, Last FDB update and the current Formulary dates. 

Dashboard Icons 

There are seven dashboard icons located on the Alt-X Start screen. Each icon provides access to 

tools that support pharmacy operations; when used properly, these tools help improve patient 

care. Note the numbers in the red circles indicate the number of entries listed under the 

specific dashboard icon). 

 

Dashboard 

The Dashboard icon is the default view for the Alt-X Start screen. It displays prescriptions that 

are overdue, approaching due time, or in the Trouble queue. The Workflow window allows 

users to quickly determine the number of Rxs approaching due time at each prescription 

processing stage. 
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Click the Details button located directly below Rx Counts to view the current Rx counts. The Rx 

Totals Form will display. 

 

Users can enter a previous date in the Totals for Date field and click Recalculate or press Enter 

on the keyboard to view totals for the inputted date. 

Callbacks 

The Callback Icon displays communications initiated from the system to prescribers. An entry is 

automatically created in the Callback list whenever one of the following actions is initiated from 

the system:  

 The Add to Doctor Callbacks command is selected from the Extra Functions menu in the 
patient profile. 

 The Doctor Authorization Report (a.k.a. Fax Doctor Report) is printed or previewed 
from the system. 
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Date Range  

  Current + [x] days: Displays entries that are currently active as well as those that are 
scheduled to become active “x” number of days. 

 Current Or Resolved Today + [x] days: Displays entries that are either currently active or 
that have been resolved today. 

  All + [x] days:  Displays all entries, historical and current. 

  History + [x] days: Displays entries that have been resolved for “x” number of days.  

Filter results further by accessing the Doctor dropdown menu (CTRL+O) to view callback entries 

generated for a specific prescriber.  

The status of a callback entry can be managed by highlighting an entry and selecting one of the 

following options:  

C (Mark as Call Doctor) 
Select this option to indicate that a phone call needs to be made to the doctor for the 
highlighted entry. When this option is selected, you will be presented with a comment box that 
allows them to “Specify a comment for the doctor callback”. 
 
O (OK Refills) 
Users can select this option to add prescription repeats to an entry. Once repeats have been 

added, the status of the entry will change to “Doc Okayed”. 

F (Fill) 
The F (Fill) option is only available for callback entries with a status of “Doc Okayed”. When this 

option is selected, users will be presented with the following choices: 

 Copying the entry to a new Rx number will create a new Rx Work Order  

 Apply repeats to the existing entry  

 Ignore changes = do nothing  

W (Mark as Waiting) 
This option changes the status of a callback entry to “Wait for Doc”.  

R (Refuse Refills) 
Select this option if the prescriber has declined the pharmacy’s request for repeats on behalf of 

the patient. Selecting this option will change the status of the callback entry to “Doc Refused” 

and add an entry under the Follow-ups Icon to remind you to contact the patient and let them 

know their request for repeats was refused.  
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D (Summarize Doctor) 
Selecting this option will display the address, phone number and fax number of the prescriber 

listed in the callback entry. This option makes it easy to access contact information for the 

prescriber.  

Print Report 
Selecting this option will allow users to print the “To Do Report”. This report can be used to 

identify outstanding/resolved notes, refills, follow-ups, and doctor callbacks. 

NOTE: Callback entries generated from printing/previewing the ‘Doctor Authorization 
Report’ will automatically be removed from the list when the Rx(s) are refilled using the 
‘Copy Rx’ function. The system recognizes that the authorization request has been resolved 
through the act of copying the old Rx to a new Rx number.       

Regular maintenance of the Callback screen is essential for ensuring that entries in the list are 

relevant to pharmacy operations for that day. For example, entries that have been resolved or 

have become irrelevant need to be deleted so that only current and active entries are 

displayed. 
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Followups 

The Followups icon displays entries that serve as reminders to follow up with patients 

regarding a specific matter; the actual follow up can be performed via phone call or face-to-face 

interaction.  

You can manually add a follow up entry by clicking Ins or pressing Insert on the keyboard from 

the Follow Ups window and completing the Patient Note form. 

 

The Patient Note screen has a number of options which are explained below:  

Due Date/Time 
Select when the follow-up is due to occur.  

Reoccurring Follow-up 
Patient follow-ups can be configured to re-occur every “x” number of days.  

Patient 
Depending on how the follow-up entry was added, the patient field may or may not be 

populated. If the patient field is empty, click F2 or press F2 on the keyboard to search and insert 

a patient record into the follow-up entry.  

Entered by 
Users can enter their initials to identify the author of the follow-up entry.  The initials are 

defaulted to you who opened the session but can be overwritten.  
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Resolved by 
Users can enter their initials to confirm a follow-up has been completed. Once a follow-up has 

been “resolved” it can only be accessed by setting the date range to “History + ___days”.  

Comment 
Details of the patient follow-up can be recorded in the Comment field.  

Mark a Callback entry as “Doc Refused”. When a prescriber refuses to authorize repeats for a 

patient, the pharmacy needs to follow-up with the patient so they can make other 

arrangements to obtain their medication.  

From the Follow Ups window users can choose to view entries generated for a specific Date 

Range:  

Current + [x] days 
Displays follow-up entries that are currently active as well as those that are scheduled to 

become active in “x” number of days. <Blank> will display follow-up entries due today.  

All 
Displays all follow-up entries; historical and current.  

History + [x]days  
Displays follow-up entries that have been resolved “x” number of days ago.  

Notes 

The Notes icon is a communication tool used by pharmacy users to communicate with each 

other. The intention is to reduce paper clutter within the dispensary by using a system 

supported function that facilitates user-to-user communication. Click Ins to insert a new note. 

For example, the pharmacist may wish to leave a message for the afternoon assistant indicating 

that drug expiry checking should be continued to the second to the third bay; the pharmacist 

can relay this message to the assistant by inserting an entry into the notes section.  

From the Notes window, users can choose to view note entries generated for a specific date 

range: 

Current+___ days  
Displays notes entries that are currently active as well as those that are scheduled to become 

active in “x” number of days. <Blank> will display note entries due today.  

All 
Displays all note entries; historical and current.  
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History+___ days  
Displays note entries that have been resolved “x” number of days ago.  

 

The To Do Note screen has a number of options which are explained below:  

Due Date/Time 
Users can select when the note entry will become “active”. Active notes contribute to the 

running count on the Notes Icon.  

Reoccurring Notes 
Notes can be configured to re-occur every “x” number of days.  

Entered by 
Users can enter their initials to identify who created the note; the initials are defaulted to you 

who opened the session but this can be overwritten.  

Resolved by 
Users can enter their initials to confirm that a note has been read or acknowledged. Once a 

note has been “resolved” it can only be accessed by setting the date range to “History + 

___days”.  

Comment 
Responses or general comments regarding the note can be entered in the comments field.  
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Inbound Docs 

The Inbound Docs icon displays images that have been scanned into the system via the 

document scanner or received via the fax or email. From the scan window, users can filter the 

Inbound Documents list by selecting Pending, Completed, or Deleted and Network Scan, 

Inbound Fax, or All from the Show menus. Use the From the last [x] days field to specify a date 

range. 

 

See the Sending and Receiving Faxes user guide for more information on this functionality. 

Outbound Fax 

Outbound Fax is used for sending fax messages such as Prescription Authorization Requests 

and Rx Transfer Requests. See the Faxes - Sending and Receiving user guide on our website for 

more information about the fax functionality. 

 

 

http://www.kroll.ca/userguides/Kroll%2010%20Sending%20and%20Receiving%20Faxes.pdf
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Mail 

The Mail Icon is an internal email system built within the Kroll Pharmacy Software. The Mail 

Module is the tool Head Office will use to send “fan out” messages to pharmacy users for 

various communications including, but not limited to, provincial network broadcasts. As long as 

a user is set up in the Kroll Pharmacy Software, they will have the ability to send a message to 

another local system user. 

The red number beside the mail icon indicates the number of unread messages available for 

you that are currently logged into the system.  
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Click the Mail icon or the envelope at the bottom of the screen to access your inbox. 

 

To compose a new message: 

 Click New Message, located in the top left corner of the Mail screen. 1.

 The New Mail Message window will open. Complete the following: 2.

 Enter the recipient’s name in the To: field.  

 Enter a subject in the Subject field. 

 Click Add Attachment to attach an image or document to the mail message. 
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 Click Send to send the mail message. 3.

 

Patient Records 

Patient records contain comprehensive information about patients’ contact details, drug plans, 

allergies and conditions, and Rx history. This section explains how to perform patient searches 

and how to create and manage patient records. 

Searching for a Patient 

Method 1: From the F3 - Patient Search Screen 

 Select F3 - Patient from the Alt-X Start screen.  1.

 Enter one of the following patient search criteria and click Search:  2.

a) Last Name, First Name (e.g. “Doe, Jane” OR “doe,j” OR “Doe” OR “,Jane”)  
b) A period (.) and the Patient Quick Code (e.g. “.DoeJ”)  
c) 7 or 10 digit phone number (e.g. 800-263-5876 or 263-5876)  
d) A number sign (#) and the +Third Party Billing number (e.g. #123456789)  
e) An asterisk (*) to search ALL patients in the database  
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 Double-click the patient record. The F3 - Patient screen will appear. 3.

 

Method 2: From the Alt - X Start Screen 

 Enter any of the search criteria described above in the Universal Search Field and click F3 - 1.
Patient. 
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 A list of patients matching the search criteria will be displayed. Double-click the patient 2.
record. 

 

 The F3 - Patient screen will display. 

Method 3: From the F11 - Drop-Off Screen 

 Call up the F11 - Drop-Off screen and enter any of the search criteria described above in the 1.
Patient Search field and press the Enter key on your keyboard. 

 

 A list of patients matching the search criteria will be displayed. Double-click the applicable 2.
patient record. The F3 - Patient screen will display. 

Performing an Advanced Patient Search 

If a patient is not found through a regular patient search as described in the previous section, 

an Advanced Patient Search can be performed. 

 Call up the F3 - Patient search screen and place a checkmark next to Advanced. The 1.
Advanced Search pane will appear. 

 

 Enter any available advanced patient search criteria and click Search. 2.
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Inactive Patient Records  

You have the ability to inactivate patient records in the system by un-checking the Active flag 

located on the patient record. Inactivating a patient record means that the patient will not 

show up in the regular patient search; an Advanced search for inactive patients will have to be 

initiated in order to access the record.  

 

NOTE: Inactive patient records cannot be used in prescriptions. The Active flag must be 
turned on in order to fill prescriptions for that patient. 

There are various reasons why a user may choose to inactivate a patient record. For example, 

the patient may be deceased, or may have moved to another country. Inactivating these 

records allows the regular search to provide more succinct results; this reduces the chances of 

selecting the wrong patient record into a prescription.  

To locate inactivated patient records in the system, perform an Advanced search and make 

sure the Inactive or All flag is marked on the far right. Search for the patient as usual to find the 

applicable record.  
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NOTE: Inactive patient records will appear in red text in the patient search screen. 

Configuring Columns in the Patient Search Screen 

You can configure the columns that are displayed on the Patient Search screen by clicking 

Change Columns from the right navigation pane. 

 

The Edit Scan Columns window will appear. Place a checkmark next to the columns you want 

displayed and click OK. 

  

Use the Use Default Columns button to revert the column view back to its default settings. 
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Creating a New Patient Record 

1. Perform a thorough search to ensure the patient does not already exist in the database. It is 
advisable to perform an Advanced search for inactive patients as well.  

2. Once you have determined that the patient does not exist in the system, click Insert or 
press the Insert key on the keyboard. 

 

 A blank F3 - Patient screen will appear. Complete the patient fields and click Save. 3.

Copying an Existing Patient Record 

If a new patient has a family member who already exists in the system, you can copy 

information from the family member to a new patient record by using the Copy Pat function 

from the Patient Search Screen. 

1. Perform a thorough search to ensure the patient does not already exist in the database. It is 
advisable to perform an Advanced search for inactive patients as well.  

2. Once you have determined that the patient does not exist in the system, click Copy Pat or 
press CTRL+Y on your keyboard. 

3. A second patient search window will appear. Search for the family member who should 
already be in the system.  
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 Highlight the family member of the new patient and click Select. The family member’s 4.
patient record will appear. Review the information and confirm that it is the patient you 
want to copy information from. Click Select. 

 

 A prompt will appear asking if you want to copy the patient’s plans. Answer Yes or No 5.
accordingly. 

a. If you answered Yes, a window will appear prompting you to select a relationship to 
the cardholder. Select a relationship and click OK. 

 

NOTE: Third party plans will be linked to the patient that the information was copied from. If 
any changes to the plan numbers need to be made, it must be done from the originating 
patient record.  

 Enter missing information for the new patient record such as birthdate, gender, snap cap 6.
preference, phone numbers, etc.  

 Click Save to save the patient record. 7.

Patient Record Fields 

Last Name 
Type the Last Name of the patient (do not add any symbols to this field).  

First Name 
Type the First Name of the patient (do not add any symbols to this field).  
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Salutation 
Type the salutation (e.g. Mr, Mrs, Miss, Dr, etc) or click on the down arrow to select the 

appropriate salutation from the options.  

Address 1 & 2 
Type the patient’s street address in one or both lines.  

City, Province, Postal Code Country 
Type in the rest of the address information.  

Email 
Enter the email address of the patient.  

Phone 
Phone numbers can be entered in this area. The phone number will auto-format so simply type 

in the numbers without using hyphens or brackets.  

To add a phone number click Ins, press Insert on the keyboard, or simply begin typing the 

number in the field.  

To delete a phone number, highlight the entry you want removed and click Del or press Delete 

on the keyboard. A window will appear asking you to confirm the deletion. 

 To edit a phone number, highlight the entry and either:  

a) Click F2 with the mouse.  
b) Press F2 on the keyboard. 
c) Double click the entry.  

 

Family Doctor (Optional) 
Click F2 with the mouse or press F2 on the keyboard to search and select the patient’s family 

doctor. When a prescriber is populated into this field, all prescriptions processed for the patient 

will default the prescriber to the one indicated here; be careful of prescriber errors when using 

this function.  
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Birthdate 
Enter the patient birthdate as DDMMYYYY. The year can be entered as a 2 or 4 digit number 

(e.g. 1950 or 50). Once the birthdate is entered, the system will automatically calculate the 

patient’s age in years.  

Gender 
Type the letter M or F to indicate Male or Female, or click on the down arrow to select the 

gender.  

Language 
The patient language will default to English. Click on the down arrow to select a different 

language for the patient. Be careful when changing the language setting as this will cause the 

SIG on the vial label to print in the language selected if the language is configured into the 

system. (Note: English translations will appear on hardcopy for pharmacist checking).  

Height 
Enter the patient’s height. Pharmacy users should use the same measurements to record height 

to maintain database consistency (i.e. make a decision to use Feet or Centimeters, but not 

both).  

Weight 
Enter the patient’s weight. Pharmacy users should use the same measurements to record 

weight to maintain database consistency (i.e. make a decision to use Kg or lbs, but not both).  

Provincial Plan 
Enter the patient’s provincial health number (i.e. ODB, HSN, PHN, ULI) in this field.  

Load Patient Image 
Users can load a patient photo into the patient record by using the document scanner. Simply 

feed the photo into the scanner and click Load to initiate scanning.  

Groups 
Patients can be included in a group for reporting. Patient Groups are created by head office and 

can be applied by pharmacy users to any number of patients. For example, a group called 

“Diabetic” can be attached to all patients that are Diabetic. Also note that patients can belong 

to more than one Patient Group.  

To add a Patient Group, click Ins with the mouse or press Insert on the keyboard to call up a 

selection window displaying the available groups to insert.  

To delete a Patient Group, highlight the entry you want to remove and click Del or press Delete 

on the keyboard. A window will appear asking you to confirm the deletion.  
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To edit a Patient Group, highlight the appropriate entry and either:  

a) Click F2 with the mouse.  
b) Press F2 on the keyboard.  
c) Double click on the entry. 

 

Comments 
Patient records can contain any number of comment entries, and each entry can contain a large 

amount of data.  

To add a comment, click Ins with the mouse, press Insert on the keyboard, or simply begin 

typing in the comment field. The following window will appear:  

 

Select a Topic for the comment by accessing the dropdown menu. A topic must be selected in 

order to save the comment.  
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Each comment has three options. To enable an option, use the mouse to click on the checkbox, 

or TAB to the desired option and use the spacebar on the keyboard.  

 Show on Rx: Enabling this option will display the comment at the F12-Filling Screen.  

 Print on Hardcopy: Enabling this option will print the patient comment on the hardcopy. 
Note that only one patient comment can be flagged for this option as there is limited 
space on the hardcopy.  

 Alert: Enabling this flag will cause the comment to pop up every time the patient record 
is accessed, and every time an Rx is filled for the patient.  

To delete a comment, highlight the appropriate comment entry and click Del, or press Delete 

on the keyboard. A window will appear to confirm the deletion.  

To edit a comment, highlight the appropriate comment entry and either:  

a) Click F2  
b) Press F2 on the keyboard  
c) Double click on the comment.  

Make any necessary changes and click Save with the mouse or press Enter on the keyboard.  

Plans 
Third party plan information is stored in the “Plans” section of the patient record. A patient can 

have unlimited number of third party plans, and the system will support billing to all plans listed 

in the patient’s record.  

To add a plan, click Ins with the mouse, press Insert on the keyboard, or simply begin typing the 

name of the plan. The following Patient Plan Information screen will appear. Users can fill out 

third party details from this window.  
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Order 

If there is only one plan for the patient, it will automatically be set as the Primary plan. If there 

is more than one plan, you must specify the sequence of billing for coordination of benefits (i.e. 

primary, secondary, tertiary, etc.)  

Carrier ID, Group ID, Client ID 

Obtain these numbers from the patient’s plan card. Note that some plans do not require all of 

these fields to be filled out.  

CPHA Pat Code 

This field is only used by certain plans (e.g. Green Shield).  

Birthday 

Enter the date of birth of the cardholder. 

Always Use in Rx 

This flag is ON by default and applies the plan to all Rxs filled for the patient. This flag may be 

turned OFF for plans that only cover certain medications/products (e.g. STI Plans, Workman 

Compensation Plan, etc.)  

Inactive 

Place a checkmark next to this flag if the plan no longer accepts claims for the patient. An 

alternative to inactivating a plan is to delete it.  

Link To… 

This field is used to link an existing patient to the current plan. 

Relationship 

Select the relationship of beneficiary to the cardholder of the plan. Type the number 

corresponding to the correct relationship, or click on the down arrow to view all options.  

Deduct Type 

This field is only used for manually billed plans and refers to how the patient deductible is 

calculated (e.g. select whether the deductible amount is calculated based on percentage or 

dollar amount).  

Deduct Value 

This field is only used for manually billed plans and must be left blank for real-time plans. If the 

plan is a manual plan, enter the value of the deductible in this field (works in conjunction with 

“Deduct Type”).  
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Expiry Date 

If applicable, enter the date the plan expires; the date should be entered as DDMMYYYY.  

Last Name 

Enter the patient’s last name as it appears on the plan card if it is different than what is entered 

on the patient record. The last name entered here will be sent to the plan.  

First Name 

Enter the patient’s first name as it appears on the plan card if it is different than what is 

entered on the patient record. The first name entered here will be sent to the plan. For 

example, if the patient’s name on the plan card is “Robert”, but on the patient record it is 

recorded as “Bob”, type Robert into the First Name field.  

Comment 

Enter any comments related to the patient record. 

To delete a plan, highlight the appropriate plan entry and click Del with the mouse or press 

Delete on the keyboard. A window will appear to confirm the deletion. 

 To edit any plan information, highlight the appropriate plan entry and either:  

a) Click F2.  
b) Press F2 on the keyboard.  
c) Double click the plan entry.  

Make any necessary changes and click Save with the mouse or press Enter on the keyboard.  

Allergies 
Any number of allergies can be added to a patient record. Note that allergies entered into the 

patient record will be cross-checked against prescriptions filled for the patient using the First 

Data Bank (FDB) clinical module.  

To add an allergy, click Ins with the mouse or press Insert on the keyboard. Options to search 

the allergy can be done by selecting the Starts with or Contains option beside the search field. 

Click Search or press Enter on the keyboard to begin the search.  
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Use the Arrow Keys to highlight the desired allergy entry and click Select with the mouse or 

press Enter on the keyboard to continue. Once the allergy is selected, the Patient Allergy 

Information window will appear with fields to indicate the Source of the allergy, the Date the 

allergy was reported, and Comments regarding the allergy. 

 

NOTE: Allergy entries with comments will have an asterisk next to them. 

Once all necessary information has been entered into the Patient Allergy Information form, 

click OK with the mouse, or press Enter on the keyboard to save changes.  
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Allergies can also be added by searching and selecting specific drugs (as opposed to using 

therapeutic classifications). To add an allergy by searching for a specific drug, click on the Add 

Drug button from the allergies section of the patient record. 

 

A Drug Search Screen will appear. Search for the drug the patient is allergic to. Once a drug is 

selected, a screen will display all components of the drug; all components will be selected by 

default. If the patient is only allergic to a fraction of the components, uncheck the rest of the 

components.  

Once the components of the drug have been selected, click OK or press Enter on the keyboard 

to call up the Patient Allergy Information window where comments and other supplementary 

information can be entered.  

 

To delete an allergy record, highlight the appropriate entry and click Del or press Delete on the 

keyboard. The system will prompt you to confirm the deletion.  

To edit an existing allergy record, highlight the appropriate entry and either: 

a) Click F2.  
b) Press F2 on the keyboard.  
c) Double click on the desired allergy entry.  
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Make any necessary changes and click OK or press Enter to save changes. 

Medical Conditions 
Any number of medical conditions can be added to a patient record. Note that medical 

conditions entered for a patient will be cross-checked against prescriptions in the patient 

profile using the First Data Bank (FDB) clinical module. Users should only add physician-

diagnosed medical conditions to the patient record; this prevents inaccurate clinical warnings 

from showing up during the prescription filling process.  

To add a medical condition, click Ins, press Insert on the keyboard or simply begin typing the 

medical condition in the field. The Select a Condition window will appear with the option to 

search by Starts with or Contains. Users can search by ICD-10-CA conditions, FDBDX conditions 

or both. Click Search with the mouse or press Enter on the keyboard to begin the search.  

 

Use the arrow keys to highlight the desired condition and click Select or press Enter to 

continue. Once the condition is selected, the Patient Condition Information form will appear 

allowing you to add supplementary information such as Source of the medical condition, the 

Date the condition was reported, and Comments regarding the medical condition  

NOTE: Medical condition entries that have a comment will have an asterisk next to it.  
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Once all necessary information has been entered into the Patient Condition Information form, 

click OK with the mouse, or press Enter on the keyboard to save changes.  

To delete a condition, highlight the appropriate condition entry and click Del or press Delete on 

the keyboard. A window will appear to confirm the deletion.  

To edit a condition, highlight the appropriate condition entry and either: 

a) Click F2.  
b) Press F2 on the keyboard.  
c) Double click on the entry to call up medical condition details.  

Make any necessary changes and click OK or press Enter on the keyboard to save changes. 

Groups 
Use the Groups section to add the patient to a patient group. 

Patient Information Tabs  

The patient record contains tabs of information located at the bottom right of the screen. Move 

from one tab to another by pressing Ctrl in conjunction with the underlined letter on the tab 

(e.g,. press Ctrl + F to access the Family tab). You can also flip from tab to tab by pressing Ctrl +  

→ to move right or Ctrl + ← to move left. 
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General 

The General tab displays general information and preferences of the patient. 

 

Active 
Patient records are “active” by default. Uncheck the Active flag if the patient has not filled 

prescriptions with the pharmacy for an extended period of time and you do not want them 

appearing in the “regular” patient search. Inactive patients are excluded from reports unless 

otherwise specified in the Options tab of the report. 

Animal 
If the patient is an animal, place a checkmark next to this flag; the corresponding text field will 

open up so users can enter a descriptor such as “dog” or “cat”. In certain provinces, activation 

of this flag triggers taxes to be applied to the patient’s prescriptions (i.e. Veterinarian Rxs are 

taxable). In certain DIS provinces, activation of this flag will prevent the patient’s prescriptions 

from being sent to the pharmacy network.  

Deceased On 
If the patient has passed, enter their deceased date in this field. If a deceased date is entered, 

the Active fag will become automatically unchecked. 

Delivery Type 
Select the delivery type from the dropdown menu. 

Delivery Route 
Select a delivery route from the dropdown menu. Delivery routes can be defined in Edit > Lists > 

Master Lists. 

Price Group 
Patients can be placed into a Price Group to activate patient specific pricing. Click on the down 

arrow to select from the available Patient Price Groups which are set up by head office.  
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Drug Line 1 
Drug Line 1 refers to first piece of drug information printed on the vial label; users can choose 

from: None, Brand, Generic, Description, Equivalent To, or Description 2. The drug information 

is pulled directly from the Drug record.  

Drug Line 2 
Drug Line 2 refers to the second piece of drug information printed on the vial label; users can 

choose from: None, Brand, Generic, Description, Equivalent To, or Description 2. The drug 

information is pulled directly from the Drug record.  

Double Count 
This field allows users to indicate if double counting is necessary for the patient. The options 

are: “Not Required”, “Always” or “Narcotics Only”. If an option to double count is selected, a 

message will display on the packaging screen at the filling stage to prompt you to double count 

medications for the patient.  

Snap Caps Requested 
Place a checkmark next to this flag if the patient has requested snap cap vials. If snap caps are 

requested for the patient, a message will display on the packaging screen during the filling 

stage to prompt you to package medications in snap cap vials. ‘Snap Caps Requested’ will print 

on the hardcopy when this is enabled. 

Snap Caps Documented 
This flag is only available when the “Snap Caps Requested” flag is ON. Place a checkmark next to 

this option if the patient has provided written documentation/consent for packaging their 

medications in snap cap vials.  

No Kroll Care 
Place a checkmark next to this flag if the patient has requested not to receive Kroll Care 

Monographs. Activation of this flag will prevent the Kroll Care from printing for any 

prescriptions filled for the patient.  

Compliance Calendar on Label 
A calendar will print according to the day supply on the Rx. The calendar is intended for the 

patient to record when a dose has been taken. 

Unit Dose 
Enter unit does packaging details in this section. Note that whenever a Unit Dose Type or Unit 

Dose Cycle is selected, you will be prompted to activate and configure unit dose packaging for 

each prescription that is processed for the patient.  
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Type 
Enter the type of unit dose packaging used for the patient. Select from “Dosett”, “Pilpak”, 

“Pilpak 28 Day”.  

Cycle 
Enter the number of weeks of medication packaged for the patient for one cycle.  

Price Group 
Enter a pricing strategy that adds a supplementary charge to unit dose Rxs.  

NOTE: Unit Dose Price Groups are configured and set up by head office. 

Rx Total 
This is a read-only section that keeps a running total of the number of Rxs filled for the patient 

and the cumulative dollar value of those Rxs. Click Reset to reset the counters to zero.  

ID 
Whenever a patient record is created, it is assigned an ID. This read-only ID is used to track the 

patient within the system tables. 

Family 

Family members can be grouped together in the system for managing records more efficiently. 

Once members of a family are grouped together, changing the information of one member (i.e. 

address, telephone number, and/or third party plan information) will allow you to extend the 

change to other family members. Once the updated information is entered, press enter on the 

keyboard and a window with the existing family members will show up. If the changes apply, 

click the checkbox.  

In addition, linking family members together in the system will link their work orders together 

at point of sale. For example, if John and Jane are linked as family members and both have 

prescriptions ready for pick-up, when the pharmacy user accesses John’s prescriptions at 

pickup, Jane’s prescriptions will be displayed as well. You will have the choice of asking the 

patient if he wants to pick up prescriptions for his family members. This functionality ensures 

that patients do not have to make multiple trips to pharmacy as well as helping users manage 

the Pickup Bins more effectively.  

To add a family member, click Ins with the mouse or press Insert on the keyboard. This will call 

up a Patient Search Screen. Search and select the applicable patient as you would regularly; if 

the family member you are linking has a different address than the original patient, you will be 

prompted to optionally update the addresses so they match. 
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NOTE: If a patient is added into the database by copying an existing patient, the Family link 
will automatically be created. 

To remove a family member, highlight the member you want to remove and click Del or press 

Delete on the keyboard. You will be asked to confirm the deletion.  

Nursing Home 

The Nursing Home tab displays information that pertains to nursing home patients only. 

 

Home 
All of the nursing homes configured in your system are available from this dropdown menu. 

Selecting a nursing home and saving the patient profile will enrol that patient in the selected 

nursing home.  

Ward 
The configured wards for the selected nursing home will appear in this menu. Select a ward for 

the patient, if applicable. 

Cycle 
The configured cycles for the selected nursing home will appear in this menu. Select a cycle for 

the patient, if applicable. 



  Kroll Windows 10 User Manual  

 

44 
 

Room/Bed 
Enter the patient’s room number and bed number in the nursing home, if applicable. 

Diet 
Enter any dietary restrictions the patient may have in this field.  

Comment 
Enter any patient comments in this field. 

Admit Date 
Enter the date the patient was admitted to the selected nursing home. 

Discharge Date 
Enter the date the patient was discharged from the selected nursing home, if applicable. 

Last TMR Date 
Enter the date the patient received his or her last Three Month Review, if applicable. 

Status 
This field is used to indicate if the patient is on LOA (leave of absence). To set an LOA status, 

click the New button next to the Status field and complete the Start Patient Leave of Absence 

form. When you are finished, click Save. 
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Standing Orders 
This section is used to record any medications that the registered nurse or registered 

psychiatric nurse may administer based on his or her assessment of the resident’s needs. These 

orders are not to exceed three doses per 24-hour period without notifying the physician. Any 

rapid deterioration in the resident’s condition must be reported to the physician immediately. 

To add a standing order, click Ins with the mouse or press Insert on the keyboard. This will call 

up the NH Standing Orders screen. Complete the necessary fields and click OK. 

 

Copays 

When the third party had already paid part of the deductible, the system discounts just the 

remaining cash portion of the Rx.  

This is a read-only section that displays the Copay Strategies associated with the patient record.  
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Creating a new Copay Strategy 
To create a new Copay Strategy, click Ins from the Copays section of the patient record. 

 

When you done filling the Copay Strategy fields, click Save. 
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Communications 

This section is used to record the patient’s communication preferences and prescription refill 

preferences. Use the Refill Type and Pickup menus to record the patient’s auto-refill 

preferences, and the Language menu to select the patient’s language.  

The Communication Methods pane allows you to record how the patient wants to be 

contacted for refill reminders and when Rxs are ready for pickup. Click Ins or press the Insert 

key on your keyboard to add a new communication method. Select from the Message and Type 

menus; Notification Type and Phone# fields will appear. Select the appropriate Notification 

type; the patient’s phone number/fax number/email addresses will auto populate. Click Save. 
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Other 

This section shows when the patient record was created, when it was last changed, and when a 

prescription was last filled for the patient. 

 

Patient profile 

The patient profile contains a list of medications the patient has filled at the pharmacy. Each 

line within the profile represents a written prescription with details including, but not limited 

to: Unit Dose, Rx Status, Rx Number, Dispensed Quantity, Drug Brand Name, SIG, Authorized 

Quantity, Remaining Quantity, Prescriber, Dispensed Date, etc. Users can perform actions 

against the Rx entries in the profile such as Refill, Modify, Cancel, Inactivate, Detail and more.  

In addition, the medication profile gives pharmacy users the opportunity to actively participate 

in monitoring patient care by comparing new medication orders to all of the medications that 

the patient has been taking. This reconciliation is done to avoid medication errors such as 

omissions, duplications, dosing errors or drug interactions. This verification should be 

performed at every transition of care in which new medications are ordered or existing orders 

are rewritten.  

Patient Profile Views 

There are seven (7) patient profile views available in the Kroll Pharmacy Software. Different 

views allow you to filter and display prescription information that is relevant to the user’s needs 

at that time. The patient profile views will be explained below:  
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All Rxs  

The All Rxs profile displays all prescriptions filled for the patient regardless of when the Rx was 

filled, or the Rx status. This view is useful for viewing prescriptions that have been inactivated 

or transferred out.  

Do one of the following to access All Rxs: 

a) From the patient profile or F11 - Drop-off screen, press Shift + F3 on the keyboard.  

b) From the patient profile or F11 - Drop-off screen, press Shift + F4 on the keyboard.  

c) From the patient profile or F11 - Drop-off screen, click on All Rxs from the right 
navigation pane. 

d) From the patient profile, select Profile > All Rxs. 

 

Active Rxs  

The Active Rxs medication profile displays prescriptions that have an Active prescription status. 

Prescriptions that are Unfilled, Not dispensed, Transferred-In or have a <blank> status is 

considered “active” and will be displayed. This view is useful for filtering out prescriptions that 

have been inactivated or transferred-out.  

Do one of the following to access Active Rxs:  

a) From the patient profile or F11 - Drop-off screen, press Shift + F5 on the keyboard.  

b) From the patient profile or F11 - Drop-off screen, select Active Rxs from the right 
navigation pane.  

c) From the patient profile, select Profile > Active Rxs. 
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Active Rxs with Passtimes 

The Active Rxs w/ Passtimes profile displays active prescriptions with columns that show unit 

dose information for prescriptions that are configured for unit dosing. The additional columns 

include Passtime, Unit Dose Quantity, and Passtime Note.  

Do one of the following to access Active Rxs:  

a) From the patient profile or F11 - Drop-off screen, press Shift + F10 on the keyboard.  

b) From the patient profile or F11 - Drop-off screen, select Active Rxs w/ Passtimes from 
the right navigation pane.  

c) From the patient profile, select Profile > Active Rxs w/ Passtimes. 

 

Refillable  

The Refillable Rxs medication profile only displays prescriptions that have a Remaining 

Quantity left on the prescription. In other words, this view filters out prescriptions that cannot 

be refilled, while only displaying those prescriptions that can be refilled.  

Do one of the following to access Refillable Rxs: 

a) From the patient profile or F11 - Drop-off screen, press Shift + F6 on the keyboard.  

b) From the patient profile or F11 - Drop-off screen, select Refillable Rxs from the right 
navigation pane.  

c) From the patient profile, select Profile > Refillable Rxs. 
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Pricing Profile  

The Pricing Profile displays ALL the prescriptions filled for the patient with columns displaying 

cost, markup, fee and Rx Total. The values represent amounts pulled from the last filled Rx in 

the Prescription Chain. This view is useful for determining prescription pricing and resolving 

pricing discrepancies.  

Do one of the following to access the Pricing Profile: 

a) From the patient profile or F11 - Drop-off screen, press Shift + F7 on the keyboard.  

b) From the patient profile or F11 - Drop-off screen, select Pricing Profile from the right 
navigation pane.  

c) From the patient profile, select Profile > Pricing Profile.  

 

Not Dispensed/OTC Rxs  

The Not Dispensed/OTC Rxs medication profile displays prescriptions that have been marked 

with a status of “Not Dispensed”. Over-The-Counter (OTC) products are added to the patient 

profile by marking them as “Not Dispensed” to allow drug interaction checking to occur without 

generating official prescription receipts.  

Do one of the following to access Not Dispensed/OTC Rxs: 

a) From the patient profile or F11 - Drop-off screen, press Shift + F8 on the keyboard.  

b) From the patient profile or F11 - Drop-off screen, select Not Disp/OTC Rx from the right 
navigation pane.   
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c) From the patient profile, select Profile > Not Disp/OTC Profile. 

 

Rx Filled in Error 

The Rx Filled in Error profile displays prescriptions filled in error for the patient. This profile is 

commonly known as the “Garbage Profile” because it houses prescriptions for the patient that 

should not have been filled and contain “wrong” information. Entries in this profile are 

excluded from drug interactions checking and should not influence dispensing decisions.  

Do one of the following to access Rxs Filled in Error: 

a) From the patient profile, press Shift + F9 on the keyboard.  

b) From the patient profile, select Rxs Filled in Error from the right navigation pane.  

c) From the patient profile, select Profile > Rxs Filled in Error.  
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Perform FDB Analysis 

Users can easily initiate a First Data Bank (FDB) clinical interactions analysis for a patient’s 

medication profile by selecting the option to Perform FDB Analysis from the patient sidebar.  

 

From the selection screen, place a checkmark next to the clinical information you want to 

retrieve from FDB; the Select All and Select None buttons allow users to quickly check or 

uncheck all the options. Once selections have been made, click OK or press Enter on the 

keyboard to execute the FDB analysis; the analysis will be based on information contained in 

the patient profile.  
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Results of the analysis will be displayed in the Clinical Reports window under separate tabs 

across the top of the screen; click Back to move left a tab, click Next to move right a tab. There 

is also an option to print the clinical report by accessing the File dropdown menu and selecting 

the command to Print. 

 

Configuring the Columns in the Patient Profile 

You can customize the information columns displayed on the patient profile by accessing the 

Edit Scan Columns window in one of three ways: 

a) Right-click anywhere on the patient profile columns to display a list of menu options. 
b) Select the command to Change Columns.  
c) Click on the Extra Functions button located on the upper right of the patient profile.  
d) From the Extra Functions menu, select the command to Change Columns.  
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e) Ensure your cursor is somewhere on the patient profile and press “x” on the keyboard 
to access the Extra Functions menu; from the menu, select the command to Change 
Columns. 
 

 

The Edit Scan Columns window gives users the ability to customize the Rx columns displayed on 

the patient profile; simply place a checkmark next to the information you want displayed. Users 

can also highlight a selected option and click Move Up or Move Down to determine where the 

information is displayed relative to the other information columns. At any time, you can select 

the option to Use Default Columns which will cause the column view to revert back to the 

default.  

Once the user has selected the columns they want displayed on the patient profile, they can 

click OK or press Enter on the keyboard to save changes until the session is closed. If the user 

wants the changes to become permanent, they must right click on the columns and select the 

option to make these the default columns.  

Below are all the column options available for selection and provides a description of the 

information contained within the column: 

Column Name Column Description 

U  Unit Dose Indicator. “Y” means “yes”, the prescription is configured for unit 
dosing. “N” means “no”, the prescription is not configured for unit dosing.  
 

Status  Prescription Status (e.g. <BLANK> = Active, Inactive, Unfilled, Not Dispensed, 
Transferred In, Transferred Out, etc.)  
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Rx Num  Prescription Number of the last filled Rx in the prescriber chain.  
 

Qty  Dispensed quantity. 
 

Brand Name  Brand name of the drug. 
 

Sig  SIG code for the prescription (not expanded). 
 

Auth  Authorized prescription quantity in units (e.g. the number of tablets/caplets).  
 

Rem  Remaining prescription quantity in units (e.g. the number of tablets/caplets). 
 

Doctor  Name of the prescriber of the prescription.  
 

Date  Date of the last filled Rx in the prescriber chain.  
 

Ago  Number of days ago the prescription was filled. 
 

Orig Rx  Original prescription number for the prescriber chain.  
 

Generic Name  Generic name of the drug. 
 

Equivalent To  Brand name equivalent of drug product being dispensed. This column is not 
always populated because the associated field may not be populated on the 
drug record.  
 

Sig Expansion  The expanded SIG code for the prescription. For example, “Take one tablet 
once daily until finished”.  
 

Cost  The calculated cost of the last filled Rx in the prescriber chain.  
 

Markup  The calculated markup of the last filled Rx in the prescriber chain. 
 

Fee  The calculated fee of the last filled Rx in the prescriber chain. 
 

MixFee  The calculated mixture fee for the last filled Rx in the prescriber chain. 
 

SSCFee  Special Service Code Fee; the dollar value of the fee will be displayed in this 
column.  
 

Total  Total dollar value of the last filled Rx in the prescriber chain. (Cost + Markup + 
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Fee + MixFee + SSCFee = Total).  
 

Total Fee  Total fees of the last filled Rx in the prescriber chain. (Fee + MixFee + SSCFee = 
Total Fee).  
 

Days  Days’ supply of the last filled Rx in the prescriber chain.  
 

Inact  Indicates whether the prescription is inactive. 
 

DIN  Drug Identification Number of the drug product.  
 

Initial  User initials of the pharmacist who worked on the prescription.  
 

Tech  User initials of the assistant who worked on the prescription.  
 

Rem #  Remaining number of refills (e.g. 1 refill, 2 refills, etc.)  
 

Auth #  Authorized number of refills (e.g. 1 refill, 2 refills, etc.)  
 

Due  Number of days before the prescription is “due” to be refilled (e.g. 10 days 
until due). 
 

OrigDate  Date when the first Rx of the prescriber chain was filled.  
 

ExpDate  Expiry Date of the written prescription (Note: expiry dates for written 
prescriptions vary from province to province and drug schedule to drug 
schedule).  
 

B  Batched prescription: Y = Yes; N = No 
 

NH  Nursing Home prescription: Y = Yes; N = No  
 

CF  Central Fill prescription: Y = Yes; N = No  
 

Card #  Indicates the blister card number the prescription is assigned to.  
 

Tracking  Indicates the current workflow state the prescription is at.  
 

Methadone 
Ingest Date  

Displays the Methadone Ingest Date for methadone prescriptions.  

MI  Indicates if a prescription has been billed to a third party with an “MI” 
intervention. “Y” = yes; “N” = no.  
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Patient Profile Commands From the Patient Record    

There are eight (8) key commands that can be executed when you call up the patient profile 

from the patient record. These commands are outlined below in RED and will act on the 

highlighted or tagged prescription(s) in the patient profile. 

 

ESC –Back to Patient  M-Modify prescription(s)   D-Detail prescription(s)  
Space – Mark Multiple Rxs  R-Reprint prescription(s)   I-Inactivate prescription(s)  
F - Refill prescription(s)  C-Cancel prescription(s)  

ESC – Back to Patient 

Press Esc on the keyboard or click on the word Esc to return to the Patient Record from the 

patient profile.  

Space – Mark Multiple Rxs 

Users can execute a command (e.g. Refill, Reprint, Cancel, Modify, etc.) on multiple 

prescriptions at once. For example, users can tag multiple prescriptions on the profile and 

select the command to “Cancel” which will bring up one prescription after another to be 

cancelled until all Rxs are reversed.  

To tag prescriptions on the patient profile: 

1. Highlight an Rx entry and press the spacebar on the keyboard. Once a prescription is tagged 
it will appear in bold. Repeat this step to tag additional Rxs. 
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F-Refill 

To tag prescriptions for refill: 

1. Highlight or tag prescription(s) to be refilled by pressing F on the keyboard or click F-Refill 
with the mouse.  

2. Once the Refill command has been executed, the F12 screen will appear.  

NOTE: Notice that the status of the prescription on the upper left hand corner of the window 
will read “Refill”. A work order due time must be selected from this screen in order to 
continue processing the prescription. 

M-Modify 

To tag prescriptions to modify: 

1. Highlight or tag prescription(s) to be modified by pressing M on the keyboard or clicking M-
Modify with the mouse.  

NOTE: Once a prescription has been adjudicated to a plan, only certain fields will be open for 
modification; any field that impacts price will not be editable. 

R-Reprint 

To tag prescriptions to reprint: 

1. Highlight or tag prescription(s) from the patient profile.  

2. Select to reprint various labels such as vial labels, hardcopies, drug information 
monographs, privacy labels, and receipts.  

C-Cancel 

Cancelling a prescription means you would like to reverse a prescription. If an Rx is being 

cancelled after adjudication to a third party, a reversal will also be made for financials. Users 

can highlight or tag prescription(s) from the patient profile and press C on the keyboard or click 

C-Cancel with the mouse. Once the Cancel command has been executed, the prescription will 

be brought up in “cancel” mode; you will be asked to confirm whether or not they would like to 

cancel the prescription.  

When cancelling any prescription, you will be presented with a message box asking “Is this the 

Rx that you want to cancel?”  

Yes – Proceed with reversing the prescription  
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No – Do nothing, return to the previous screen  

Cancel and Refill – Used in scenarios where the user has made an input error and needs to 

reverse the Rx, make a correction, and refill the Rx to the third party plan.  

 

When cancelling an Unfill (i.e. On hold Rx), you will be presented with a message asking “Do 

you want to Cancel this Unfilled Rx and mark it as a mistake?” If you answer Yes the 

prescription will be removed from the patient profile.  

 

When cancelling the first fill of a prescription, you will be presented with a message box with 

two options:  

Make this Rx Unfilled (i.e. put the prescription on hold)  

Filled in Error – Remove from profile  
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When cancelling the first fill of a “Not Dispensed” Rx (i.e. OTC to profile prescription), you will 

be prompted to mark the prescription as Filled in Error – Remove from profile.  

 

D-Detail 

The Detail command allows users to view adjudication details for a prescription. This command 

is useful for identifying and resolving pricing issues. Obtain adjudication details from the patient 

profile as follows:  

Highlight the prescription of interest and press D on the keyboard or click D- Details to view the 

Rx Detail form.  

This screen will bring up all the transaction numbers (Tx Number) used with the original Rx.  

 

Highlight the Tx Number of interest and press D on the keyboard or click D-Billing Detail to view 

the Rx Plan Detail Form. This screen breaks down the amounts paid by each third party payer 

for the Rx selected.  

 

NOTE: Any value for Cash is indicative of the patient pays amount. 
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Highlight the third party plan entry, in this case the AHE, and press D on the keyboard or click D-

Adjudication History to view the Rx Plan Adjudication History form which shows the details 

and messages sent back from the third party plan.  

 

At this point, pressing D or clicking D-View Adjudication Detail will bring up the Adjudication 

Claim and Response Form. The left side of the screen, Claim Values, shows all the values being 

sent to the third party payer. The right side of the screen, Response Values, shows all the 

values and messages sent back from the third party payer.  
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I-Inactivate 

User can highlight or tag prescription(s) from the patient profile to be inactivated by pressing I 

on the keyboard or clicking I-Inactivate with the mouse. Once the Inactivate command has 

been chosen, you will receive a screen showing the eligible and ineligible prescriptions.  

Once a prescription is inactivated, it can be reactivated by accessing the Extra Functions menu 

and selecting the command to Reactivate.  
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Patient Profile Commands from the F11 - Drop-Off Screen 

There are five key commands that can be executed when you call up the patient profile from 

the F11 - Drop-Off screen. These commands are listed in RED and act on the highlighted or 

tagged prescription(s) in the patient profile.  

 

ESC –Back to F11 screen D-Detail prescription(s)  F - Refill prescription(s) 
Space – Mark Multiple Rxs  Y-Copy to new   I-Inactivate prescription(s)  
   
The ESC, Space, F-Refill, and D-Detail, and I-Inactivate commands available from the F11-Drop-

off patient profile are the same as the commands from the patient profile; however, there is a 

new command on the F11-Drop-off which is Y-Copy to New. This command allows you to 

highlight or tag prescription(s) from the patient profile and copy to a new prescription number 

(or work order).  

1. Using the spacebar highlight or tag the prescriptions that you want to copy to a new 
prescription number.  
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2. Press Y on the keyboard or click Y-Copy To New with the mouse; the F11-Drop-off window 
will be populated with prescription information from the copied Rx. 

 

Once all prescriptions have been copied, click on Finalize Work Order or press Enter on the 

keyboard to move the work order to the Input stage.  

Extra Functions from the Patient Profile    

Tag prescriptions on the patient profile using the spacebar, and proceed to execute actions on 

the selected prescription(s) by accessing the Extra Functions menu. The following subsections 

will explain how to use the applicable functions listed under the Extra Functions menu. 

Suspend 

The Rx Suspend feature allows prescriptions to be suspended from filling and appearing on 

reports (including all blister packaging reports) for a specific amount of time or indefinitely. 

Suspended prescriptions can be filled interactively if needed. During an interactive fill, you will 

receive a warning that the Rx is suspended. However, the dispensed quantity cannot be 

adjusted since the day the patient started taking the medication for this fill is unknown.  
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An active prescription can be suspended for a number of reasons (e.g. Drug-to-drug 

interactions, hospital admission, etc.). The pharmacist can “suspend” selected prescription(s) 

on the profile as follows:  

Tag prescription(s) on the patient profiole you want to suspend. Use the Spacebar on the 

keyboard to tag prescriptions.  

Access the Extra Functions menu by clicking Extra Functions with the mouse, or by pressing “x” 

on the keyboard. Select the command to View/ Edit Suspends/Resumes, and then choose the 

options to Suspend.  

The Suspend Rx(s) window will be displayed:  

 

Under the Suspend section, enter the Date, Time, and Reason for suspending the Rx(s). Users 

can select a reason for suspending the Rx(s) from options available in the dropdown menu, or 

they can type in a free-form reason. There is also an optional Comment field for entry of 

supplementary information regarding the suspend action. 

Resume 

When users suspend an Rx, they can also choose to set a Date, Time and Reason for resuming 

the Rx if this is known; if this information is unknown, leave it blank to suspend the Rx 
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indefinitely. Users can select a reason for resuming Rx(s) from one of the options available in 

the dropdown menu, or they can type in a free-form reason. There is an optional Comment 

field for entry of supplementary information regarding the resume action.  

Towards the bottom of the Suspend Rx(s) window, details for the selected prescriptions are 

displayed. If more than one Rx is being suspended, the first tab will show an Rx Summary listing 

all prescriptions selected for the suspend action. Subsequent tabs will contain information 

specific to the Rx number listed on the tab.  

Once the suspend information has been inputted, click Suspend Eligible Rxs or press Enter on 

the keyboard; prescriptions with a status of OK to suspend will become suspended.  

NOTE: Rxs with the following statuses cannot be suspended - Inactive, Inactive (Copied), 
Inactive Transferred Out, Fee for Service, Stock Transfer, or Unfill).  

A suspended prescription will appear on the patient profile with a status of Suspended. 

 

Only prescriptions with a status of Suspended can be resumed. Resume a suspended 

prescription as follows:  

 Tag prescription(s) on the patient profile you want to resume. Use the Spacebar on the 1.
keyboard to tag prescriptions.  

 Access the Extra Functions menu by clicking Extra Functions with the mouse, or by pressing 2.
X on the keyboard. Select Suspend/Resume, and then choose the option to Resume.  
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 The Resume Rx(s) window will be displayed: 3.

 

Select the Date, Time and Reason for resuming the Suspended Rx. Users can select a reason for 

resuming Rx(s) from one of the options available in the dropdown menu, or they can type in a 

free-form reason. There is an optional Comment field for entry of supplementary information 

regarding the resume action.  

Once the resume information has been inputted, click Resume Eligible Rxs or press Enter on 

the keyboard, prescriptions with a status if OK to Resume will become active again.  
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View/Edit Suspend/Resume 

Users can access the suspend/resume history for a specific prescription by highlighting the 

prescription from the patient profile and accessing Extra Functions > Suspend/Resume > 

View/Edit Suspend/Resume.  

 

To edit an existing suspend/resume entry, highlight the entry and press F2 on the keyboard, or 

double click on the entry to bring up the Edit Rx Suspension window. You can add or change 

data in any of the fields and click OK to save. 

 

Once a suspension has been set for a prescription, users are prevented from deleting the 

suspension when the suspend date is set to a previous date. Prescriptions that have a suspend 

date set to the future can be deleted. 
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Add to Doctor Callbacks 

The Add to Doctor Callbacks function serves to add entries to the Callback icon on the System 

Start Screen to remind users to call the doctor regarding a specific prescription. The callback 

reminder may serve to clarify prescription dosage, SIG instructions, refills, etc.  

Users can tag prescription(s) on the patient profile that require a call-back to the prescriber. 

Subsequent to tagging applicable prescription(s), access the Extra Functions menu and select 

the command to Add to Doctor Callbacks. 

Once prescription(s) have been flagged for doctor callback, access the System Start Screen by 

pressing ALT+X on the keyboard and clicking on the Callback icon. The prescriptions that were 

selected for Add to Doctor Callbacks will appear as callback entries with a status of Call Doctor. 

Users can double click on a specific entry to add a comment regarding the callback, or to 

resolve the callback. 

 

Add to Rx To Do List 

The Add to Rx To Do List function allows users to quickly create a work order for refill 

prescriptions. Users can tag prescriptions that need to be refilled from the patient profile and 

assign a due time for the work order. For example, if “Ms. Jane Doe” arrives at the pharmacy to 

refill her “Cortate” and “Clotrimaderm” creams, you can create a work order from the patient 

profile as follows:  

1. Access the patient profile for the patient requesting the repeat(s). 

2. Access the patient profile.  

3. Using the spacebar on the keyboard, tag all prescriptions that need to be refilled 
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4. Click on Extra Functions with the mouse or press “x” on the keyboard.  

5. Select Add to Rx To Do List. 

The Create Refill Reminder(s) window will appear prompting you to enter a due date for the 

refill prescription(s). Users can click on the Down Arrow to select one of the pre-configured due 

times. Or you can click F2 to enter a specific Due Date and Time. Once the due time has been 

selected for the refill work order, click OK with the mouse or press Enter on the keyboard. 

 

The refill(s) will be prioritized against all other exiting work orders in the system and presented 

to you for processing at each applicable Rx stage.  

Display Therapeutic Equivalents 

The Display Therapeutic Equivalents function allows you to highlight a prescription from the 

patient profile and display any therapeutic equivalents the patient may have had in the past.  

Display therapeutic equivalents for a prescription as follows:  

1. Highlight the prescription you want to view therapeutic equivalents for.  

2. Click on Extra Functions or press X on the keyboard.  

3. Select Display Therapeutic Equivalents.  

Once the command is selected, the patient profile will only display therapeutic equivalents for 

the prescription that was initially selected. 

Fax Doctor 

The Fax Doctor command generates a refill request for prescriptions tagged from the patient 

profile. Multiple prescriptions can be tagged to appear on the Fax Doctor Report.  

Generate a Fax Doctor Report for one or more prescriptions from the patient profile as follows:  
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1. Search and access the record for the patient who requires a Fax Doctor Report.  

2. Select All Rxs from the right navigation pane. 

3. Using the Spacebar on the keyboard, tag all prescriptions that need to be included in the 
Fax Doctor Report. 

4. Click on Extra Functions with the mouse or press X on the keyboard.  

5. Select Fax Doctor(s). The Doctor Authorization Report window to appear. 

 

Comments tab 

Use this space to enter comments specific to the tagged prescriptions. The comment will be 
deleted from the report parameters once the report is printed.  
 
Customized Text tab 
Use this space to enter a generic comment for the report. For example, store hours can be 
entered here, or an ending salutation, etc. The content entered under the “Customized Text 
Tab” will be saved and printed on all Fax Doctor Reports until the content is manually deleted 
from the field. 
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Options tab 
Use this space to check or uncheck any of the options listed in this area. The Preview option 
located at the bottom of the reports window allows users to view the report before actually 
printing.  
 
Cover Page Comments tab 
Use this space to enter any comments you want printed on the cover page. 
 
Click Print to print the Fax Doctor Report (a.k.a. Doctor Authorization Request). 
 
Sample Prescription Authorization Request: 
 

 

NOTE: If prescriptions tagged from the patient profile are from different prescribers, the 
report will print separate pages for each prescriber so that refill request are grouped and 
faxed to the doctor that initially prescribed the Rx. 
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Whenever a Fax Doctor Report is generated for a prescription, the system will automatically 

add an entry for the prescription into the Callback window. The entry serves as a reminder to 

follow up with the prescriber regarding the refill request. The Callback window can be accessed 

from the ALT+X Start Screen by clicking on the Callback icon.  

NOTE: When the Rx Number (i.e. Rx Num) is copied to a new prescription number, the 
system will automatically remove the callback entry from the callback window. 

Limited Use Request (Ontario Only) 

For certain medications, ODB will only reimburse prescriptions for a medication if it complies 

with a medical reason for use as defined by ODB. The Limited Use Request form generates a 

request to the prescriber for a limited use code.  

Generate the Limited Use Request Form as follows:  

1. Search and access the record of a patient who requires a Limited Use Request form.  

2. Access the patient profile.  

3. Use the Spacebar on the keyboard to tag the prescription eligible for a Limited Use Code.  

4. Click on Extra Functions with the mouse or press X on the keyboard.  

5. Select Limited Use Request. 

6. The Limited Use Request form will appear. Ensure Rx Info is checked. 
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 Select the Options tab and place a checkmark next to the applicable option(s). 4.
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From the Customized Text Tab, users will see pre-populated information under the First 

Section and Second Section; however, the information can be overridden for customized 

wording.  

 

Click Print to print the Limited Use Request form for the selected prescription. Note the Limited 

Use Code and associated medical reason will be printed at the bottom of the report. 
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Sample Limited Use Request Form: 

 

Section 8 Request (Ontario Only) 

A Section 8 Request is a request sent to a prescriber for special coverage of a product that is 

not normally covered under the ODB formulary. The prescriber, on behalf of the patient, can 

request coverage for a particular drug product not normally covered under ODB for a specific 

period of time.  

Generate the Section 8 Request form as follows:  

1. Search and access the record of a patient who requires a Section 8 Request.  

2. Access the patient profile.  

3. Use the Spacebar on the keyboard to tag the prescription requiring a Section 8 Request.  

4. Click on Extra Functions with the mouse or press X on the keyboard.  

  



  Kroll Windows 10 User Manual  

 

79 
 

 Select the Section 8 Request command and wait for report window to appear. 5.

 

 Select the Options tab and place a checkmark next to the option(s) you want printed on the 6.
report.  
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 Select the Customized Text tab. The information on this tab is pre-populated but can be 7.
overridden for customized wording. 

 

 Click Print to print the Section 8 Report. 8.

Transfer Rx to Another Store 

Generate the Transfer Report as follows: 

1. Call up the patient profile for the patient who requires a prescription transfer. 

2. Use the Spacebar on the keyboard to select the prescription that needs to be transferred to 
another pharmacy.  

3. Click on Extra Functions with the mouse or press X on the keyboard.  

4. Select Transfer Rx to Another Store and wait for Transfer Out Rx(s) window to appear.  
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 Perform a search for the pharmacy you want to transfer the Rx to. The pharmacy’s address 9.
and contact information will auto-populate. 
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a) To insert a new pharmacy record, click New and complete the Create Store form. 
When you are finished, click OK. 
 

 

 Enter the Pharmacist Name and Comments as required and click Transfer Out Eligible Rxs. 10.

 A prompt will appear asking if you want to print the Transfer Report. Answer Yes or No 11.
accordingly. 
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a. If you answer Yes, the Rx Transfer Report form will appear. Select what information 
you want included in the report and click Print. 

 

Sample Rx Transfer Report: 
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Once an Rx has been transferred to another pharmacy it will have a status of Intact(Transferred 
Out). 

 

Reactivate Rx 

The Reactivate function allows users reactivate prescription(s) with an Inactive status. Be 

careful when reactivating a prescription; be sure you know why the Rx was inactivated in the 

first place to avoid dispensing errors.  

Reactivate an inactive prescription as follows:  

1. Access the patient profile.  

2. Use the spacebar to highlight the inactive prescription you would like to reactivate.  

3. Click Extra Function with the mouse or press X on the keyboard.  

4. Select Reactivate Rx.  

5. The Reactivate Rx window will appear. Click Reactivate Eligible Rxs with the mouse or press 

Enter on the keyboard to reactive prescriptions with a status OK to Reactivate. 
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Patient Sidebar Functions 

Once a patient record is called up from the system, users can access/view a number of sidebar 

functions to the right of the screen. The following sub-section will explain sidebar functions 

applicable to pharmacies. 
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Alternate Address 

You have the option to add a secondary address for a patient using the Alternate Addresses 

option.  

Click Alternate Addresses from the Patient Sidebar to access the Alternate Patient Addresses 

window. From the Location field click Ins or Add to add a description for the new address (e.g. 

Summer Home, Parent’s Home, Child’s Home, etc.). Fill in the fields as required and click Save 

or press Enter on the keyboard when complete. 

 

You can access Alternate Addresses from the sidebar at any time to add additional addresses, 

edit existing information, or delete an address.  
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AR Profile 

AR Profile allows you to view the patient’s Accounts Receivable information. Accounts 

Receivable is a program that maintains the charges and payments made by customers within 

the store, allowing information about charges to be viewed, statements to be printed, and 

reports to be run to analyze the impact of the AR program within the store. 

 

Batches 

Batch filling is a feature available to nursing home customers that allows you to fill Rxs 

belonging to a particular cycle in a single batch.  

 

Select a batch and click Detail Batch to view additional details that pertain to the batch.  
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Charting 

Patient Charting allows you to monitor and record patient health metrics directly within the 

pharmacy management system. Benefits include the ability to print charts, as well as having the 

ability to electronically store patient health information in one area for ease of access. Values 

can be added to any chart by clicking the Ins key located to the right of the charting window. 

Users can edit or delete an entry by clicking F2 or Del respectively.  

NOTE: Any chart value that has a comment attached to it will have an asterisk to the left of 
the entry. Hovering the mouse over the entry will expand the comment in a yellow box. 

Weight 

Weight charting allows users to record values in kilograms (kg) or pounds (lbs). Only one form 

of weight measurement needs to be entered; the system will automatically convert the entered 

measurement into the form that is missing (e.g. if you enters 115lbs, the system will calculate 

the kg field to 52.27kg). 

Click Ins to add a new weight reading, F2 to modify an existing weight reading, and Del to 

delete a weight reading. 
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Height  

Height charting allows users to record values in centimeters (cm) or inches (in). Only one form 

of height measurement needs to be entered; the system will automatically convert the entered 

measurement into the form that is missing (e.g. if you enters 170cm, the system will calculate 

the inches field to 66.93in). 

Click Ins to add a new height reading, F2 to modify an existing height reading, and Del to delete 

a height reading. 

 

  



  Kroll Windows 10 User Manual  

 

90 
 

Blood Pressure 

Blood pressure charting allows entry of a Systolic, Diastolic, and Pulse Rate value. The pulse rate 

is measured in beats per minute (bpm).  

Click Ins to add a new blood pressure reading, F2 to modify an existing blood pressure reading, 

and Del to delete a blood pressure reading. 
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Blood Sugar 

The blood sugar concentration is the amount of glucose (sugar) present in the blood. If blood 

sugar levels drop too low, hypoglycemia can develop if untreated. If levels remain too high, 

hyperglycemia can develop and cause many of the long term health problems associated with 

diabetes. Blood sugar values are measured in millimoles per litre (mmol/L) within the system.  

Click Ins to add a new blood sugar reading, F2 to modify an existing blood sugar reading, and 

Del to delete a blood sugar reading. 
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Cholesterol 

Total cholesterol levels are recorded in millimoles per litre (mmol/L).  

Click Ins to add a new cholesterol reading, F2 to modify an existing cholesterol reading, and Del 

to delete a cholesterol reading. 
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Creatinine CL 

Creatinine clearance values are used to evaluate the rate and efficiency of kidney filtration. It is 

used to help detect and diagnose kidney dysfunction and/or the presence of decreased blood 

flow to the kidneys. Creatinine clearance charting allows users to enter values for Weight, 

Height and Serum Creatinine level (SCr) which is measured in millimoles per liter (mmol/L).  

Click Ins to add a new creatinine CL reading, F2 to modify an existing creatinine CL reading, and 

Del to delete a creatinine CL reading. 
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INR – International Normalized Ratio 

An INR is useful in monitoring the impact of anticoagulant medicines, such as Warfarin. An INR 

can be too high; a number greater than 4 may indicate that blood is clotting too slowly, creating 

a risk of uncontrolled bleeding. An INR less than 2 may not provide adequate protection from 

clotting. INR charting allows the INR Factor to be entered as well as the anticoagulant daily 

dose.  

Click Ins to add a new INR reading, F2 to modify an existing INR reading, and Del to delete an 

INR reading. 
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Clozaril 

Patients taking Clozaril are required to have white blood cells (WBCs) and Absolute Neturophil 

Count (ANC) levels monitored on a regular basis by physicians and dispensing pharmacists. 

These values can be recorded in the patient record of the Kroll Pharmacy Software for instant 

lookup and retrieval.  

Click Ins to add a new Clozaril reading, F2 to modify an existing Clozaril reading, and Del to 

delete a Clozaril reading. 
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Consent 

The Consent window allows you to record whether or not the patient has given the pharmacy 

consent for the following: 

 Privacy Consent 

 PASI Enrolment 

 MediResource Patient Consent Enrolment 

 Pharmaspace Enrolment 

 Antiviral Consent 

 Central Fill Consent 

 ODB Frequency of Dispensing 

 Rx Synchronization Consent 

 

Click Ins to add a new consent, F2 to modify an existing consent, and Del to delete a consent. 

Credit Cards 

The Credit Cards section is used to store patient credit card information. In order for credit card 

information to be entered, you must: 

a) Be assigned to a use group that has permission to view credit card information. 
b) Have the credit card access password. 

 

 

Click Ins to add a new credit card, F2 to modify an existing credit card, and Del to delete a credit 

card. 
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Documents 

Kroll has built-in functionality to import and attach external files (e.g. docx, pdf, xslx, jpeg, etc.) 

to specific patient records through the Document function listed on the patient sidebar. With 

this function, you can import medical forms, medication charts, lab results, etc. into the system 

for electronic storage. Electronic files facilitate a paperless pharmacy as well as providing ease 

of access.  

 

Click Ins or Add New Document to add a new patient document, F2 to modify an existing 

patient document, and Del to delete a patient document. 

Medication Review/Dialogues 

Medication Review/Dialogues is used to record patient review sessions, such as Medication 

Reviews, General Counseling, or Pharmacist Consultations. Clicking Medication 

Review/Dialogues from the navigation pane will open the patient’s Medication Reviews 

profile.  
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Select N - New Review/Dialog to insert a new review/dialogue record, F2 - View Details  to 

view details of an existing review/dialog, P - Print/Reprint to print an existing review/dialog, F - 

Call up to continue working on an existing review/dialog, and C - Cancel Claim to cancel an 

existing review/dialog. The D - Pharmacist Declined and R - Patient Refused buttons are used 

to record reviews/dialogs that have been declined by the pharmacist or refused by the patient. 

 

See the Medication Review user guide for your province for more information about 

Medication Reviews: https://www.kroll.ca/user-guides.html. 

Rx Counseling History 

Rx Counseling History is used to record the patient’s Rx counseling sessions. Recording Rx 

counseling sessions in patient profile helps pharmacies meet the legal requirement for 

counseling documentation.  

Use the Type menu to specify if you want to view Rx counseling sessions that have been 

Accepted, Rejected, performed on Paper, or <All>.  

 

  



  Kroll Windows 10 User Manual  

 

100 
 

Click F2-View to view the counseling information for a selected counseling record.  
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History 

Patient History allows users to track changes made to the Patient Record including changes to 

third party plans, phone numbers, addresses, etc. The Patient History window is read-only and 

displays entries sorted by date and you who executed the change. To view details of a patient 

record change, simply click on the plus sign (+)to expand the details or hide details by clicking 

on the minus sign (-).  

 

Select a change record and click Display Record After Changes to view what the patient profile 

looked like after that particular change was made. 

Select a change record and click Display Record Before Changes to view what the patient 

profile looked like before that particular change was made.  

Limited Use Items 

Limited Use numbers are stored at the patient level and they can be attached to a patient 

without filling a prescription when presented with a LUP form from the patient.   

The Patient Limited Use Drugs screen displays all the Limited Use Drugs that is available in the 

patient record. You can manually insert a Patient Limited Use Drugs record by clicking Ins or 

pressing Insert on the keyboard. 
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To Do Items 

The To Do screen displays all outstanding callbacks and followups for the patient. You can 

manually insert a to do item for the patient by clicking Ins or pressing Insert on the keyboard.  

 

Work Orders 

The Work Orders screen displays all outstanding work orders for the patient.  
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Drug Records 

Drug records contain comprehensive information about how drugs should be stored, 

administered, handled, and priced. This section explains how to perform drug searches and 

how to create and manage drug records. 

Searching for a Drug 

Method 1: From the F5 - Drug Screen 

 Select F5 - Drug from the Alt-X Start screen.  1.

 Enter one of the following patient search criteria and click Search:  2.

a) Brand/Generic Name, Strength/Pack Size (e.g. Apo-Metformin, 500/360)  
b) DIN (5-8 digits)  
c) UPC (11-12 digits)  
d) A period (.) and the Drug Quick Code (e.g. TYLE3)  
e) # symbol and the Catalog Item Number (e.g. #78945) 
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 Double-click the drug record. The F5 - Drug screen will display. 3.

 

Method 2: From the Alt - X Start Screen 

 Enter any of the search criteria described above in the Universal Search Field, located on 1.
the Alt - X Start screen, and click F5 - Drug. 
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 A list of drugs matching the search criteria will be displayed. Double-click the applicable 2.
drug record. 

 

The F5 - Drug screen will display. 

Method 3: From the F11 - Drop-Off Screen 

 Call up the F11 - Drop-Off screen and perform a patient search. Once you have selected a 1.
patient, the Drug/Mix field will become available.  

 Enter any of the search criteria described above in the Drug Search field and press the Enter 2.
key on your keyboard. 

 

 A list of drugs matching the search criteria will be displayed. Double-click the applicable 3.
drug record. The F5 - Drug screen will display. 
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Performing an Advanced Drug Search 

If a drug is not found through a regular drug search as described in the previous section, an 

Advanced Drug Search can be performed. 

 Call up the F5 - Drug search screen and place a checkmark next to Advanced. The Advanced 1.
Search pane will appear. 

 

 Enter any available advanced drug search criteria and click Search. 2.

Inactive Drug Records  

You have the ability to inactivate drug records in the system by un-checking the Pack Active flag 

located on the drug record. Inactivating a drug record means that the drug record will not show 

up in the regular drug search; an Advanced search for inactive drugs will have to be initiated in 

order to access the record.  

 



  Kroll Windows 10 User Manual  

 

107 
 

NOTE: Inactive drug records cannot be used in prescriptions. The Pack Active flag must be 
turned on in order to fill prescriptions for that drug. 

There are various reasons why you may choose to inactivate drug records. For example, a drug 

may be inactivated because the manufacturer no longer produces the particular pack size, or 

the drug may be discontinued. Inactivating these records allows the regular search to provide 

more succinct results; this reduces the possibility of selecting the wrong drug pack into a 

prescription.  

To locate inactivated drug packs in the system, perform an Advanced search and make sure the 

Only Inactive or All flag is marked on the far left. Search as usual to find the applicable record. 

 

NOTE: Inactive drug records will appear in red text in the drug search screen. 

Configuring the Columns in the Drug Search Screen    

You can configure the columns that are displayed on the Drug Search screen by clicking Change 

Columns from the right navigation pane. 
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The Edit Scan Columns window will appear. Place a checkmark next to the columns you want 

displayed and click OK. 

 

Creating a New Drug Record 

1. Perform a thorough search to ensure the drug does not already exist in the database. You 
will be prompted to perform an Advanced search for inactive drugs as well.  

2. Once you have determined that the drug does not exist in the system, click Insert or press 
the Insert key on the keyboard. 

 

 Enter a pack size for the new drug and click OK. 3.

 

 A blank F5 - Drug screen will appear. Complete the drug fields and click Save. 4.
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Copying an Existing Drug Record 

If a drug manufacturer releases a new strength for an existing drug product, users can utilize 

the copy function to prevent having to re-enter duplicate drug information. Copy an existing 

drug to a new drug record as follows:  

 Perform a thorough drug search to ensure that the new drug does not already exist in the 1.
database. You will be prompted to perform an Advanced Search to make sure the drug 
record they are adding is not simply inactivated.  

 Once you have determined that the drug does not exist in the system, click Copy Drug or 2.
press CTRL+Y on your keyboard. 

 A second drug search window will appear. Search for the drug that should already be in the 3.
system.  

 

 Highlight the drug you want to copy and click Select. The selected drug record will appear. 4.
Review the information and confirm that it is the drug you want to copy information from. 
Click Select. 

 Enter a pack size for the new drug and click OK. 5.

 A prompt will appear asking if you want to copy the price information to the new drug. 6.
Answer Yes or No accordingly. 

 Enter any missing information for the new drug record. Note that the DIN will not be copied 7.
over. 

 Click Save to save the drug record. 8.
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Drug Record Fields 

Equivalent To 
If the drug record is a generic product, this field displays the brand name equivalent.  

Default SIG 
Used to quickly populate the Rx with a repeatedly used sig code.  

Location 
Store level users can enter information about the physical location of a drug product in this 

field to facilitate retrieval (e.g. Refrigerator, Safe, etc.) 

Generic Type 
Displays one of the following options:  

 Brand Multi Source Brand  

 Brand Multi Source Generic  

 Brand Single Source  

 Generic Multi Source  

 Generic Single Source 

DIN 
Displays the Drug Identification Number for the drug product. This field can also house “PDIN – 

Pseudo DIN”, “ NPN – Natural Product Number”, “HDIN – Homeopathic DIN”, or “OPIN – 

OPINION”.  

Strength 
Displays the strength of the drug product.  

Followup (Days): Users can enter the number of days that elapse before a follow-up reminder is 

created in the system to remind the pharmacist to follow up with the patient regarding their 

drug treatment.  

Form 
Displays the form of the drug product (e.g. capsule, tablet, injection, etc.)  

Route 
Displays the route of administration for the drug product (e.g. oral, topical, intravenous, etc.)  

Manufacturer 
Displays the manufacturer of the drug product (e.g. Astra, Pfizer, Apotex, etc.)  
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Handling Instr. 
Users can enter handling instructions for a drug product (e.g. for example, sublingual tablets 

should be handled with clean dry hands).  

Price Group 
A price group can be assigned to a drug record for activation of specific pricing requirements. 

Drug Price Groups are configured and assigned by head office.  

Department 
Drug Departments are used to narrow report output to certain clusters of drugs, similar to the 

function of Drug Groups. The main difference between Drug Groups and Drug Departments is 

that a drug record can only belong to one department which maintains mutual exclusivity 

between departments, whereas a drug record can have multiple Drug Groups.  

Marketing Message 
Marketing messages are configured by head office. These messages promote and support 

awareness for certain products as well as facilitate branding of the business. When a Marketing 

Message is entered into a drug record, the message will be printed on the patient receipt 

whenever a prescription is filled for the drug. For example, if a pharmacy is holding a diabetes 

clinic, a marketing message can be attached to diabetic drugs and supplies to promote and 

provide information regarding the clinic.  

Fee For Service 
Fee For Service entries are configured and maintained by head office. When this field is 

populated, it means that the drug record is being used to bill a professional service. Some types 

of professional service billings require specific indicators to be sent to the third party in order 

for the claim to go through; by selecting the appropriate Fee for Service option in the drug 

record, billing indicators are automatically sent with the prescription during adjudication.  

Reportable 
A checkmark in this field indicates that the system will track prescriptions filled for the drug 

product and display results in the Narcotic Report.  

Dispense as Pack 
A checkmark in this field indicates that the drug product will be billed to third parties as 

multiples of one pack rather than billed as dosages. This flag is used for billing of birth control, 

inhalers, and nasal sprays in some provinces.  

Ward Stock 
This option is used for pharmacy’s that dispense ward stock to patients. 
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Trial: When this flag is checked, a prompt will appear during the first fill of a prescription asking 

you if they would like to fill a trial supply rather than filling the total dispense quantity of the 

prescription.  

Device 
This flag indicates that the drug record is for a medical device, not a drug product. This flag is 

also used in the transmission of DIS device transactions in Atlantic Provinces.  

Immunization 
This flag indicates that the drug record is for an immunization.  

Print Compliance Calendar 
When this flag is on, a calendar containing empty boxes will appear for the guest to document 

once a dose has been taken. 

Eligible for Coupon 
Coupons are configured and set up by home office. When this flag is on, the configured coupon 

will be printed when the drug product is filled in a prescription.  

Flavor Rx 
This flag indicates that flavoring should be used to augment the taste of the medication. A note 

will be printed on the hardcopy to remind users to use flavoring during preparation of the drug.  

Health Inform/Rx Canada 
Maintained by head office, this flag will be checked for drugs qualifying for programs used to 

distribute patient education leaflets complementing Kroll Care. 

Class 
Displays the therapeutic class code as obtained from First Data Bank.  

Clinical Form 
Displays the clinical form of the drug product as obtained from First Data Bank.  

Narcotic Monitoring*: This flag will be checked for drug products that are a part of the 

provincial Narcotic Monitoring Program (not applicable in all provinces).  

View Reason Codes 
This button is only applicable to Ontario pharmacies. Access of this option will display Reason 

Codes and Reason Code descriptions for Limited Use products. There is also an option to print 

Reason Code information from the window.  
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Drug Line 1 
Displays the type of drug information (i.e. Brand, Generic, Description, Description 2, Equivalent 

To) that is printed on the vial label.  

Drug Line 2 
Displays the type of drug information, different from Drug Line 1 that is printed on the vial 

label.  

Half-size SIG 
When this flag is activated, it will cause the SIG to print at half the size it normally prints at. This 

option is useful for drug products that usually have long SIG instructions, for example eye 

drops.  

Track Lot Num 
When this flag is activated, you will be required to enter the lot number of the drug product 

into the Motorola handheld during the filling stage.  

Track Expiry 
When this flag is activated, you will be required to enter the expiry date (MM/YYYY) of the drug 

product into the Motorola handheld during the filling stage.  

Refrigerated 
When this flag is activated, the word “Refrigerated” will appear on the handheld during filling 

and at point of sale during the prescription pick up stage.  

Drug Substitutions 
The Drug Sub function allows users to point the drug record to an interchangeable substitute. 

This function allows users to switch away from using one brand to another. When a Drug Sub is 

entered into this field, you will be prompted to use the substitution when inputting a 

prescription.  

Comments 
Drug records can have an unlimited number of comments. To add a comment, click Ins, press 

Insert on the keyboard, or simply begin typing the comment.  

Select a topic for the comment by clicking on the down arrow or pressing the down arrow on 

the keyboard to view the list of choices. A topic must be selected in order to save the comment.  

Each comment has three options. To enable an option, use the mouse to click on the checkbox 

or TAB to the desired option and use the spacebar to select.  

Show On Rx 
Enabling this option will display the comment on the F12-Filling Screen.  
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Print on Hardcopy 
Enabling this option will print the comment on the hardcopy portion of the Rx label. Note that 

only one drug comment can be flagged on the hardcopy due to limited space.  

Alert 
Enabling this flag will cause the comment to pop up every time the drug card is accessed.  

To delete a comment, highlight the appropriate comment entry and click Del, or press Delete 

on the keyboard. A window will appear to confirm the deletion.  

To edit a comment, highlight the applicable comment entry and either:  

 Click F2 with the mouse  

 Press F2 on the keyboard  

 Double click on the comment and make the necessary changes.  

 Click Save or press Enter to save changes. 

Groups 
Drugs can be included in a “group” for a wide range of reporting purposes. Drug Groups are 

created by head office and can be applied to any number of drug records. For example, a drug 

group called “Diabetic Supplies” can be created and attached to a drug records for diabetic 

supplies. Also note that drugs can belong to more than one Drug Group.  

Drug Information Tabs 

The drug record contains tabs of information located at the bottom right of the screen. To 

move to a specific tab, press CTRL on the keyboard and the underlined letter on the tab (e.g. 

Press CTRL+R to access the Ordering tab). You can also flip from tab to tab by pressing CTRL+→ 

to move right or CTRL+← to move left. 
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General 

The General tab displays general information about cost and quantity that pertains to the 

selected drug. 

 

Packs (#) 
This area displays the different pack sizes available for the drug product (in Ontario, this area 

will also display ODB pack sizes). When a drug pack is highlighted, the information displayed to 

the right will refer to the specific pack size selected.  

Pack Active 
Pack sizes that are actively being used, or have been used recently in a prescription should have 

the Pack Active flag enabled. Users can remove the Pack Active flag for pack sizes that have 

been discontinued, or are no longer in use by the pharmacy. Inactive drug packs will not be 

returned on a regular drug search; an advanced drug search must be executed in order to view 

inactive drug packs.  

Quick Code 
Enter a short code that represents the drug record which facilitates searching (e.g. T3 for 

Tylenol with Codeine #3). Note that the Quick Code must be preceded by a period (.) in the 

drug search screen to indicate that you is searching using Quick Code convention.  

Purchase Price 
The first price field always displays the price used to purchase the drug product from the 

vendor (i.e. acquisition cost). Pricing strategies within the system may pull from this field.  

Price Fields 
The four price fields located below the Purchase field will vary from province to province and 

will be centrally maintained by head office. Pricing strategies set within the system may pull 

from one of these fields.  
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Default Vendor 
The default vendor will be set to K&F for all drug records.  

On Hand 
The On Hand field displays the current amount of medication available for dispensing. Users will 

be required to enter their User Initials and Password in order to modify values in the field.  

Min Qty 
The minimum quantity field displays the point when a drug pack is triggered for reordering. For 

example, if the minimum quantity is set at 100, when the on hand drops below 100 units, the 

drug pack will be placed on order. The Days field will display the minimum number of days’ 

supply that triggers reordering and is related to Min Qty through a calculated formula. Min Qty 

is required for perpetual inventory.  

Max Qty 
The maximum quantity tells the system how much of a drug product should be reordered. For 

example, if a drug pack has a Max Qty set to 300, the system will order enough so that the 

current on hand reaches 300 units. The Days field displays the maximum days’ supply a store 

should have on hand and is related to Max Qty through a calculated formula. Max Qty is 

optional for perpetual inventory; when the field is empty the system will always order 1 

package of the drug pack.  

UPC 
The UPC field displays the drug pack UPC. If there is more than one UPC for the drug pack, the 

UPC marked as “default” will be displayed here (See UPC section for further details).  

Lot 
User can optionally enter the Lot number of the drug product in this field. Note that this field 

cannot account for multiple lot numbers.  

Expiry Date 
Users can optionally enter the expiry date of the drug (DDMMYYY) in this field, or type in the 

number of Days that the drug is good for once it is dispensed. The expiry date will print on the 

vial label. Note that this field cannot account for multiple expiries.  

Only allow manual price changes 
A checkmark in this field ensures when updates are ran against the drug card, the pricing fields 

will not updated. 

Front Store 
A checkmark in this flag indicates that the product is available over-the-counter.  
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Drug Picture 
A large majority of drug records will have a drug picture attached. Periodic updates from 

central maintenance will ensure that drug records have an associated drug picture.  

Created On 
The timestamp indicates the date and time the drug record was created.  

Changed On 
The timestamp indicates the date and time the drug record was last changed.  

Ordering 

The ordering tab contains information and configurations related to drug ordering.  

 

Packs (#) 
This area displays the different pack sizes available for the drug product (in Ontario, this area 

will also display ODB pack sizes). When a drug pack is highlighted, the information displayed to 

the right will refer to the specific pack size selected.  

Available Vendor Items 
This area displays the default vendor.  In addition, the item number, description and catalog 

price for the drug product is displayed here.  
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No Inventory Adjustment 
When this flag is activated, the On Hand field will not be adjusted when the drug is dispensed, 

nor will it be adjusted when the product is received into the system; in other words, this flag 

causes the On Hand field to remain static. This flag may be used for OTC products that you 

create a “Not Dispensed” prescription for because you want it in the patient’s medication 

history, but you don’t want to deduct inventory from the drug record.  

Disable Automatic Ordering 
When this flag is activated, the drug product will not be included in the automatic order even 

when the On Hand quantity is less than the Minimum. Users may activate this flag for 

expensive products they want to order on demand rather than through the automatic ordering 

system.  

On Hand 
The On Hand field displays the current amount of medication available for dispensing. Users 

will be required to enter their User Initials and Password in order to modify values in the field. 

This field is also available from the General Tab.  

Base Ordering On 
Ordering points can be based on Min/Max or Usage/Days Supply (default). In both scenarios, if 

automatic ordering is activated, a drug product will be placed on order when the On Hand 

value drops below the Minimum value. When Min/Max is selected, the Days Supply fields will 

be greyed out and vice-versa.  

Benefits of Min/Max ordering 

You can control the exact point at which a drug is reordered by setting an exact minimum value.  

The Min/Max values do not change once they are set because the values are independent of 

usage.  This is particularly useful for drugs that the pharmacy wishes to under-stock or 

overstock.  

Drawbacks of Min/Max ordering 

The Min/Max values do not change once they are set, so you must be aware of drug usage and 

adjust ordering points accordingly when required.  

Benefits of Usage (Days Supply) ordering 

Drug reorder points are dynamic values that increase or decrease depending on how often the 

drug is dispensed within the days supply indicated. This is particularly useful for cyclical drugs 

like allergy medications that are dispensed frequently during some parts of the year and less 

during other parts.  
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Drawbacks of Usage (Days Supply) ordering  

The minimum and maximum values are not open for manipulation as they are calculated 

values; this may result in less control over the exact point the drug is ordered.  

Min Scripts Calc 
The system can calculate Script quantity based on Maximum Rx Quantity or Average Rx 

Quantity.  

Order in Multiples of ___ Packs 
This configuration is useful for products that are dispensed in multiple packs. For example, birth 

control is usually dispensed in packs of three, so you may wish to order product in multiples of 

threes.  

Place Order 
Accessing the Place Order function will allow you to add a manual order for the drug; this 

manual order will become a part of the automatic order when it is generated. To create a 

manual order, simply select the Vendor (i.e. McKesson), enter the quantity being ordered, and 

enter the Order Date. This function is most commonly used when the pharmacy wants to order 

more of a product even when the On Hand quantity is greater than the minimum required.  

 

Additionally, accessing the Place Order function allows you to future-date a drug order so that 

the drug product will be placed on order on the date specified. This is useful for drug products 

that have short expiries or are costly to stock in advance of dispensing. To future-date an order 

simply enter the date in the future that you would like the drug product to be ordered.  
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Order Grouping 
This function is used to create re-order points for a drug grouping. By grouping interchangeable 

drugs Kroll will re-order the primary assigned pack when stock depletes from each drug card in 

the group. 

 

Usage Values 
Usage Values provide users with a succinct snapshot drug movement in terms of daily usage, 

average Rx quantity, and maximum Rx quantity. Usage values help users to make optimal 

decisions on replenishment.  

Outstanding Orders 
Whenever the drug product has been ordered, an entry will be created under Outstanding 

Orders to indicate that the drug product is on its way to the pharmacy, or is in the process of 

being ordered. 

Whenever there is an entry under Outstanding Orders, the drug product will NOT be ordered 

even when the On Hand is below the minimum required; this prevents the system from 

duplicating orders for drug products. 
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UPCs 

The UPCs tab contains all UPCs listed for the selected drug pack. Highlight the applicable drug 

pack on the right hand side to view UPCs corresponding to the pack size. UPCs are centrally 

maintained; therefore, any errors should be communicated to the Pharmacy Support Helpdesk 

for correction.  

The UPCs listed in this section are used to verify that the product being used to package an Rx 

at the filling stage is the correct product.  

 

Plans 

The information contained in the Plans tab is centrally maintained by head office and serves 

two purposes. The first is to display formulary coverage for the drug product. You can look 

under this tab and locate the entry for the provincial plan (in this case ODB for Ontario) and see 

if the drug product is covered or not. Provincial coverage is updated regularly through 

formulary updates to the system.  

 

The second purpose of the Plans tab is to house Pseudo DINs that are adjudicated to third 

parties for financial reimbursement. To view details of a pseudo DIN, highlight entry of choice 

and press F2 on the keyboard, or double click on the entry. This will call up the Drug-Plan 

Information window where detailed pseudo DIN information is displayed.  

From the Drug-Plan Information window, users can see which pack sizes the pseudo DIN is 

being applied to. When the Default flag is checked, it means that the pseudo DIN will be 

automatically sent to the third party during adjudication; if the Default flag is NOT checked, the 

DIN on the drug record will be sent to the third party rather than the pseudo DIN. A checkmark 

next to the Covered flag indicates that the third party plan will pay for the drug product; this 

flag serves information purposes only. 
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Usage 

The Usage tab displays information regarding how often and in what volume a drug product is 

being dispensed over a specified time period. This information helps you to determine if 

current ordering points (i.e. Min/Max values) support optimal replenishment. The graph on the 

Usage tab displays how many prescriptions have been filled for the drug product and the total 

drug quantity dispensed monthly. Use the Year dropdown menu to specify a date range.  

 

Old Costs 

The Old Costs tab displays pricing changes made to any of the 5 price fields located on the 

General Tab of the drug record. Each of the five pricing fields will display Current Costs, Old 

Cost, Changed On and Changed By columns so that users can accurately identify when, why 

and by whom a price change was made. 
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Counseling 

The Counseling tab displays patient counseling messages extracted from the First Data Bank 

(FDB) clinical drug module. Counseling messages are broken down into Patient Messages and 

Professional Messages.  

 

Kroll Care  

The Kroll Care tab displays the Drug Information Monograph that is printed out and handed to 

the patient during the prescription filling process. The content of Kroll Care is provided by the 

First Data Bank (FDB) clinical drug module. Users can print the drug information monograph on 

demand by clicking Print Kroll Care from the drug sidebar, or by accessing the Drug dropdown 

menu and selecting the command to Print Kroll Care. 
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Drug Sidebar Functions 

The Drug sidebar is available at the right of the screen whenever a Drug Record is accessed. The 

Sidebar options allow users to quickly access functions related to the drug with just a click of 

the mouse. The following section will explain how each of the Drug Sidebar functions is used. 
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Order Drug 

Accessing the Order Drug function from the sidebar will open up the same window as pressing 

the Place Order button under the Ordering tab. This window allows you to add a manual order 

for the drug; this manual order will become a part of the automatic order when it is generated.  

To create a manual order, simply select the Vendor (i.e. K&F), enter the Order Quantity, and 

enter the Order Date. This function is most commonly used when the pharmacy wants to order 

more of a product even when the On Hand quantity is greater than the minimum required. 

 

Additionally, accessing the Place Order function allows users to future-date a drug order so that 

the drug product will be placed on order on the date specified. This is useful for drug products 

that have short expiries or are costly to stock in advance of dispensing. To future-date an order, 

enter the date in the future that you would like the drug product to be ordered.  
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Receive Drug 

The Receive Drug function is used to add drugs to your pharmacy’s drug inventory. When drugs 

are received into the system, the on hand quantity for that drug is updated accordingly. 

To record that an order has bene received, select Receive Drug to open the Receive a Drug 

form. Enter the number of Packs being received, the Lot Number, Expiry Date, and the Reason 

for adjusting the on-hand quantity for that drug. Click Save to save your changes. 
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Returning to Stock 

From the drug card side menu you can choose to return inventory to stock using the Return to 

Stock feature. Enter the Qty to return to stock and select a Reason for returning to stock. Click 

Save to save your changes. 

 

Perform FDB Analysis 

Users can initiate a First Data Bank (FDB) clinical analysis of a drug by selecting Perform FDB 

Analysis from the sidebar. 
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Place a checkmark next to the clinical drug information you want to retrieve. The Select All and 

Select None buttons allow you to quickly check or uncheck all options. Once selections have 

been made, click OK or press Enter on the keyboard to retrieve data from First Data Bank (FDB).  

Results of the analysis will be displayed in the Clinical Reports window under separate tabs 

across the top of the screen. Click Back to move left a tab, click Next to move right a tab. There 

is also an option to print the clinical report by selecting File > Print. 
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Analyze Multiple Drugs 

The option to Analyze Multiple Drugs allows you to view interactions between two or more 

drugs. The analysis is based on the First Data Bank (FDB) clinical module.  

When Analyze Multiple Drugs is selected, the Drug Analysis Form will be displayed. Locate the 

Drug Search Criteria field and search and select the drug(s) you want to perform the 

interactions checking against. Users can add any number of drugs into the analysis. Once you 

has added all the drugs they want to analyze, click Perform Analysis. 

 

A selection screen will appear where you can select what elements you would like to analyze. 

Once selections have been made, click OK or press Enter on the keyboard to retrieve data from 

First Data Bank (FDB).  
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Results of the analysis will be displayed in the Clinical Reports window under separate tabs 

across the top of the screen. Click Back to move left a tab, click Next to move right a tab. There 

is also an option to print the clinical report by selecting File > Print. 
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Customize FDB Info 

Customize FDB Info allows you to customize if, when, and for whom Counseling messages, 

Kroll Care, and Auxiliary labels are printed for the drug, and the order which they appear. 

 

Click Apply to apply you FDB information changes. 

Print Kroll Care 

Kroll Care is an information printout that is provided to patients upon receiving their prescribed 

medication. The content of Kroll Care is provided by the First Data Bank (FDB) clinical drug 

module. Click Print Kroll Care to generate.  
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Alerts  

Alerts are messages regarding the drug products that are pushed down from head office. Click 

on the Alerts button to read the details of the message. The bracketed number next to the 

Alert button indicates the number of alert messages for the drug product. Alert messages are 

printed along with Kroll care and distributed to the patient as additional drug information. Drug 

alerts are added by head office and can be found under Edit ˃ Lists ˃ Drug Alerts. 

 

Generic Equivalents 

The Generic Equivalents function allows you to view a comprehensive list of generic 

equivalents for a drug product. In Alberta and British Columbia, the Generic Equivalent list is 

maintained by First Data Bank (FDB) Updates, whereas in the rest of the provinces, the Generic 

Equivalent list is maintained by Provincial Formulary Updates. Highlight a generic equivalent 

entry and click Select or press Enter on the keyboard to pull up the corresponding drug record. 

Each entry will display the following information:  

 Preferred Brand Indicator (1 = Preferred; 2 = 2nd Preferred, etc.)  

 DIN  

 Drug Name  

 Manufacturer  

 Unit Cost (Acquisition Cost ÷ Pack Size)  

 On Hand quantity (Allows users to quickly see what brands are stocked)  

 Extra info comment if applicable  
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Modification History  

The Modification History function calls up read-only data regarding any and all changes made 

to the drug record. Details of the changes can be expanded (click on the + sign) or condensed 

(click on the - sign) depending on the level of detail you wants to see. For example, if there is 

inventory missing or overstated in the drug record, users can go into Modification History to 

view what changes were made to the On Hand field. 

 

Select a change record and click Display Record After Changes to view what the drug profile 

looked like after that particular change was made. 

Select a change record and click Display Record Before Changes to view what the drug profile 

looked like before that particular change was made. 
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Old/New DIN Links 

DIN Links are centrally maintained by head office. Din Links appear for drug products that have 

had a DIN change. The function of the DIN Link is to link the old DIN to the new DIN so that the 

system recognizes both DINs are for the same product. Users cannot create a DIN Link, but they 

can remove a DIN Link by highlighting the entry and clicking Del or pressing Delete on the 

keyboard. 

 

Order History 

The Order History function displays read-only information on when the drug product was 

placed on order (i.e., InitPO), sent (i.e., Ord), and received (i.e., Rec). You can access the Pack 

Size dropdown menu to view order history for different packs of the drug product. This screen 

helps you determine root causes of ordering issues and/or discrepancies. 
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Reason Codes 

The Reason Codes function is only applicable to pharmacies operating in the province of 

Ontario. Drug products that are eligible to be billed to the provincial plan (ODB) using Limited 

Use (LU) Codes can access the Reason Code sidebar function to view all codes, descriptions and 

expiries for the LU drug. You can print the codes by clicking Print or pressing CTRL+P on the 

keyboard. 

 

Mixture Records 

Mixture records are composed of two or more drug records. The drug records within a mixture 

are referred to as “components”. The following sections will describe two methods of searching 

for mixtures in Kroll Version 10. 

Searching for a Mixture 

Method 1: From the F5 - Drug Screen 

 Select F5 - Drug from the Alt-X Start screen.  1.

 Place a checkmark next to Mixture and enter one of the following search criteria: 2.

a) Search using Mixture Description, also known as Mixture Name.  
b) Search using mixture Components; type in the full or partial component names 

separated by commas. It does not matter what order the components are entered. For 
example, to search for “Hydrocortisone 1% Powder in Clotrimaderm 1% Cream” users 
can search “hydro, clot” or “clot, hydro”.  
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c) Search by entering a period (.) followed by the Mixture QuickCode. If a mixture does 
not have a Quick Code assigned to it, this type of search cannot be executed.  

d) Search for ALL mixtures in the database by entering an asterisk (*). 
 

 

 Double-click the mixture record. The F5 - Mixture screen will display. 3.
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Method 2: From the F11 - Drop-Off Screen 

 Call up the F11 - Drop-Off screen and perform a patient search. Once you have selected a 1.
patient, the Drug/Mix field will become available.  

 Enter any of the search criteria described above in the Drug Search field and press the Enter 2.
key on your keyboard. 

 

 A list of mixtures matching the search criteria will be displayed. Double-click the applicable 3.
mixture record. The F5 - Mixture screen will display. 
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Performing an Advanced Mixture Search 

If a mixture is not found through a regular mixture search as described in the previous section, 

an Advanced Mixture Search can be performed. 

 Call up the F5 - Mixture search screen and place a checkmark next to Advanced. The 1.
Advanced Search pane will appear. 

 

Enter any available advanced mixture search criteria and click Search. 

Inactive Mixture Records    

Similar to drug records, you have the ability to inactivate mixture records if they become 

obsolete or are no longer used. To inactivate a mixture record, uncheck the Active flag. 

Inactivated mixtures will not show up in the “regular” mixture search; an “advanced” search for 

Inactive records must be initiated in order to access mixture information.  

 

NOTE: Inactive mixture records cannot be used in prescriptions. The Active flag must be 
turned on in order to fill prescriptions for that mixture. 

Inactivating mixture records that are not actively being used to fill prescriptions allows the 

regular search to provide more succinct results thereby reducing the chances of selecting the 

wrong mixture into a prescription.  
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Inactivating mixture records that are not actively being used to fill prescriptions allows the 

regular search to provide more succinct results thereby reducing the chances of selecting the 

wrong mixture into a prescription.  

To locate inactivated mixtures in the system, perform an Advanced search and make sure the 

Only Inactive or All flag is marked on the far left. Search as usual to find the applicable record. 

 

Configuring the Columns in the Mixture Search Screen 

You can configure the columns that are displayed on the Mixture Search screen by clicking 

Change Columns from the right navigation pane. 
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The Edit Scan Columns window will appear. Place a checkmark next to the columns you want 

displayed and click OK. 

 

Mixture Naming Conventions (Recommended) 

When creating a new mixture record, it is recommended to use the following Mixture 

Description naming convention:  

 Active Ingredient(s) should come before base ingredient(s). If there is more than one active 1.
ingredient, the one with the higher concentration goes first, followed by the active 
ingredient with the second highest concentration, etc.  

 Base ingredient(s) go after active ingredients. If there is more than one base ingredient, the 2.
one with the higher proportion goes first, followed by the base ingredient with the second 
highest proportion, etc.  

 Percentages/ratios go after the name of a component (e.g. “Hydrocortisone Powder 1%”, 3.
rather than “1% Hydrocortisone Powder).  

 Spell out full component names and forms when possible. If there is not enough room, 4.
abbreviate the form before abbreviating the components; furthermore, abbreviate the base 
components before active components.  

Whenever possible, enter mixture proportions by percentage so that the system can 

automatically calculate how much of each component is needed to make the mixture 

regardless of dispense quantity.  
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Creating a New Mixture Record 

Mixture records are added and maintained by store-level users, not by the central system, 

which makes understanding them especially important. Avoid adding a mixture record without 

performing a thorough search of the system; duplicate mixture records cause confusion for the 

pharmacy and potentially for the patient. 

NOTE: If a mixture component is inactive or missing during mixture creation, you will have to 
open a new Kroll session to reactivate/add the component before continuing to create the 
mixture record. 

1. Perform a thorough search to ensure the mixture does not already exist in the database. 
You will be prompted to perform an Advanced search for inactive drugs as well.  

2. Once you have determined that the drug does not exist in the system, click Insert or press 
the Insert key on the keyboard. 

 

 A blank F5 - Mixture screen will appear. Complete the mixture fields and click Save. 2.
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Inserting Mixture Components    

A mixture record is not complete without the addition of mixture components. In fact, users 

cannot save a mixture record until components have been selected.  

 Call up the Mixture card for the mixture you want to add components to and click Ins or 1.
press the Insert key on your keyboard from the Components pane. 

 

 Perform a drug search. Highlight the applicable component and click Select. 2.

 The Compound Component form will appear. Click Add. 3.
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 Repeat steps 2-3 for each component you want to add to the mixture. When you have 4.
finished adding components, click Close to exit the drug search screen. 

 The drug components will appear in the Components pane. Click Save to save the mixture 5.
record. 

 

Mixture Information Tabs 

The mixture record contains tabs of information located at the bottom right of the screen. To 

move to a specific tab, press CTRL on the keyboard and the underlined letter on the tab (e.g. 

Press CTRL+R to access the Ordering tab). You can also flip from tab to tab by pressing CTRL+→ 

to move right or CTRL+← to move left. 
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General 

The General tab displays general information about the selected mixture. 

 

Enter Proportions by 
Identify the best, or most applicable, way to enter the proportions of the mixture. 

 Percentage: Whenever possible, use percentages (i.e. ratios) to enter mixture 
proportions. Using percentages allows the system to calculate how much of each 
ingredient is required to compound any dispensing quantity. The Base Quantity for 
mixtures entered in percentage proportions is always equal to 100.  

 Units: Compounds made up of ingredients with different forms may require 
components to be entered by units rather than percentages. When Units are used to 
enter mixture proportions, you must indicate the quantity being prepared in the Base 
Quantity field in order for the system to correctly calculate how much of each 
ingredient is required for compounding.  

 Bags/Capsules: When preparing I.V. bags or pharmacy prepared capsules, enter 
proportions by Bags/Capsules. When Bags/Capsules is selected, you must indicate the 
number of bags or capsules being prepared in the Base Quantity field in order for the 
system to correctly calculate how much of each ingredient is required for compounding.  

Base Quantity 
Specify the physical quantities of the mixture components and must reflect the selected 

proportion type (Percentage, Units, or Bags/Capsules). 

Form 
Specify the physical state of the mixture (i.e., liquid, powder, vaccine). 
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Route of Admin 
Specify how the mixture must be administered (i.e., injection, topical, oral). 

Schedule 
Select the drug schedule of the mixture if it contains controlled component. 

Oral/Written 
Indicate whether the mixture requires an oral or written prescription; if neither option applies, 

select Not Specified.  

Mix Type 
The mixture type is required for adjudication purposes. Select from one of the following 

mixture types:  

 0-Topical Cream  

 1-Topical Ointment  

 2-External Lotion  

 3-Internal Use Liquid  

 4-External Powder  

 5-Internal Powder  

 6-Injection or Infusion  

 7-Ear/Eye Drop  

 8-Suppository  

 9-Other  

Price Group 
Created by head office, price groups are used to price Rxs. If this mixture requires special 

pricing, the price group field can be populated to maintain the automatic pricing. 

 Default SIG 
If the mixture is always dispensed with the same SIG instructions, users can optionally enter a 

“Default SIG” in this field. The SIG will automatically be carried over to the prescription filling 

screen when the mixture record is selected, but can be overridden.  

Provincial PIN 
Each province’s provincial plan covers certain mixtures; these mixtures have assigned pseudo 

DINs (i.e. PINs) which can be viewed under the Provincial PIN dropdown menu. If the mixture 

record is covered by one of the pseudo DINs, select the correct PIN from the dropdown menu.  

Expiry (Days) 
If applicable, enter the number of days the mixture is good for once it has been compounded; 

the system will calculate a calendar date for when the mixture reaches expiry and prints this 

date on the vial label.  
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Active 
The Active flag is checked by default. Uncheck the Active flag if the mixture record is no longer 

being used in any active prescriptions, or if the mixture has become obsolete.  

Reportable 
Place a checkmark next to the Reportable flag if the mixture contains a narcotic component. 

When the Reportable flag is checked, the mixture will be tracked in the system’s Narcotic 

Report.  

Refrigerated 
Place a checkmark next to the Refrigerated flag if the mixture requires refrigeration. When the 

Refrigerated flag is checked, a message will appear during the filling stage to remind you that 

the mixture needs to be stored in a refrigerator subsequent to preparation.  

Methadone 
The methadone flag should only be checked for methadone mixture records. Activation of this 

flag enables the “carries” function and other methadone related dispensing functions.  

Mixture Time 
The Mixture Time chart allows users to configure the Mixture Fee charged to the patient based 

on the amount of mixture being dispensed. Each mixture will have its own mixture fee tier. 

Each row in the chart represents a pricing tier: 

 The first row represents the minimum mixture fee charged to the patient. The Rx 
quantity should equal zero because any dispense quantity greater than zero requires a 
minimum base fee to be charged.  

 The second row of the chart is the second tier for the mixture fee; the Rx quantity 
entered here should be the threshold value where making more than that quantity will 
mean graduating to the next tiered fee.  

 You can choose to add up to 5 mixture pricing tiers, however this is not required and 
depends on the complexity of the mixture.  
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The last entry in the chart or the final pricing tier represents the maximum mixture fee charged; 

any dispense quantity greater than the Rx quantity listed here will charge the maximum 

mixture fee only.  

The above Mixture Time chart reads, “When the Rx (dispense) quantity is equal to or greater 

than 0, then charge 8 minutes of mixture time; when the Rx (dispense) quantity is equal to or 

greater than 100, then charge 10 minutes of mixture time; when the Rx (dispense) quantity is 

equal or greater than 250, then charge 16 minutes of mixture time; and any dispense quantity 

greater than 250, charge a maximum of 16 minutes of mixture time.  

 

Instructions 

The Instructions tab records any special instructions that must be followed when compounding 

the mixture (e.g., heating time, use of mixing solutions).  
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Handling Instructions 
Enter any instructions that must be followed when preparing the compound. 

Batch Quantity 
Batch quantities of a mixture may be compounded at store level because it is dispensed 

frequently. Enter the volume of the batch in this field and the system will deduct quantities 

dispensed against the value entered here (equivalent to the drug On Hand).  

Print Instructions at Fill 
Select Never if you do not want instructions to print when and Rx for the mixture is filled; select 

Always if you do want instructions to print, and Prompt if you want to be prompted to print 

instructions. 

Print both Batch and Fill Instructions 
Place a checkmark next to this option if you want both batch and fill instructions to be printed 

when an Rx for the mixture is filled or batched. 

Add Component Names to Instructions 
Click this button to include the names of the mixture components in the instructions field. 

 

Comments 

The Comments tab displays any general comments that pertain to the mixture.  
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To insert a new comment, click Ins or press the Insert key on your keyboard. The Comments 

window will open. Select a Topic and enter your comment.  

 

Place a checkmark next to Show On Rx if you want the comment to appear when filling an Rx 

for the mixture, Alert if you want a popup message to appear when filling an Rx for the mixture 

indicating that a comment is present, and Print On Hardcopy if you want the comment to print 

on hardcopies when an Rx is filled for the mixture. Click Save to save the comment. 

Click F2 to edit an existing comment and Del to delete a comment. 

Plan 

The Plans Tab of the mixture record houses Pseudo DINs that are adjudicated to third parties 

for purposes of financial reimbursement. Mixture Pseudo DINs will need to be added and 

maintained by store-level users.  
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To add a new plan, click Ins or press the Insert key on your keyboard. The Mixture-Plan 

Information form will appear. 

 

SubPlan 
Select the third party plan that is associated with the pseudo DIN from the dropdown menu. 

Description 
Enter a general description or a note associated with the pseudo DIN. This field will be set to 

Default if no description is specified. 

Default 
This option is enabled by default and instructs the system to automatically send the pseudo DIN 

to the third party plan whenever an Rx is processed for the mixture. 

DIN 
Select from PDIN (pseudo DIN), NPN (Natural Product Number), HDIN (Homeopathic DIN), 

OPIN (OPINIONS). Proceed by entering the 8-digit drug identification number in the field to the 

right. 

Covered 
This is an information flag that indicates third party coverage. Place a checkmark next to this 

flag if the associated third party covers the costs of the medication.  

Mix Type 
Place a checkmark next to this option if the third party plan requires submission of a Mix Type 

that is different than what is set on the Mixture Record. This field is commonly used for 

Methadone mixtures billed to Green Shield.  
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Bill As Pack 
Place a checkmark next to this flag if the mixture needs to be billed to the third party by packs 

rather than by units. 

Fee Schedule 
This field specifies the fee category the mixture will be billed as to the third party plan. 

Click F2 to edit an existing plan and Del to delete a plan.  

Other 

The Other tab displays information about when the mixture was created, last changed, last 

used in an Rx, and any groups the mixture may belong to. 

 

Created On 
The date the mixture record was created. 

Changed On 
The date the mixture record was last modified. 

Last Rx On 
The date an Rx was last filled for the mixture. 

Workflow/Packaging 

 Track Mixture Lot Number when Packaging: Activate this flag if you would like to 
require the lot number for each component to be entered/ scanned during mixture 
packaging verification (i.e. filling).  

 Track Mixture Expiry Date when Packaging: Activate this flag if you would like to 
require the expiry date for each component to be entered/ scanned during mixture 
packaging verification (i.e. filling).  

 Require Ingredient Confirmation when Packaging: Activate this flag if you would like to 
require the UPC for each component to be scanned during mixture packaging 
verification (i.e. filling). 
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Groups 
Mixtures can be included in a group for reporting or dispensing purposes. Mixture groups are 

created by head office and can be applied by pharmacy users to any number of mixtures. For 

example, a group called “Methadone” can be created and attached to all methadone mixture 

records. Also note that a mixture record can belong to more than one Mixture Group.  

To add a drug group, click Ins or press Insert on your keyboard. The Add/Delete Groups 

window will appear.  

 

Highlight the desired item(s) from the Available Groups pain and click Insert. The group(s) will 

appear in the Selected Groups pain. Click OK to close the Add/Delete Groups window. 

 

Click the F2 button to modify an existing group and the Del button to delete a group from the 
mixture profile. 

Mixture Pricing 

Mixture pricing is made up of a number of elements:  

Price/Minute  
Dollar amount charged for each minute of mixture time (centrally maintained according to 

provincial standards).  

Mixture Fee 
Derived from the Mixture Time Chart on the mixture record. Mixture Fee is calculated based on 

the quantity dispensed in the prescription.  
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Cost of the components 
Derived from acquisition cost for mixture components (i.e., drug records). Acquisition cost is 

maintained through invoice receiving or catalogue feeds.  

Markup Strategy 
Set by home office and centrally maintained. 

Setting Minimum & Maximum Mixture Fee    

To set a minimum and maximum mixture fee, users must first call up the mixture record and 

refer to the Mixture Time Chart. The first line of the Mixture Time Chart configures the 

minimum fee charged for the mixture; in the chart below, even if the pharmacy makes one 

gram (1 gm) of mixture, there will be a minimum of 5 minutes charged. The last line of the 

Mixture Time Charge configures the maximum fee charged for the mixture; in the chart below, 

even if the pharmacy makes 1000gm of mixture, the maximum time charged will be 10 

minutes.  

 

The lines (or tiers) in between the minimum and maximum charge account for prescriptions 

where the dispense quantity lies between the two barrier points. For example, according to the 

Mixture Time Chart above, if a prescription has a dispense quantity of 100gm, 7 minutes of 

mixture time will be charged. 
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Setting a Flat Mixture Fee    

A flat fee can be set for a mixture, which means that no matter how much is dispensed, the 

same mixture fee will be applied to the prescription. A flat fee configuration is achieved by 

setting a single line in the Mixture Time Chart. The following flat fee configuration reads any 

dispense quantity greater than zero will be charged 12 minutes of mixture time.  
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Mixture Breakdown    

Whenever a user is filling a prescription for a mixture, it is always recommended to review the 

“Mixture Breakdown” before adjudicating the Rx. The Mixture Breakdown provides exact dollar 

amounts for elements that make up mixture pricing (e.g. Mixture Fee, Component Costs, etc.).  

Access the Mixture Breakdown from the F12-Filling Screen as follows:  

 From the F12 screen, all prescription information should be entered and populated:  1.

 From the prescription sidebar, click Mixture Breakdown, or press ALT+V+M on the 2.
keyboard. The Mixture Breakdown window will appear. 

 

Component Quantity and Associated Cost  

Total Base Cost  
Total acquisition cost of all components.  

Embedded/Rx Markup 
Centrally maintained.  

Dispensing Fee 
Regular and Customary Rx Dispensing Fee (centrally maintained).  

Mixture Fee 
Based on Mixture Time Chart and quantity dispensed  

Mixture Minutes 
Used to calculate Mixture Fee  
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Rx Quantity 
Rx Dispense Quantity  

Users also have an option to Print Mixture Instructions which will print the comments inputted 

in the Instructions Tab of the mixture record as well as other relevant information. 

Once the Mixture Breakdown has been reviewed, click Close or press Enter on the keyboard to 

escape back to the mixture prescriptions. 

Prescriber Records 

Prescriber records contain comprehensive information about prescribers’ contact details, 

licence numbers, and other specifics. This section explains how to prescriber searches and how 

to create and manage prescriber records. 

Searching for a Prescriber Record 

Method 1: From the F7 - Doctor Screen 

 Select F7 - Doctor from the Alt-X Start screen.  1.

 Enter one of the following patient search criteria and click Search:  2.

a) Last Name, First Name (e.g. “house, greg” OR “hou, g” OR “house” OR “,greg”).  
b) A period (.) and the Doctor Quick Code (e.g. “.house”).  
c) 7 or 10 digit phone number of the prescriber office.  
d) A number sign (#) and the prescriber license number (e.g. #123454).  
e) An asterisk (*) to search for ALL prescribers in the database. 
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 Double-click the prescriber record. The F7 - Doctor screen will display. 3.

 

Method 2: From the Alt - X Start Screen 

 Enter any of the search criteria described above in the Universal Search Field, located on 1.
the Alt - X Start screen, and click F7 - Doctor. 

 

 A list of prescribers matching the search criteria will be displayed. Double-click the 2.
applicable prescriber record. 
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The F7 - Doctor screen will display. 

Method 3: From the F11 - Drop-Off Screen 

 Call up the F11 - Drop-Off screen and perform a patient search. Once you have selected a 1.
patient, the Doctor field will become available.  

 Enter any of the search criteria described above in the Doctor search field and press the 2.
Enter key on your keyboard. 

 

 A list of prescribers matching the search criteria will be displayed. Double-click the 3.
applicable prescriber record. The F7 - Doctor screen will display. 

Performing an Advanced Prescriber Search 

If a prescriber is not found through a regular prescriber search as described in the previous 

section, an Advanced Drug Search can be performed. 

 Call up the F7 - Doctor search screen and place a checkmark next to Advanced. The 1.
Advanced Search pane will appear. 
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 Enter any available prescriber information and click Search. 2.

Inactive Prescriber Records  

You have the ability to inactivate prescriber records in the system by un-checking the Doctor 

Active flag located on the drug record. Inactivating a prescriber record means that the 

prescriber will not show up in the regular prescriber search; an Advanced search for inactive 

prescribers will have to be initiated in order to access the record. 

 

NOTE: Inactive prescriber records cannot be used in prescriptions. The Doctor Active flag 
must be turned on in order to fill prescriptions for that prescriber. 

There are various reasons why you may choose to inactivate a prescriber record. For example, a 

prescriber may be inactivated because they have retired, or has been relocated to a different 

region. Inactivating these records allows the regular search to provide more succinct results; 

this reduces the chances of selecting the incorrect prescriber into a prescription.  

To access inactive prescriber records in the system, perform an Advanced search and make 

sure the Inactive or All flag is marked. Search for the prescriber as usual to find the applicable 

record. 
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Configuring the Columns in the Prescriber Search Screen    

You can configure the columns that are displayed on the Prescriber Search screen by clicking 

Change Columns from the right navigation pane. 

 

The Edit Scan Columns window will appear. Place a checkmark next to the columns you want 

displayed and click OK. 
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Creating a New Prescriber Record 

1. Perform a thorough search to ensure the prescriber does not already exist in the database. 
You will be prompted to perform an Advanced search for inactive prescribers as well.  

2. Once you have determined that the prescriber does not exist in the system, click Insert or 
press the Insert key on the keyboard. 

 

 A blank F7 - Doctor screen will appear. Complete the prescriber fields and click Save. 3.

Prescriber Record Fields 

Last Name 
Type in the Last Name of the prescriber (do not add any symbols to this field).  

First Name 
Type in the First Name of the prescriber (do not add any symbols to this field).  

Salutation 
From the dropdown menu, select from Dr. Miss. Mr. Mrs. Ms.  

Quick Code 
Enter an optional code for searching the prescriber. For example, “Dr. Gary Thomson” may 

have a quick code of “THOMG”. The quick code field can also be used to identify doctors 

working at the same clinic or hospital. For example, users can enter a quick code “CLINIC” for all 

doctors working at the nearby clinic; when you searches “.CLINIC” all patients with that quick 

code will be displayed.  

Address  
Type in the prescriber’s street address in one or both lines.  

City, Province, Postal, Country 
Type in the rest of the address information.  

Locations 
Physicians who practice in more than one physical location can have multiple addresses and 

contact numbers in their record. Place a checkmark next to Primary Location if the location 
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listed is the prescriber’s primary place of practice. When the prescriber is used in a prescription, 

the location will default to the primary location unless otherwise specified.  

Click Ins or press the Insert key on your keyboard to add a new location. A window will appear 
prompting you to enter a description for the new location (e.g., Clinic, Hospital, etc.). Enter the 
new location and click Save.  
 

 
 
The Address, City, Province, Postal Code, Country, Phone, and Fax fields will become available 
to input details for the secondary location; fill out these fields accordingly.  
Click F2 to edit an existing location and Del to delete a location. When a location is deleted, the 
address and contact information is also removed from the record.  

Comments 
Prescribers can have an unlimited number of comments and each comment can have an 

unlimited amount of content.  

To add a comment, click Ins or press the Insert key on your keyboard. The Comments window 

will appear.  

Select a Topic and enter your comment in the comment field. Place a checkmark next to Show 

On Rx if you want the comment to appear on the Rx, Print On Hardcopy if you want the 

comment to show on hardcopy printouts, and Alert if you would like to be alerted of the 

comment whenever the prescriber record is accessed.  
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Click Save to save the comment. 

 

Click F2 to edit an existing comment and Del to delete a comment. 

Show on Rx 
Enabling this option will display the comment on the F12-Filling Screen. 

Print on Hardcopy 
Enabling this option will print the prescriber comment on the hardcopy. Note that only one 

prescriber comment can be flagged for this option as there is limited space on the hardcopy.  

Alert 
Enabling this flag will cause the comment to pop up every time the prescriber record is 

accessed and every time an Rx is filled for the patient. 

Prescriber Groups 
Prescribers can be included in a group for a wide range of reporting purposes. Prescriber groups 

are created by head office and can be applied to any number of prescriber records. For 

example, a prescriber group called “Walk-In Clinic” can be created and attached to prescriber(s) 

that work at the walk-in clinic; reports on Rx volume can be generated for the group. 

To add a group, click Ins or press the Insert key on your keyboard to call up a selection window 

displaying the available groups to insert. 

Use the F2 button to modify an existing group and Del to delete a group. 
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General Information Tab 

 

Designation 
Select a designation for the prescriber by clicking the down arrow or by pressing the down 

arrow on the keyboard.  

Specialty 
Optionally select a specialty for the prescriber by clicking the down arrow or by pressing the 

down arrow on the keyboard.  

Dispensing Rights 
Select from the following options:  

 Full Rights: This selection means the prescriber can dispense Schedule 1, 2, 3, Targeted, 
Controlled and Narcotic prescriptions.  

 No Narcs: This selection means the prescriber cannot dispense Narcotic substances. If 
you attempt to process a narcotic Rx using the prescriber record, the system will display 
a warning message, “This doctor is not allowed to dispense narcotics”, and prevent the 
Rx from moving to the next Rx processing stage.  

 No Narcs or Controlled: This selection means the prescriber cannot dispense Narcotic or 
Controlled substances. If you attempt to process a narcotic or controlled Rx using the 
prescriber record, the system will display a warning message, “This doctor is not allowed 
to dispense narcotics or controlled drugs”, and prevent the Rx from moving to the next 
Rx processing stage.  

Written Language 
This field is defaulted to English, but can be overridden to another language. This field is not 

tied to any functionality and only serves information purposes.  
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Spoken Language 
This field is blank by default, but can be selected to reflect the spoken language of the 

prescriber. This field is not tied to any functionality and only serves information purposes.  

Email 
Enter the email address of the prescriber.  

Primary License Number 
Enter the license number of the prescriber in this field. Select the applicable province from the 

dropdown menu. Note that the Ref ID (or Reference ID) is automatically set when a 

“designation” is selected for the prescriber record; however, it can be overridden, by placing a 

checkmark next to Override.  

Alternate License Number 
If the prescriber practices in more than one region, they may have an alternate license number 

which can be entered in this field.  

No Kroll Care 
Activation of this flag means that Kroll Care will not be generated for prescriptions from this 

prescriber.  

No Fax Refills 
Activation of this flag will cause a warning message to appear whenever the “Fax Doctor 

Report” is generated. The warning will indicate that the prescriber does not accept fax requests 

for prescription refills; however, you will still have the option to print the “Fax Doctor Report” 

after acknowledging the warning.  

No Phone Refills 
Activation of this flag will cause a warning message to appear whenever the option to “Call 

Doctor” is selected from the Rx Filling Screen, or from the patient profile. The warning will 

indicate that the prescriber does not accept phone requests for refills.  

Signature Load 
For terminals hooked up to a Document scanner, users can load the prescriber signature into 

the system by scanning the written prescription and cropping the signature. Once the signature 

has been scanned and saved, it will be available during “Check” stages for cross-checking.  

To load a prescriber signature, feed the written prescription into the Document scanner and 

click Load from the prescriber record.  
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Once the image has been loaded, users can crop the scanned image from the Doctor Signature 

window by clicking and dragging a box around the signature. Click Save or press Enter to save 

the signature.  

To remove an existing prescriber image, simply click Delete from prescriber record.  

Dates 

 Created On: Indicates when the prescriber record was created.  

 Changed On: Indicates when the prescriber record was last changed.  

 Last Rx On: Indicates when the last time and Rx was filled using the prescriber record.  

Workflow Management 

Workflow management in Kroll allows pharmacy users to process prescriptions in a structured 

and standardized manner. This user guide illustrates how a typical prescription progresses 

through the Kroll system with the following workflow elements activated: 

 Multiple workflow queues including ‘Waiting for Pickup’ 

 No hardcopy generation 

 Electronic signature capture 

 Thermal printing 

The model described in this document describes workflow management at its highest potential, 

using the latest available technology. Workflow management can be tailored to meet the needs 

of any pharmacy environment. If you require further information, please contact the Kroll sales 

team at 416-383-1010 (option 3), or 1-800-263-5876 (option 3), or sent an email to 

sales@kroll.ca. 
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Start Screen 

 

A. Workflow queues configured for the system. 

 ToDo/Data Input: Items in this queue require data to be entered in order to complete 
the record. Use the scanned image of the written prescription as a reference and enters 
the appropriate information. Note that refill prescriptions ordered via an IVR system are 
placed into this queue for processing. 

 Data Verification/Adjudication: After the prescription data has been entered 
successfully, the record moves to the Data Verification/Adjudication queue. At this 
point, a pharmacy team member will confirm that the data inputted in the previous step 
is correct by comparing the scanned image of the original written prescription to the 
data that was inputted. Once the correct data has been confirmed, the internal DUE 
process commences and any potential ADR’s are identified. Once managed, adjudication 
occurs if the prescription is being paid for by the patient’s third party plan. 

 Packaging: Once adjudication has been completed, the record moves to the Packaging 
queue. When selected, the prescription is displayed on the Packaging screen. It is here 
that the pharmacy team member will scan the UPC code on the product to confirm that 
the correct item has been selected from the shelf. If desired, the pharmacy team 
member can also record the lot number and expiry date for each pack used to complete 
the packaging step of this prescription. 
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 Package Verification: Once packaging has been completed, the prescription moves to 
the Package Verification queue. When selected, the prescription is displayed on the 
Package Verification screen. The pharmacy team member, with vial in hand, will 
compare what is on the original prescription, to what was key entered into Kroll, to 
what is on the label and finally to what is in the vial. 

 Clinical Verification: Once all other steps have been completed, the pharmacist is 
provided with the opportunity to evaluate the prescription and determine that it is 
clinically correct for the patient. 

 Incomplete Pickup: This queue should always have zero prescriptions in it. If a 
prescription is listed, it means that something occurred during pickup that needs to be 
resolved. 

 Waiting for Pickup: Prescriptions stay in this queue until they have been picked up out 
of Kroll. 

B. Grid: The numbers on the grid represent the number of prescriptions currently located 
within each queue and when they are due to be completed. This provides the pharmacy 
team with the ability to quickly see where the bulk of the work is. Once seen, then 
adjustments to the operations can be implemented in order to keep up with the work. 

C. Pickup Grid: This grid provides the pharmacy team with a picture of how many prescriptions 
are in their pickup bin/drawer and how long they have been there. The value noted in the 
Total field should equal the total number of prescriptions found in the pickup bin/drawer. 
The value noted in the Total $ space represents the total coat (actual acquisition cost) of all 
prescriptions in the pickup bin/drawer.  
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Drop-off 

The Drop-off screen allows users to enter Rx information quickly and efficiently. Most of the 

entry work can be completed while the patient is still in the pharmacy, thus reducing lineups 

and wait time.   

 Call up the F11 - Drop-off screen and perform a patient search. Double-click the patient 1.
record and click the Drop-off button. 
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 Place the written prescription face down in the document scanner and select Import Script 2.
Image File. 

 

 The Scan Image screen will appear with the scanned image displayed. If there is more than 3.
one item on the written prescription, enter the total number of items in the # of Rxs On 
Page field. 

 



  Kroll Windows 10 User Manual  

 

173 
 

 Click Save. The prescription image will appear in the Drop-off screen. 4.
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 Ask the patient when they want to pick up the prescription. Based on their response, select 5.
an option from the Rx Status field. (Options include Fill, Unfill, Not Disp, and Stock Trans.) 
Your choice will dictate how the Rx will progress through the system. 

 

 Click Add. The prescription will be placed into the workorder. 6.
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 Click Fill Later. The prescription record will progress to the next workflow step and the 7.
Drop-off screen will refresh. You can begin serving the next patient in line.  

 

NOTE: If the pharmacy is not busy, you can complete the Rx fields on the Drop-off screen 
before adding the prescription to the workorder. 

For more information about Drop-off, see the Drop-off – F11 section on our website.  

ToDo/Data Input 

Once the Drop-off step has been completed, the prescription will move to the ToDo/Data Input 

queue.  

 Select F9 - Workflow from the Alt-X Start screen. Click ToDo/Data Input to view all 1.
prescriptions currently in the ToDo/Data Input queue. The prescriptions will display in order 
of priority (those with sooner due times are displayed first). 

 

  

http://www.kroll.ca/userguides/9.1%20F11%20Drop-off.pdf
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 Double-click the prescription you want to work on, or click Get Work to consecutively work 2.
on each prescription in the queue, in order of priority. 

 

 The Create New Rx From To Do screen will display. Complete the Rx fields based on the 3.
information available on the script image.  
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 Click Lookup Rx. The system will perform a drug/mixture search and a doctor search based 4.
on the information entered. Select the correct drug/mixture and doctor records. 

 

 When you are finished entering information in the Create New Rx From To Do screen, click 5.
Save.  

 The F12 - Fill Rx screen will appear with all the Rx details entered. Review the information 6.
and make any necessary changes. Click F12 - Fill Rx to move the prescription to the next 
workflow step. 
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Data Verification/Adjudication 

Once the ToDo/Data Input step has been completed, the prescription will move to the Data 

Verification/Adjudication queue.  

 Select F9 - Workflow from the Alt-X Start screen. Click Data Verification/Adjudication to 1.
view all prescriptions currently in the Data Verification/Adjudication queue. The 
prescriptions will display in order of priority (those with sooner due times are displayed 
first). 

 

 Double-click the prescription you want to work on, or click Get Work to consecutively work 2.
on each prescription in the queue, in order of priority. 

 The Data Verification screen will display. Using the scanned prescription image on the left, 3.
ensure all of the entered information is correct. If you detect an error, do one of the 
following to have it resolved: 

f) Click F12 - Return to Rx. The F12 screen will display where you can make the 
necessary changes. Click F12 - Save to save your changes. The Data Verification 
screen will display again. 

g) Click Save for Later. The Rx will be placed back into the queue where it can be 
completed later.  

h) Click Cancel Rx. The Rx will be cancelled outright. 

i) Click Trouble. The Rx will be placed in the Trouble queue. You will be prompted to 
specify why the prescription is being moved; this allows the prescription to be 
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moved out of the flow without disrupting the prescriptions that follow behind it. 
Another user can manage the prescription from the Trouble queue, if need be. 

j) Click Reject. The Rx will be sent back to the previous workflow step. You will be 
prompted to specify why the prescription is being rejected; this ensures the next 
user knows why the prescription was rejected and can make the necessary changes 
before progressing the Rx to the next workflow step. 

 To confirm that you have performed the Data Verification step correctly, click the 4.
checkboxes (which are configurable) next to each key piece of information. You must check 
each box before the Approve button will become available. The key pieces of information 
that must be checked are Patient, SIG, Drug, Qty, Prescriber, Auth Qty, and Drug Strength. 

 

 Click Approve.  5.

NOTE: If you have electronic signatures linked to this step, you will be prompted for your 
signature after you have clicked Approve.  
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 The internal DUE process will display any important messages that the pharmacist should 6.
view. If configured, the pharmacist will be required to entire their login credentials before 
the prescription can continue. 

 If the patient has a third party plan in their profile, the claim will be transmitted once the 7.
DUE has been completed. Review and adjust the information on the Adjudication Response 
screen as per the current process. 

Packaging 

Once the Data Verification/Adjudication step has been completed, the prescription will move to 

the Packaging queue.  

 Select F9 - Workflow from the Alt-X Start screen. Click Packaging to view all prescriptions 1.
currently in the Packaging queue. The prescriptions will display in order of priority (those 
with sooner due times are displayed first). 

NOTE: To maximize efficiency, the Packaging workstation should have a barcode scanner 
connected to it. 

 

 Double-click the prescription you want to work on, or click Get Work to consecutively work 2.
on each prescription in the queue, in order of priority. 
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 The Package Rx screen will display. Based on the displayed information, retrieve the 3.
medication from the shelves. 

 

 Using the bar code scanner, scan the UPC on the product. If the correct drug and pack size 4.
are selected, a ‘UPC match found for selected pack’ message will display and you can 
continue.  

If the wrong pack size is selected, the ‘UPC matches a different pack size for this drug’ 

message highlighted in yellow will display. You must change the prescription to include the 

correct pack size.  You can do this in one of two ways:  

k) Click F12 - Return to Rx. The F12 screen will display. Make the necessary changes and 
click F12 - Save Changes.  

l) Select Change Pack Sizes from the right navigation pane.  Follow the prompts to select 
the correct pack size.  If the wrong drug is selected and scanned, a message stating 
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‘The UPC does not match’ will display in red. You cannot proceed until the correct item 
has been selected and scanned successfully. 

 Press Enter. 5.

 If desired, scan the bottle or manually enter the Expiry Date and Lot number for the 6.
product. 

 

 When all of the information has been entered successfully, click Package. 7.

 

 The Packaged button will become available. Click to proceed. 8.
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A vial label will print from the thermal printer associated with the Packaging workstation. 

 

NOTE: The Packaging screen allows you to record if more than one pack of a product was 
used to complete the prescription, as well as how many tablets/capsules/millilitres were 
used from each pack. If you discover that you do not have enough product to completely fill 
the prescription, you can arrange to owe the patient a portion of their prescription by 
clicking the Owe button. You will be prompted to enter the quantity that you are dispensing 
up front. The system will automatically create a second ‘Owe’ transaction and place it in the 
Trouble queue with a reason of ‘Insufficient inventory’. Once the inventory is replenished, 
access the Trouble queue and remove the ‘Owe’ status. The transaction will be place into 
the Packaging queue where it can be processed like any other prescription.  
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Package Verification 

Once the Packaging step has been completed, the prescription will move to the Package 

Verification queue.  

 Select F9 - Workflow from the Alt-X Start screen. Click Package Verification to view all 1.
prescriptions currently in the Package Verification queue. The prescriptions will display in 
order of priority (those with sooner due times are displayed first). 

 

 Double-click the prescription you want to work on, or click Get Work to consecutively work 2.
on each prescription in the queue, in order of priority. 
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 The Package Verification screen will display. Confirm that what is in the vial and what is 3.
printed on the vial label matches what has been entered on the right side of the screen. 

 

If an error is detected, do one of the following: 

a) Click F12 - Return to Rx. The F12 screen will display where you can make the 
necessary changes. Click F12 - Save to save your changes. The Package Verification 
screen will display again. 

b) Click Save for Later. The Rx will be placed back into the queue where it can be 
completed later.  

c) Click Cancel Rx. The Rx will be cancelled outright. 

d) Click Trouble. The Rx will be placed in the Trouble queue. You will be prompted to 
specify why the prescription is being moved; this allows the prescription to be 
moved out of the flow without disrupting the prescriptions that follow behind it. 
Another user can manage the prescription from the Trouble queue, if need be. 
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e) Click Reject. The Rx will be sent back to the previous workflow step. You will be 
prompted to specify why the prescription is being rejected; this ensures the next 
user knows why the prescription was rejected and can make the necessary changes 
before progressing the Rx to the next workflow step. 

 Once the prescription has been completely verified, click Approve.  4.

 You will be prompted for a pharmacist’s signature. Using the stylus, sign your name. Touch 5.
the Done button on the signature pad or click OK on the screen. 
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Clinical Verification 

Once the Package Verification step has been completed, the prescription will move to the 

Clinical Verification queue.  

 Select F9 - Workflow from the Alt-X Start screen. Click Clinical Verification to view all 1.
prescriptions currently in the Clinical Verification queue. The prescriptions will display in 
order of priority (those with sooner due times are displayed first). 

 

 Double-click the prescription you want to work on, or click Get Work to consecutively work 2.
on each prescription in the queue, in order of priority. 
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 The Clinical Verification screen will display. This screen has several tabs across the top that 3.
provide all of the necessary information that you require to properly evaluate the 
prescription.  

 Clinical Verify tab: 
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 Rx tab: 
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 Financial tab: 
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 Rx Images tab: 
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 Workflow tab: 
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 Packaging tab: 

 

 Once the prescription has been completely verified, click Approve.  4.
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 You will be prompted for a pharmacist’s signature. Using the stylus, sign your name. Touch 5.
the Done button on the signature pad or click OK on the screen. 

 

A prescription receipt will print from the thermal printer associated with the Clinical 
Verification workstation. 
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A privacy label will print from the thermal printer associated with the Clinical Verification 
workstation. 

 

A wallet card will print from the thermal printer associated with the Clinical Verification 
workstation. Wallet cards can be configured to print one per patient or one per work order. 
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If configured, a Kroll Care sheet will print from the laser printer. 
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Waiting for Pickup 

Once the Clinical Verification step has been completed, the prescription will move to the Rxs 

Waiting for Pickup queue. The medication should be bagged and placed in a drawer where it 

will wait to be picked up by the patient. 

 

 When the patient arrives at the Pickup counter, select F10 - Pickup from the Alt-X Start 1.
screen. 

 Enter the patient’s name in the search field and click Search. A lost of patients who have 2.
prescriptions in progress and who match the search criteria will display. 
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 Ask a few confirming questions to ensure you have located the correct patient and 3.
prescription. Click Select. A list of prescriptions associated with the patient will appear, 
along with its current workflow state. 

 

 Place a checkmark next to the prescription(s) that is being picked up and click Pickup [x] 4.
Item(s). 

 

 The patient search screen will display. Highlight the patient’s name and click Select. 5.
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 Depending on your configuration settings, you may be required to enter an identification 6.
number for the patient. Enter the patient’s identification number in the Photo ID # field and 
select an identification Type from the menu. When you are finished, click Confirm. 

 

 Retrieve the patient’s medication and scan the barcode on the privacy label using the 7.
barcode scanner. You can also manually enter the barcode information. This step ensures 
that the correct prescription has been taken from the drawer. 

 

 Click Confirm [x] Item(s). 8.

 

The screen will refresh so you can begin serving the next patient who is waiting to pick up 
their medication.  
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Workstations 

Implementing a structured approach to prescription processing allows you to assign a specific 

function to each workstation in your pharmacy. Below is a diagram that illustrates how you can 

assign each workflow queue to a separate workstation: 

 

To assign each workflow queue to a separate workstation, call up the F9 - Workflow screen and 

click the workflow queue(s) you want to activate. Work from the activated queue(s) will be 

displayed and worked on at that workstation. 

If you do not have a large number of workstations, you can still designate specific workstations 

for specific tasks by turning on the queues that you want activated at that workstation. The 

only limitation is the peripheral equipment. For example, if you want a workstation to be used 

for Packaging, then that workstation must have a barcode scanner and thermal printer 

associated with it. If you want a workstation to be used for Clinical Verification, then that 

workstation must have a digital signature pad and a thermal printer associated with it. 

In a multi-workstation scenario, Kroll recommends at least one workstation be set up as an “all-

in-one” workstation. This workstation allows a single pharmacist who is working alone to be 

able to perform all workflow steps from one spot in the dispensary.  In order to accomplish this, 

the following peripheral equipment must be associated with the workstation: 

 Thermal printer for vial labels 

 Thermal printer for receipts/wallet cards/privacy labels 
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 Barcode scanner  

o For product scanning at Packaging 

o For prescription scanning at Pickup 

 Digital Signature Pad 

F12 - Fill Rx Screen 

The F12 screen contains all the Rx information that is entered during the prescription filling 

process. This section explains each component of this screen, including the Rx fields, the 

options in the menus and on the navigation pane, and how to manage warnings and Rx 

messages. 

Main Screen 

The F12 screen is the focal point of a prescription. It brings all the main elements of a 

prescription together on one screen. Included are details on who filled the prescription and any 

legacy details about the prescription. A ribbon bar provides functionality at your fingertips 

along with access to a robust arrangement of reports and utilities that can be accessed without 

exiting the program. 
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Information Bar 

The information bar is located along the top of the F12 screen, directly below the function keys. 

Below is a description of each field in the information bar. 

 

Last Rx Number: This read-only field shows last Rx number filled for the Rx. 

 

Rx Label: This read-only field displays shows what mode the Rx has been called up in (i.e., New 

Rx, Refill, Modify Rx). 

 

Pending Adjudication:  This read-only field indicates that the Rx is pending adjudication if the 

adjudication step has not been completed. The field is blank once adjudication is complete. 

 

First Fill: This read-only field shows the original fill date for the Rx.  

 

Number of days since First Fill: This read-only field shows the number of days that have passed 

since the original fill date. 
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Last Fill Information:  This read-only field shows the last fill date for the Rx

 

Number of days since Last Fill: This read-only field shows the number of days that have passed 

since the last time the Rx was filled.

 

Qty: This read-only field shows the quantity that was dispensed the last time the Rx was filled.

 

Last total: This read-only field shows the amount that was charged the last time the Rx was 

filled.

 

Init: This read-only field shows the initials of the user who last filled the Rx.

 

Priority: Indicates if the Rx has a due time (pick up time). Select an option from the menu to 

specify a priority. Priorities can be configured in the Store-Level Configuration Parameters 

screen. Click F2 to change this field to a Date and Time field to enter a specific due time. Click 

F2 again to change the Date and Time field back to Priority.

 

Due: This read-only field indicates the time remaining before the Rx is due.
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Workflow Detail: This read-only field indicates the Workflow type (i.e., Forward, Reversal, 

Inactivation, Owe, etc.) 

 

Click F2 to access the Rx Workflow Detail for Rx screen. This screen consists of three tabs: 

 Workflow tab: Displays all of the workflow actions that are connected to the 
prescription, along with the status of each action, the date of completion, the initials of 
the user who completed the action, and any comments that were entered. 
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 Packaging tab: Identifies the drug that was filled in the prescription. Information such as 
owed quantities, quantities packaged, tote number, and delivery status are also 
available on this screen.  

 

 Comments tab: Displays comments that pertain to the workflow action or steps. Click 
Ins to insert a new comment.  
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Work Order: Rxs with the same work order number are presented together as one work order 

when completing the pickup process. 

 

Click F2 to view the work order screen. The work order screen will display all Rxs that belong to 

the same work order.

 

Delivery: This menu allows you to select a delivery route. Options include Pickup, Store 

Delivery, and Mail Order Courier.

 

Lookup: This key is used to refresh the F12 screen after information has been entered or 

changed. For example, if the plan has changed on the prescription, you can press Enter or click 

Lookup to refresh your changes.  

 

Cancel: Returns you to the last screen viewed before you accessed the F12 filling screen. 
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Unit Dose  

The Unit Dose section is used to identify Rxs that should be taken at a certain time. Kroll 

supports multiple unit dose packaging types including DisPill, PillPak, Dosettes, and a number of 

generic compliance reports.  

 To enable unit dose on an Rx, go to View > Unit Dose Info or select Unit Dose Info from the 1.
right navigation pane.  

 

 The Rx Information screen will appear. 1.

 Rx Start Date: The start date will be populated with the start date from the F12 Dates 
tab. The start date can be modified from this section but in turn when changed will also 
change the Start Date in the Dates tab. This start date will be the first date the 
medication will be populated on the Unit dose packaging reports.    

 Rx Stop Date: The stop date will be populated with the stop date from the F12 Dates 
Tab (if populated). The stop date can be modified from this section but in turn when 
changed will also change the Stop Date in the Dates tab. This stop date will be the last 
date the medication will be populated on the Unit dose packaging reports (date 
inclusive).     

 Drug: Displays the selected drug. 

 Sig: Displays the Sig that has been entered for the Rx.     
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Dosing tab:  

 Unit Dose: Select to enable unit dosing for the Rx; doing so will make the other fields on 
the tab available. 

 Frequency: Select a dosing frequency from the menu.     

 Card Number: Enter a card number so Rxs can be grouped according to unit dose 
packaging type. The default for all Rxs is 1.    

 Quantity: The available quantity fields depend on the selected frequency. Enter a 
dosage quantity for Breakfast, Lunch, Dinner, and Bedtime.  
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Calendar tab: This is a monthly display of unit dose times and quantity of dose based on the 
selected frequency and quantity.   

 

  



  Kroll Windows 10 User Manual  

 

210 
 

Navigation Pane 

The navigation pane is located on the right side of the F12 filling screen and contains a variety 

of functions that pertain to the Rx.  

 

Make Rx Unfilled: Use this option to mark the Rx as Unfilled (on hold). This option is available 

for new Rxs only and can also be accessed via the Rx menu. 

Make Rx Not Dispensed: Use this option to mark the Rx as Not Dispensed. This is used to mark 

over-the-counter items so they can be logged on the patient profile without passing through 

the different filling stages and generating labels and receipts. This option is available for new 

Rxs only and can also be accessed via the Rx menu. 

Make Rx Stock Transfer: Use this option to mark the Rx as a stock transfer to another 

pharmacy. This option is available for new Rxs only and can also be accessed via the Rx menu. 

Copy to New Rx: Use this option to inactivate the current Rx chain and begin a new Rx using the 

same information. This option is available for refill Rxs only and can also be accessed via the Rx 

menu. 

Add Rx Image: Selecting this option displays the Rx Image screen where you can import a script 

image or select an existing image to add to the Rx. This option can also be accessed via the Rx 

menu. 
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Transfer Rx from Other Store: If the prescription is being transferred from another pharmacy, 

select this option to input information regarding the pharmacy that is transferring the 

prescription. This option is available for new modify Rxs only and can also be accessed via the 

Rx menu. 
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Transfer Rx to Another Store: If the prescription is being transferred to another pharmacy, 

select this option to input information regarding the pharmacy that receiving the transferring 

the prescription. This option is available for modify Rxs only and can also be accessed via the Rx 

menu. 

 

Charge to AR: This option will only be available if the Accounts Receivable module is turned on 

and the patient in the Rx has an AR account. Selecting this option will add charge the remaining 

cash amount to the patient’s AR account. This option is available for all Rx types and can also be 

accessed via the Rx menu. 

Call Doctor: Select this option to create a callback record to remind pharmacy users to contact 

the prescriber regarding the Rx (for Sig confirmation, refill requests, etc.) Once selected, a ‘Call 

Doctor is Enabled’ message will appear in the Warnings section on the F12 screen. This option is 

available for all Rx types and can also be accessed via the Rx menu. 
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Counsel Patient on Pickup: Select this option to arrange for patient counseling at pickup. A 

form will appear where you can select a reason for conducting the counseling session. This 

option is available for all Rx types and can also be accessed via the Rx menu. 

 
Inactivate Rx: Select this option to discontinue an Rx. These options are only available for refill 

and modify Rxs and can also be accessed via the Rx menu. 

Owe Quantity: Select this option to display the Edit Rx Owe screen where you can select a drug 

quantity to owe the patient for a return pickup. An owing amount will print on the label. This 

option is available for all Rx types and can also be accessed via the Rx menu. 

 

Cancel Rx: Select this option to reverse an Rx. This option is available for modify Rxs only. 
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Clinical Interactions: Select this option to perform a clinical review of the prescription against 

the rest of the patient medication history derived from the FDB database. This option is 

available for all Rx types. 

 

Mixture Breakdown: Select this option to display the Mixture Breakdown screen. It is 

recommended that you view this screen prior to adjudicating the Rx. This screen provides exact 

dollar amounts for elements that making up the mixture pricing. This option can also be 

accessed via the View menu. 
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Plan Information: Select this option to display the Rx Plan Information screen where you can 

enter plan-specific information. If more than one plan applies to the Rx, tabs will appear across 

the top of the screen, one for each drug plan. This option is available for all Rx types and can 

also be accessed via the View menu. 

 
 

 Intervention Code 1: Click F2 to search and select the applicable code. If you want to 
remove an intervention code, click F2 again and select None.  

 Intervention Code 2: Click F2 to search and select a second applicable code. If you want 
to remove an intervention code, click F2 again and select None.  

 Special Authorization #: A special authority grants full benefit status to a medication 
that would otherwise be a partial benefit or a limited coverage drug. Enter the special 
authorization number in this field for billing.  

 Special Services Code: Select a special services code from the menu. This field is often 
used to bill service fees to Indian Affairs.  

 Reason Code: Click F2 to view available reason codes for the drug in the prescription, if 
applicable. This option is available in Ontario only. 

 Claim Type: Do not change this field as it should be configured according to the 
parameters of the prescription.  

 Real Time Plan: Do not change this flag as it is configured according to the third party 
plans present in the prescription. Incorrect deactivation of this flag could mean having 
to manually bill for a prescription that could have been billed electronically in real time.  

 Pseudo DIN: Displays the pseudo DIN being sent to the third party for the prescription. 
You can also override the field to send a onetime pseudo DIN with the prescription.  
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Refill Information: Select this option to display the refill history for the Rx. This option is 

available for refill and modify Rxs only and can also be accessed via the View menu.  

Patient Plan Information: Select this option to display the Patient Plan Information screen, 

which displays the patient’s third party plan information. If more than one plan applies to the 

Rx, tabs will appear across the top of the screen, one for each drug plan. Adjust the third party 

plan information and re-adjudicate the Rx, if necessary. This option is available for all Rx types 

and can also be accessed via the View menu. 

 

Generic Equivalents: Select this option to view the generic equivalents for the selected drug. At 

the Input stage, you can highlight a generic equivalent and click Select to select an alternate 

drug record for the Rx. This option is available for all Rx types and can also be accessed via the 

View menu. 
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Rx as it was Filled: Select this option to display to display the F12 screen for the first fill of the 

Rx. This option is available for modify Rxs only and can also be accessed via the View menu. 

Unit dose Info: Select this option to view the Unit Dose Rx Information screen for the Rx. This 

option is available for all Rx types and can also be accessed via the View menu.  

See the Unit Dose section on our website for more information.  

Work Order: This field displays the work order number (Rxs filled with the same work order 

number are intended to be picked up together utilizing the pickup application). Click F2 to 

display the work order screen, which displays all Rxs belonging to the same work order. This 

option is available for all Rx types and can also be accessed via the View menu. 

 

Rx Counseling History: Select this option to display the Counseling History screen, which shows 

records of all past counseling sessions associated with the Rx. This option is available for all Rx 

types. 

 

Workflow Detail: See the Workflow Detail section for information about this option. 

 

  

file:///E:/Dropbox/Shared%20Files/Version%2010/F12%20-%20Fill%20Documentation.docx%23_Unit_Dose
file:///E:/Dropbox/Shared%20Files/Version%2010/F12%20-%20Fill%20Documentation.docx%23WorkflowDetail
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Menu Bar 

Rx 

Make Rx Unfilled: Use this option to mark the Rx as Unfilled (on hold). This option is available 

for new Rxs only and can also be accessed via the navigation pane. 

Make Rx Not Dispensed: Use this option to mark the Rx as Not Dispensed. This is used to mark 

over-the-counter items so they can be logged on the patient profile without passing through 

the different filling stages and generating labels and receipts. This option is available for new 

Rxs only and can also be accessed via the navigation pane. 

Make Rx Stock Transfer: Use this option to mark the Rx as a stock transfer to another 

pharmacy. This option is available for new Rxs only and can also be accessed via the navigation 

pane. 

Copy to New Rx: Use this option to inactivate the current Rx chain and begin a new Rx using the 

same information. This option is available for refill Rxs only and can also be accessed via the 

navigation pane. 

Inactivate Rx: Select this option to discontinue an Rx. This option is available for refill and 

modify Rxs only and can also be accessed via the navigation pane. 
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Transfer Rx from Other Store: If the prescription is being transferred from another pharmacy, 

select this option to input information regarding the pharmacy that is transferring the 

prescription. This option is available for new modify Rxs only and can also be accessed via the 

navigation pane. 
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Transfer Rx to Another Store: If the prescription is being transferred to another pharmacy, 

select this option to input information regarding the pharmacy that receiving the transferring 

the prescription. This option is available for modify Rxs only and can also be accessed via the 

navigation pane. 

 

Back Date Rx: Select this option to change the fill date of an Rx before it is processed. This 

option is only available for new and refill Rxs. 

 

Add Rx Image: Selecting this option displays the Rx Image screen where you can import a script 

image or select an existing image to add to the Rx. This option can also be accessed via the 

navigation pane. 
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Modify Next Fill Parameters: Select this option to display the Modify Next Fill Parameters 

form. The next time the Rx is called up in fill mode, the changes entered in this form will be 

applied. This option is available for modify Rxs only. 

 

Call Doctor: Select this option to create a callback record to remind pharmacy users to contact 

the prescriber regarding the Rx (for Sig confirmation, refill requests, etc.) Once selected, a ‘Call 

Doctor is Enabled’ message will appear in the Warnings section on the F12 screen. This option is 

available for all Rx types and can also be accessed via the navigation pane. 

Counsel Patient on Pickup: Select this option to arrange for patient counseling at pickup. A 

form will appear where you can select a reason for conducting the counseling session. This 

option is available for all Rx types and can also be accessed via the navigation pane. 

Charge to AR: This option will only be available if the Accounts Receivable module is turned on 

and the patient in the Rx has an AR account. Selecting this option will add charge the remaining 

cash amount to the patient’s AR account. This option is available for all Rx types and can also be 

accessed via the navigation pane. 
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Change Rx Pack Size Qty: Select this option to display the Change Rx Pack Sizes form where 

you can change or divide the Rx quantity among pack sizes. This option is available for all Rx 

types, but only if more than one active pack size is available. 

 

Owe Quantity: Select this option to display the Edit Rx Owe form where you can select a drug 

quantity to owe the patient for a return pickup. An owing label will be printed on the label 

when this owe amount is populated. This option is available for all Rx types and can also be 

accessed via the navigation pane. 

Order Drug: Select this option to display the Place Order form where you can select a vendor 

and the quantity to order. This will place the selected drug in a manual order. This option is 

available for all Rx types. 

 

Part Fill: Select this option when the entire authorized quantity has not been dispensed. A part 

fill label will be generated. This option is available for new Rxs only. 
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Trial Rx: Select this option to bring up the Trial Rx Information screen where you can specify 

the trail amount that will be dispensed for the first fill. This option is available for new Rxs only. 

 

Print Authorization Label Now: Select this option to print an Authorization Label for the 

pharmacist to call the doctor and record information regarding the Rx on a hardcopy label for 

easy attachment to the original hardcopy/approve phone refill. This option is available for 

modify and refill Rxs only. 

 

Print Kroll Care Now: Select this option to print the drug information monograph. The content 

of Kroll Care is provided by the First Data Bank (FDB) clinical drug module. This option is 

available for all Rx types. 

Print Compliance Calendar: Select this option to print a compliance calendar on the label set. A 

custom printer beginning with the start date will print with as many consecutive days as is 

populated in the days supply field. On the label, the pharmacist can circle the days the patient 
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needs to take the dose or write in the quantity of pills to take on each date. This is typically 

used for complicated Rxs or tapering doses. This option is available for all Rx types. 

 

Print delivery label (Send To): Select this option to print a delivery label if your system is not 

configured to do so for every label. This option is available for all Rx types. 

 

Print Wallet Card (Profile): Select this option to print a wallet card or patient profile if one is 

not configured to print on every label set. This option is available for all Rx types. 
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Interventions/SA Numbers: Select this option to display the Rx Plan Information screen where 

you can enter plan-specific information. If more than one plan applies to the Rx, tabs will 

appear across the top of the screen, one for each drug plan. This option is available for all Rx 

types and can also be accessed via the View menu. 

  

 Intervention Code 1: Click F2 to search and select the applicable code. If you want to 
remove an intervention code, click F2 again and select None.  

 Intervention Code 2: Click F2 to search and select a second applicable code. If you want 
to remove an intervention code, click F2 again and select None.  

 Special Authorization #: A special authority grants full benefit status to a medication 
that would otherwise be a partial benefit or a limited coverage drug. Enter the special 
authorization number in this field for billing.  

 Special Services Code: Select a special services code from the menu. This field is often 
used to bill service fees to Indian Affairs.  

 Reason Code: Click F2 to view available reason codes for the drug in the prescription, if 
applicable. This option is available in Ontario only. 

 Claim Type: Do not change this field as it should be configured according to the 
parameters of the prescription.  

 Real Time Plan: Do not change this flag as it is configured according to the third party 
plans present in the prescription. Incorrect deactivation of this flag could mean having 
to manually bill for a prescription that could have been billed electronically in real time.  

 Pseudo DIN: Displays the pseudo DIN being sent to the third party for the prescription. 
You can also override the field to send a onetime pseudo DIN with the prescription.  
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Make this doctor that family doctor for this patient: Select this option to make the selected 

doctor the family doctor for the patient. This option is available for all Rx types. 

Elston (Ontario Only): Select this option to enable Elston Pricing for the Rx. This will charge the 

full purchase cost with no markup and is available for all Rx types. 

Allow more than 2 ODB fees per month (Ontario Only): Select this option to send a fee for all 

Rxs after the second fill for fee exception drugs. This option is available for all Rx types. 

View 

Suspensions: Select this option to display the Suspensions for Rx screen where you can view 

past suspensions that apply to the Rx or insert a new suspension. This option is available for 

modify and refill Rxs only. 

 

Mixture Breakdown: Select this option to display the Mixture Breakdown screen. It is 

recommended that you view this screen prior to adjudicating the Rx. This screen provides exact 

dollar amounts for elements that making up the mixture pricing. This option can also be 

accessed via the navigation pane. 

Work Order: This field displays the work order number (Rxs filled with the same workorder 

number are intended to be picked up together utilizing the pickup application). Click F2 to 

display the work order screen, which displays all Rxs belonging to the same work order. This 

option is available for all Rx types and can also be accessed via navigation pane. 

Workflow Detail: This read-only field indicates the Workflow type (i.e., Forward, Reversal, 

Inactivation, Owe, etc.)  

Drug Interactions: This option is the same as the Clinical Interactions option on the navigation 

pane. Select this option to perform a clinical review of the prescription against the rest of the 
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patient medication history derived from the FDB database. This option is available for all Rx 

types. This is available for all Rx types. 

Generic Equivalents: Select this option to view the generic equivalents for the selected drug. At 

the Input stage, you can highlight a generic equivalent and click Select to select an alternate 

drug record for the Rx. This option is available for all Rx types and can also be accessed via the 

navigation pane. 

Unit Dose Info: Select this option to view the Unit Dose Rx Information screen for the Rx. This 

option is available for all Rx types and can also be accessed via the navigation pane. See the 

Unit Dose section for more information.  

Adjudication Results: Select this option to display the Adjudication Results screen where you 

can view how the Rx was last adjudicated. This option is available for modify Rxs only. 

 

Plan Information: Select this option to view the Rx Plan Information screen, which displays 

information about the plans being applied to the Rx. If more than one plan applies to the Rx, 

tabs will appear across the top of the screen, one for each drug plan. This option is available for 

all Rx types. 

Patient Plan Information: Select this option to display the Patient Plan Information screen, 

which displays the patient’s third party plan information. If more than one plan applies to the 

Rx, tabs will appear across the top of the screen, one for each drug plan. Adjust the third party 

file:///E:/Dropbox/Shared%20Files/Version%2010/F12%20-%20Fill%20Documentation.docx%23_Unit_Dose
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plan information and re-adjudicate the Rx, if necessary. This option is available for all Rx types 

and can also be accessed via the navigation pane. 

Refill Information: Select this option to display the Rx Detail screen where you can view refill 

history for the Rx. These options are only available for refill and modify Rxs and can also be 

accessed via the navigation pane. 

 

Rx as it was Filled: Select this option to display to display the F12 screen for the first fill of the 

Rx. This option is available for modify Rxs only and can also be accessed via the navigation 

pane. 

Refill/Modification History: Select this option to display the History of original Rx Number 

screen where you can view all changes made to the Rx since its original fill. This option is  only 

available for refill and modify Rxs. 

 

Comments from previous fill/cancel: Select this option to display the Comments from previous 

fill/cancel screen where you can view the last Rx fill/cancel comment. This option is available 

for refill Rxs only. 
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Labels 

The options available in the Labels menu pertain to the Rx label that is generated when filling 

the Rx. 

Generic: Select this option to override the first drug name. 

Second Drug Name: Select this option to override the current second drug name. Available 

options are Brand, Generic, description, description 2, equivalent To, and None.  

Half Size Sig: When enabled, the Sig will print at half the size it normally prints. This is useful for 

drug products with long Sig instructions. 

Preview Label Printing Action: Select this option to preview the label set or Kroll Care. 

Message: Select a message to be printed on the label. Rx messages can be configured in 

Utilities > Labels > User Labels. 

Profile Lines to Skip: Select this option to choose how many lines from the top to not display on 

the wallet card.  

Profile 

There are seven patient profile views available in the Kroll Pharmacy Software. The Profile 

menu allows you to view each of these profiles from the F12 filling screen. Different views allow 

you to filter and display prescription information that is relevant to your needs at that time.  

All Rxs: Displays all prescriptions filled for the patient regardless of when the Rx was filled or 

the Rx status. This view is useful for viewing prescriptions that have been inactivated or 

transferred out. 

Active Rxs: Displays prescriptions that have ‘Active’ prescription status. Prescriptions that are 

unfilled, not dispensed, transferred-in, or that have a <blank> status are considered active and 

will be displayed in this view. This is useful for filtering out prescriptions that have been 

inactivated or transferred-out.   

Pricing Profile: Displays all prescriptions filled for the patient with columns displaying cost, 

markup, fee, and the Rx total. The values represent amounts pulled from the last filled Rx in the 

prescription chain. This view is useful for determining prescription pricing and resolving pricing 

discrepancies. 



  Kroll Windows 10 User Manual  

 

230 
 

Not Disp/OTC Profile: Displays prescriptions that have been marked with a status of ‘Not 

Dispensed’. Over-the-counter (OTC) products are added to the patient profile by marking them 

as ‘Not Dispensed’ to allow drug interaction checking to occur without generating official 

prescription receipts. 

Rxs Filled in Error: Displays prescriptions filled in error for the patient. Entries in this profile are 

excluded from drug interactions checking and should not influence dispensing decisions.   

Therapeutic Equivalents: Display any therapeutic equivalents the patient may have had in the 

past for the Rx currently on the F12 filling screen.   

Reports 

Fax Doctor: Generates a refill request report for prescription that is currently displayed on the 

F12 filling screen. 

Limited Use Request: This option is available only in Ontario. For certain medications, ODB will 

only reimburse prescriptions for a medication if it complies with a medical reason for use as 

defined by ODB. The Limited Use Request form generates a request report to the prescriber for 

a limited use code for the Rx currently displayed on the F12 filling screen. 

Rx Workflow Detail Report: Generates report for all the information found in the Rx workflow 

detail screen (at time of print) for the prescription currently displayed on the F12 filling screen. 

Section 8 Request: This option is available only in Ontario. This is a request sent to a prescriber 

for special coverage of a product that is not normally covered under the ODB formulary. The 

prescriber, on behalf of the patient, can request coverage for a particular drug product not 

normally covered under ODB for a specific period of time. The Section 8 Request form 

generates a request report to the prescriber for a Section 8 for the Rx currently displayed on 

the F12 filling screen. 

Pharmacist Prescription Adaptation: To adopt a prescription, you can copy it from an existing 

prescription using the pharmacist as the doctor and a new prescription number, or fill it as a 

new prescription. When making changes to a prescription that has not been previously filled, 

the Rx would be entered as new with the adaptation mode on the first fill using the pharmacist 

as the doctor. This report is what is sent to the original prescribing doctor.   

Drug Benefit Claim/Reversal Report: This option is available only in Ontario. Selecting this 

option will generate a ODB reversal claim.   

All: Select this option to display all Kroll reports (not just F12 specific reports). 
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Search: Select this option to call up a search window where you can search for the name of a 

specific report.  

Bottom Tool Bar  

The bottom tool bar provides additional information about the Rx being processed. Use the left 

and right arrow keys to navigate through the tabs. 
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Plans  

Rx Plans: You can select to exclude third party plans from the prescription, or change the order 

of billing from this tab (remove). The first plan listed is where the Rx is being billed to first; the 

second plan is where the Rx is billed to second, etc. 

 

Plan Pays: Displays how much each plan has paid for the Rx displayed on the F12 filling screen. 

Extra Info: Display intervention codes or any other options populated in the plan info screen for 

each plan for the Rx displayed on the F12 filling screen. 

Next Dispense Qty: You can enter a new dispense quantity for the next refill. This is especially 

useful for trial prescriptions where the first order has a lower dispensing quantity than the next. 

Min Interval: Used for narcotic prescriptions to prevent refilling until a specified number of 

days have elapsed. 

Enable Auto Refill: Select this option to enable auto-refill on Rxs so when the days supply of the 

Rx has elapsed, the Rx will be displayed in the To Do queue for processing.   

Rx Comment: Selecting this option displays the number of comments that have been added to 

the Rx. Select this button to display the comments tab.   

Comment field: Used for entering prescription comments. Enter any free form comment. It will 

be saved with the prescription record. Rx comments appear in this section for those Rxs which 

have the Show on Rx option enabled. 
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Pricing  

The pricing tab displays information regarding the pricing strategy used to calculate the Rx. 

pricing strategies are set in Edit > Plans/Pricing.   

 

Strategy: A read-only name of the pricing strategy being used in the Rx and that is set up in edit 

plans/pricing. Hovering the mouse over the strategy will display the drug price group and 

patient price group being used.  

Unit Dose Strategy: A read-only name of the unit dose pricing strategy being used in the Rx and 

that is set up in Edit > Plans/Pricing. 

Acq Cost: The acquisition cost field displays read-only calculation based on the purchase price 

of the drug card.  

G.P. %: The Gross Profit percentage field displays read-only information that will based on the 

following calculation: (Rx Total $$$ - ACC)/RX total $$$ 

Unit Drug Cost: Displdays read-only information that will identify the cost per pill based on the 

following calculation: Drug pack size/Purchase Cost of the drug card. 

Manual Price: If a pricing needs to be overridden, users can place a checkmark next to the 

Manual Price flag which will open up the Cost, Markup, Fee, Mix Fee and SSC fields for manual 

manipulation. Manual pricing should only be used in emergency situations; incorrectly priced 

prescriptions should be reported to the Kroll Support Helpdesk so the root cause of the pricing 

issue is resolved at the root. 

Pricing Row: Displays the individual pricing breakdown for the Rx.   

Cost: Displays the read-only dollar amount calculated by the system as set up in the pricing 

strategies specific to cost.  
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Markup: Displays read-only dollar amount calculated by the system as set up in the pricing 

strategies specific to markup. 

Fee: Displays read-only dollar amount calculated by the system as set up in the pricing 

strategies specific to fee. 

Mix Fee: Displays read-only dollar amount calculated by the system as set up in the pricing 

strategies and/or the mixture card specific to fee. 

Total: Displays read-only dollar amount calculated by the system as set up in the pricing 

strategies specific to the sum of all the fields. 

Discounts: Displays the discounts that have been applied to each price field for waiving cost 

differences during adjudication.   

Net Amounts: Displays the net amount (original pricing – discount) that has been applied to 

each price field.   

Dates 

 

Rx Start Date: This field will automatically be populated with the date the Rx was processed. 

You can change this for New Rxs to populate the date the patient will start taking the 

medication.  

Rx Stop Date: Enter a stop date for the prescription, if applicable. You will not be able to fill the 

prescription past the stop date unless the stop date is removed.  

Written Date: This field will be automatically populated with the date the Rx was processed, 

but can be overridden to whatever date the prescription was actually written.  
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Rx Expiry Date: This field will be auto-populated depending on the drug schedule, the province 

the Rx was processed in, and the written date.  

Drug Expiry Date: Enter a drug expiry date for the prescription, if applicable. If a date is entered 

here, it will be printed on the vial label so that the patient can also see the drug expiry. This 

option is especially useful for liquid antibiotics.  

Ingest Date: Used to record the ingest date for methadone prescriptions.  

Copy Information: Displays read-only information on the original therapeutic start date, as well 

as the Rx number for where the Rx was copied from or the Rx number for where the Rx was 

copied to.  

Transfer Dates: Displays read-only information on where a prescription was transferred to or 

where it was transferred from. 

Comments 

Comments can be added under the Plans tab; however, inserting an entry from the Comments 

tab allows you to activate certain configurations for the comment as well as allowing you to 

enter more than one comment entry to the prescription record.  

 

Click Ins or press the Insert key on your keyboard to add a new comment, F2 to edit an existing 

comment, and click Del or press the Delete key on your keyboard to delete an existing 

comment.  
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Click Ins to call up the Rx Comment form: 

 

Topic: Select a topic for the comment by clicking on the down arrow or pressing the down 

arrow on the keyboard to view the list of choices. A free-form comment can also be populated 

as well. A topic must be selected in order to save the comment.  

Show on Rx: Enabling this option will display the comment on the F12-Filling screen in the 

white section on the Plans tab (bottom left of the F12 filling screen). 

Alert: Enabling this flag will cause the comment to pop up every time the Rx is accessed. The 

comment will also be displayed with red font in the comment section.  

Print on Hardcopy: When enabled, the comment will print on the hardcopy under the Rx 

comment. Only one Rx comment will print per Rx.    

Keep Comment for Refills: When enabled, the comment will also be saved for any refills against 

the prescription. 

Keep Comment for Copied Rxs: When enabled, the comment will be copied to a new 

prescription record if the original is copied.   

Workflow Alerts Edit: When enabled, the ‘Edit’ option to the right of workflow alerts is 

displayed. Place a check mark on the workflow in which you want this comment to appear.  

NOTE: If you select more than one workflow to display this comment, it will only be 
displayed at the first workflow unless you escape out of the Rx and get back to the Rx for the 
next workflow screen of that Rx. 
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Indications 

The Indications tab allows you to identify what condition(s) the prescription is treating. Click Ins 

or press the Insert key on your keyboard to add a new indication, F2 to edit an existing 

indication, and click Del or press the Delete key on your keyboard to delete an existing 

indication.  

 

Clicking Ins calls up a list of ICD-10-CA and/or FDB conditions. Search for the applicable 

condition, highlight the record, and click Select.  
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Images 

The Images tab allows you to import a script image or indicate a reason for not including a 

script image.  

 

No Script Image Reason: If a work order does not have a written Rx that accompanies it, enter 

a reason for the script image not being present.  

+:  Allows you to add an Rx image. This option is also available via the navigation pane and in 

the Rx menu. Click this button to display the Rx Images screen where you can import a script 

image file or select an existing image: 
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Other 

 

Doctor Authorization Received: This option should always be checked as it indicates that 

prescriber authorization has been received to dispense the prescription. 

Include in Narcotic report: Check this option to include the Rx in the narcotic report even if it is 

not a narcotic prescription. 

Transaction Comment: Displays any comments specific to the transaction. This can be a user 

comment, system comment, or a comment transferred from the To Do comment section.  This 

comment will not be transferred to refills or copied Rxs. 

Rx Warnings and Counselling: The Warnings and Counselling tabs are found to the left of the 

navigation pane at the bottom of the screen. The Warnings tab displays messages that inform 

you of important information or problems that pertain to the Rx. The Counseling tab shows the 

information that will be printed on the Kroll Care leaflet. 
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Warnings tab 

 

 Error Messages: Indicate there is a problem with the Rx. You will be prevented from 

moving the Rx to the next filling stage when error messages are present.  

 Warning Messages: Indicate that there may be a potential issue with the Rx. Addressing 

these warnings may prevent an input error. Rxs can be finalized while these messages are 

present. 

 Information Messages: Indicate a general purpose message. Rxs can be finalized while these 

messages are present. 

Counselling tab 

 

The Counseling tab displays patient messages extracted from the First Data Bank (FDB) clinical 

drug module. Counseling messages are broken down into Patient Messages and Professional 

Messages – Kroll Care. 
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Filling a Prescription 

This section explains the procedure for filling a prescription from the F12 screen. 

Patient Details 

 Enter one the following search criteria in the Patient Search field and press Enter: 1.

 Last Name, First Name (e.g. “Doe, Jane” OR “doe,j” OR “Doe” OR “,Jane”)  

 A period (.) and the Patient Quick Code (e.g. “.DoeJ”)  

 7 or 10 digit phone number (e.g. 800-263-5876 or 263-5876)  

 A number sign (#) and the +Third Party Billing number (e.g. #123456789)  

 An asterisk (*) to search ALL patients in the database  
 

 

 A list of patients matching the search criteria will be displayed. Select the applicable patient 2.
record by:  

 Highlighting the patient record and pressing the Enter key on your keyboard or clicking 
F12 - Return to Rx. 

 Typing in the line number corresponding to the applicable entry and pressing Enter to 
select.  

 Double clicking the patient record. 
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 The F3 - Patient screen will be displayed. Click Rx or press the Enter key on your keyboard. 3.

 

The F12 screen will display with the selected patient’s information populated in the patient 
fields. 
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Drug/Mixture Details 

 Enter one the following search criteria in the Drug Search field and press Enter: 1.

 Brand/Generic Name, Strength/Pack Size (e.g. Apo-Metformin, 500/360)  

 DIN (5-8 digits)  

 UPC (11-12 digits)  

 A period (.) and the Drug Quick Code (e.g. TYLE3)  

 # symbol and the Catalog Item Number (e.g. #78945)  

 

 A list of drugs/mixtures matching the search criteria will be displayed. Select the applicable 2.
drug/mixture record by:  

a) Highlighting the entry and pressing Enter on the keyboard or clicking F12 - Return to 
Rx.  

b) Typing in the line number corresponding to the applicable entry and pressing Enter 
to select.  

c) Double clicking the drug/mixture record. 
 

 

  



  Kroll Windows 10 User Manual  

 

244 
 

 The F5 - Drug screen will be displayed. Click Rx or press the Enter key on your keyboard. 3.

 

The F12 screen will display with the selected drug/mixture information populated in the 
drug fields. 
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Prescriber Details 

 Enter one the following search criteria in the Doc Search field and press Enter: 1.

 Last Name, First Name (e.g. “house, greg” OR “hou, g” OR “house” OR “,greg”)  

 A period (.) and the Doctor Quick Code (e.g. “.house”)  

 7 or 10 digit phone number of the prescriber office.  

 A number sign (#) and the prescriber license number (e.g. #123454)  

 An asterisk (*) to search for ALL prescribers in the database.  

 

 A list of prescribers matching the search criteria will be displayed. Select the applicable 2.
prescriber record by:  

 Highlighting the entry and pressing Enter on the keyboard or clicking F12 - Return to Rx.  

 Typing in the line number corresponding to the applicable entry and pressing Enter to 
select.  

 Double clicking the prescriber record. 
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 The F7 - Doctor screen will be displayed. Click Rx or press the Enter key on your keyboard. 3.

 

The F12 screen will display with the selected prescriber information populated in the 
prescriber fields. 

 

Sig Details 

Enter the Sig for the appropriate administration instructions in the Sig field. A read-only 

expansion will appear below the field. Sig codes and expansions can be edited in Edit > Sig 

Codes. 

Enter the Sig in the SIG field and the expansion will appear in read only format in the grey box 
below. Sig tokens and Sig expansions can be edited in Edit/Sig Codes.  

Route of Admin: Select a route of administration for the drug product (e.g., oral, topical, 

intravenous, etc.) 
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Dosage Form: Select the form of the drug product (e.g., capsule, tablet, injection, etc.) 

 

Dispense Details 

Init: Enter your user initials. Your system may be configured to auto-populate the initials of the 

currently logged in user. 

Dispense Qty: Enter the dispense quantity for the prescription. Entering a dispense quanitty 

followed by a ‘P’ will multiply the dispense quantity by the pack size.  

Refills (+): Click to add refills to the Rx. The Specify number of repeats for a new Rx form will 

appear where you can enter the number of repeats and/or authorized quantity. Place a 

checkmark next to Unlimited Refills  and enter an Until date if the prescription has unlimited 

refills until a specific date.  

 

Days: Enter the day’s supply for the dispense quantity indicated. 

Product Sel: Indicates a reason why the drug cannot be substituted. Options include 

Prescriber’s Choice, Patient’s Choice, Pharmacist’s Choice, and Existing Therapy. If you select 

None, no drug substitution restrictions will be applied. 

O/W: Indicates how the Rx has been received into the pharmacy. Options include Written, 

Oral, and Faxed. 
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Labels: Specify the number of vial labels to be printed. If two or more labels are selected, you 

can spit the labels using the F2 option. This will display the label split form. If you select Split 

Quantity on Labels, the quantity will be divided by the number of labels. 

 

Auth Qty: This field will auto-populate if the Disp Qty  and Refills fields are filled out. If this field 

is blank, enter the total authorized quantity for the prescription.   

Rem Qty: This field is auto-populated with read-only information pertaining to the number of 

pills not dispensed, based on the authorized quantity. The field to the right indicates the 

remaining refills based on the dispensed quantity that is currently populated. 

G.P.%: The Gross Profit percentage field displays read-only information that is based on the 

following calculation: (Rx Total $$$ - ACC)/RX total $$$  

Acq Cost: The acquisition cost field displays a read-only calculation based on the purchase price 

on the drug card.  

Cost: Displays the read-only dollar amount calculated by the system as set up in the pricing 

strategies specific to cost  

Markup: Displays a read-only dollar amount calculated by the system as set up in the pricing 

strategies specific to markup. 

Fee: Displays a read-only dollar amount calculated by the system as set up in the pricing 

strategies specific to fee. 
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Total: The total field displays read-only dollar amount calculated by the system as set up in the 

pricing strategies specific to the sum of all the fields. 

 

Processing the Rx 

Once the Rx fields are populated, click F12 - Fill Rx. This must be completed whether you are 

logging an Unfill, a Stock Transfer, a Not Dispensed, filling a new Rx, or saving changes on a 

modify. This must be done so an Rx number can be assigned to the prescription. (A Tx number 

will not be created when modifying an Rx.) 

After selecting F12 - Fill Rx, the Rx will progress through the workflow actions available for your 

selected workflow type. The default workflow actions are described below. Note that workflow 

orders or actions can only be changed by contacting Kroll Support.     

Prompt for AR  

In order for the AR prompt to be displayed the store must have all of the following in place: 

 The AR module must be enabled. 

 The patient must have an AR account. 

 The Charge Rxs field in File > Configuration > Store > AR is set to Prompt. 

 

If you select Yes, the cash remainder will be charged to the patient’s AR profile. If you select 

No, nothing will be charged to the patient’s AR profile. If all three criteria of the above criteria 

are not met this workflow action will be skipped.   
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Prompt for Refill Reminder or Auto- Refill  

If nothing is populated in the patient communication tab, the following prompt will be 
displayed. Note that this is dependent on the configuration settings in File > Configuration > 
Store > Interfaces > Outbound Communication. 

 

If you select Yes, you will be prompted to select a Refill Type. 

 

If the Message Type is set to Rx Ready for Pickup in F3 - Patient > Communications > 

Communication Methods, the following prompt will appear: 

 

If the Message Type is set to Refill Reminder in F3 - Patient > Communications > 

Communication Methods, the following prompt will appear: 
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Prompt for Pickup Notification 

If the Message Type is set to Rx Ready for Pickup in F3 - Patient > Communications > 

Communication Methods and the Pickup field is set to Ask for each Rx, the following prompt 

will appear: 

 

Prompt for Medication Reviews  

Depending on your province and store configuration settings, you may be prompted to perform 
a medication review if the patient is eligible. If your system is configured for paper medication 
reviews, the following prompt will appear: 
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If your system is configured for electronic medication reviews, the following prompt will 
appear: 

 

Preform Local DUE 

You can review First Data Bank (FDB) clinical interactions analysis for a patient’s patient profile 

when filling an Rx. This occurs within the Perform Local DUE workflow action. The analysis will 

be based on information in the patient profile and the drug selected in the F12 filling screen. 

Results of the analysis will be displayed in the Clinical Reports window under separate tabs 

across the top of the window. The displayed tabs depend on the settings in File > Configuration 

> Store > FDB. Click Next to proceed through the tabs.  
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There is also an option to print the clinical report by selecting File > Print, as well as an option 

to counsel the patient at pickup from the Rx menu. 
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A  Proceed button will be displayed if an interaction needs to be viewed. You can not bypass a 

required tab by selecting enter on the tab. You must click the Proceed button or press Ctrl + P 

to proceed.  

 

A Finish button will appear on the last tab. Click to close the Clinical Reports screen. 
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Depending on you store configuration settings, you may be required to manage interactions. A 

Clinical Issue Summary screen will be displayed after selecting finish on the Clinical Reports 

screen.  

 

Allocate Inventory 

Allocating Inventory is the process of dedicating the Rxs dispensing quantity amount for the on-

hand quantity for the selected drug. This action happens in the background; no prompts will be 

displayed. This will determine if an owing prompt needs to be displayed if not enough inventory 

is available.   

Adjudication to Real Time Insurance 

Once the prescription has been locally approved, the next step is to complete adjudication and 

bill the online insurance plan(s). Each Rx will adjudicate to the plan(s) listed within the plans tab 

in the order they appear in the Rx.  

In the example below, there are five plans listed. This Rx will first bill ODB (Ontario Drug 

Benefit), next to AHE 2 (Assure Health), next to ESI (Express Scripts), next to AHE 4 (Assure 

Health), and the remainder will be billed to cash which is the final amount the patient pays. 

  

NOTE: If the Patient has more than one of the same plan, the plan code will be displayed 
followed by the plan order in parenthesis.   



  Kroll Windows 10 User Manual  

 

256 
 

Adjudication Response Screen 

The Adjudication Response screen will be displayed when billing electronic online plans at the 

Complete Adjudication stage. The following screen will be displayed for each plan the Rx is 

being billed to until the total cost has been fully paid. 

 

 Submitted: This row displays the pricing break down of what is billed to the plan. 

 Accepted: This row displays the pricing break down of what is accepted from the 
plan. 

 Difference: This row displays the difference between what was submitted and what 
was accepted from the plan for each cost field. 

 Rx Total: This field displays the entire Rx Total calculated in Kroll. 

 Prev Paid: This field displays the sum of payments towards this Rx that has been 
billed before this plan. 

 Plan Pays: This field displays to the user the total amount that this specific plan has 
paid. 

 Balance: This field displays to the user the remaining unpaid amount. 
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If you select Trouble, the Rx will be placed in the Trouble queue for a specified amount of time. 
This will move the Rx out of the queue priority so that other Rxs can be processed. An Escalate 
Rx to Trouble window will display where you can enter a reason for sending the Rx to the 
Trouble queue. Enter a date and time in the Keep Rx in Trouble Until fields. 

 

To access the Trouble queue, call up the F9 - Workflow screen and select Trouble from the right 

navigation pane. 

 

If you select Cancel Rx, the Rx will be reversed. 
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Rejection Messages  

If a plan rejects a claim, the Adjudication Response screen will display a rejection code and a 

reason why the claim was rejected.  

 

If you select Interventions, a list of available intervention codes to potentially override the 
rejection will be displayed. Select an intervention code, or select Enter custom Free Form code 
to enter your own.  

 

If you select Back to the Rx, the Adjudication Response screen will close and you will be 

directed back to the F12 screen to make changes to the Rx, if necessary. Once changes are 

made, click F12 to retry adjudication. 
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If you select Bill Manually, the remainder of the cost will be manually billed to the plan instead 
of billed online. In this case, the pharmacy is required to submit a claims invoice to the 
insurance company in order to receive payment.  
 
If you select Trouble, the Rx will be placed in the Trouble queue for a specified amount of time. 
This will move the Rx out of the queue priority so that other Rxs can be processed. An Escalate 
Rx to Trouble window will display where you can enter a reason for sending the Rx to the 
Trouble queue. Enter a date and time in the Keep Rx in Trouble Until fields. 

 

To access the Trouble queue, call up the F9 - Workflow screen and select Trouble from the right 

navigation pane. 

 

If you select Cancel Rx, the Rx will be reversed. 
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Cost Differences  

If there are any cost differences between what was submitted to the insurance company and 

what was accepted from the plan, the Adjudication Response screen will require you to enter a 

response for each pricing field that contains a cost difference. If this is not the last Rx plan 

before cash, you will be asked if you want to charge the cost difference to the next third party. 

 

 

If you select No, the system will waive the cost difference on the Rx. 

If you select Yes, you will be able to change the cost difference amount.  

If you click OK, the system will ask the same question for the remaining cost difference 
field(s), if there are any and will send the difference to the remaining online plan or charge 
the patient. 

Completing the Prescription 

After the above steps are completed successfully the Rx has been billed and processed 

successfully and a label will be printed. 
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Cycle Counts    

Drug on-hand quantities can be managed through a cycle count process using the cycle count 

feature. The implementation of a cycle count process provides more accurate inventory and 

more efficient tracking of incoming and outgoing product. With the cycle count process you 

have the ability to count ‘sections’ of inventory for example specific schedules, manufacturers, 

drug types and therapeutic class. 

The cycle count process is a convenient way for inventory values to be verified during quiet 

periods and is not necessarily intended solely for yearend inventory counts. 

NOTE: Only pharmacists and pharmacy managers have permission to adjust inventory 
counts. 

 From the Alt-X Start screen, go to Utilities > Drug > Drug Inventory Counts. 1.

 The Cycle Counts screen will appear. Click Create New. 2.

 

 Select from the Create Cycle Count prompt. 3.
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Pre-select Drugs to Count 

 If you select Pre-select drugs to count, the Generate Drug Count List form will appear 1.
displaying the options available for the specific types of drugs that can be counted. 
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 Click the F2 button next to each field to select criteria for the pre-selected drugs. Select the 2.
appropriate options under the Available column by clicking the items and selecting Insert. 
The item will appear under the Selected column. 

 

 Repeat step 5 for each field you want to select criteria for. 3.

 Place a checkmark next to Exclude to exclude that category from the cycle count. 

 Use the Drug pack has not been cycle counted in the last [x] days to specify a date 
range. 

 Place a checkmark next to Include only Drug Packs with UPC, if necessary. 

 Use the On Hand Qty checkboxes to specify on on-hand quantity. 

 Select a Drug Pack Status to specify if you want to perform the cycle count for Active, 
Inactive, or Either type of drug.  
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Any fields left blank will default to (All). When you are ready to proceed to the next step, 
click Search. 
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 The Generate Drug Count List screen will appear. At this stage you can rename the drug 4.
count, if desired, and use the Limit results to option to specify the number of results you 
want displayed. Click Start Counting. 

 

 The selected drugs will be placed into a count. Click Count Drugs. 5.
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 The first drug in the count will appear in the Cycle Count Pack form. Enter the Quantity 6.
Counted (the number of pills that are in the stock bottle you just counted). If you counted 
the drug by number of packagers, you can enter this value followed by the letter P (e.g., 3P 
to specify three packagers). Click Add Qty. 
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The Quantity Counted value will appear in the Total Quantity Counted pane. Repeat this 
step for each pack you have counted for that drug. 

 

 Repeat step 9 for each drug you want to count. When you are finished, click Cancel to close 7.
the Cycle Count Pack form. 

 The Cycle Count screen will show a status of ‘Reconciled’ for each drug you just counted 8.
and an updated Count value. If you want to recount a drug, highlight the drug record and 
click Reconcile. The drug will appear in red text and will show a status of Recount Required. 
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Highlight the drug record again and click Count Drugs. Repeat step 9 to recount the drug. 

Once all drug packs have been counted, the cycle count will show a status of Counted. 

 

 If you want to view the counts for a drug, call up the Cycle Count screen, right-click the drug 9.
you want to view counts for, and select Show All Counts. 

 

The All Counts screen will appear, displaying all counts for the selected drug. Click Close to 
close the All Counts screen. 

 

Scan and go - start counting now 

 Enter a Cycle Count Name and click OK. 1.
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 The Cycle Count screen will appear. Click Count Drugs. 2.

 

 The Cycle Count Pack form will appear. Scan the first drug to be counted. If the drug does 3.
not have a UPC, a regular drug search can be performed by clicking the F5 button next to 
the Drug field. The Cycle Count Pack form will populate information that pertains to the 
scanned drug. 
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 Enter the Quantity Counted (the number of pills that are in the stock bottle you just 4.
counted). If you counted the drug by number of packagers, you can enter this value 
followed by the letter P (e.g., 3P to specify three packagers). Click Add Qty. 

 

The Quantity Counted value will appear in the Total Quantity Counted pane. Repeat this 
step for each pack you have counted for that drug. 
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 Repeat step 7 for each drug you want to count. When you are finished, click Cancel to close 5.
the Cycle Count Pack form. 

 The Cycle Count screen will show a status of ‘Reconciled’ for each drug you just counted 6.
and an updated Count value. If you want to recount a drug, highlight the drug record and 
click Reconcile. The drug will appear in red text and will show a status of Recount Required. 

 

Highlight the drug record again and click Count Drugs. Repeat step 9 to recount the drug. 

Once all drug packs have been counted, the cycle count will show a status of Counted. 

 

 If you want to view the counts for a drug, call up the Cycle Count screen, right-click the drug 7.
you want to view counts for, and select Show All Counts. 
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The All Counts screen will appear, displaying all counts for the selected drug. Click Close to 
close the All Counts screen. 

 

Printing the Drug Inventory Count Report 

 Once all drugs have been counted, call up the Cycle Count screen for the selected cycle 1.
count and click Print Report. 

 

 Select the desired printing options from the Drug Inventory Count Report form and click 2.
Print. The report will generate. 
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Drug Orders 

The following section provides information on the requirements and set-up of File Transfer 

Protocol (FTP) vendor ordering and receiving. Detailed instructions are given on how to upload 

drug orders and how to download invoices into your system.  

Creating a Drug Order 

 From the Alt-X Start screen, go to Utilities > Drug Ordering > Generate Order. 1.

 A prompt will appearing asking if you want to generate an Automatic or Manual order. 2.
Select Automatic to generate an order based on the Min/Max or Days Supply values in the 
Drug card; select Manual to generate an order from the wholesaler catalog.  

 

NOTE: A percentage field is available for instances where you want to inflate the quantity of 
drugs being ordered for all items in the order. For example, ‘Increase Min/Max re-order 
levels by 10% (For this order only)’ would cause the order quantity to increase by 10% for all 
items in the order.  

Automatic Orders (Perpetual Inventory) 

Automatic ordering can only be performed when the option Enable Automatic Drug Ordering is 

enabled in File > Configuration > Store > Order.  
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If you select Min/Max from the Base ordering on dropdown menu, automatic ordering will 

occur when the Min/Max values on the Drug card are below minimum.  

 

If you select Days Supply from the Base ordering on dropdown menu, automatic ordering will 

occur when the Days value on the Drug card is below minimum. This value is determined by the 

average sales levels of the drug.  
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If Automatic ordering is selected, the system will check all drugs with automatic ordering 

enabled and generate a suggested order similar to the one below: 

 

NOTE: Drugs that have an On Hand value lower than the Minimum will be placed on order 
given that the drug has automatic ordering enabled. The Minimum value is either entered 
manually by you or calculated based on the days’ supply (i.e., usage).  
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Manual Orders 

If Manual ordering is selected, you can choose specific items from the catalog to be placed on 

order instead of having the system auto-generate a suggested order based on min/max and on-

hand values.  

Method 1: Ordering from the Drug Order Form 

 Click Add Item to access the wholesaler catalog.  1.

 

 The Insert Order Item screen will appear. You can search for items from this screen using 2.
the following criteria: 

 Description 

 Drug Identification Number (DIN) 

 Item Number 

 Pack Size 

 UPC 
 

NOTE: The method used to search for drugs in the wholesaler catalog is differing from the 
method used to search for drugs in Kroll. For example, if you are searching for Altace 10mg, 
typing “Altace, 10” in the description field will yield ‘no items found’.  

 Highlight the drug and click Select to add it to the order.  3.
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 Enter the quantity you want ordered and click OK. 4.

 

Ordering from the Drug Card 

 Bring up the drug you want to order in the Drug card. Access the Ordering tab and click Ins 1.
in the Available Vendor Items section.  

 

 Select the appropriate vendor from the Vendor dropdown menu. 2.

 

 Enter the item number in the Item Number field and click Save. Or, click Select From 3.
Catalog to select the drug from the catalog.  
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a. If you chose Select From Catalog, highlight the drug from the Catalog Items list and 
click Select. 

 

 The item will be added to the Available Vendor Items list on the Drug card. 4.

 

Min/Max Versus Days Supply Ordering 

There are two ways to set re-order points for drug products in the Kroll Pharmacy Software: 

Min/Max Ordering versus Days Supply Ordering. In both scenarios, a drug will be placed on 

order when the On Hand value drops below the Minimum value, given the drug is activated for 

automatic ordering in the system. A Maximum value can be entered optionally, and instructs 

the system to order up-until a certain value when the On Hand drops below the minimum. The 

benefits of Min/Max Ordering versus Days Supply Ordering are explained in the following 

sections.  
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Min/Max Pros and Cons 

When Min/Max Ordering is turned on, the Ordering tab of the drug card will have the Days 

fields greyed out because minimum and maximum values are populated manually by you and 

are independent of drug usage.  

Potential Benefits of Min/Max Ordering 

You can control the exact point at which a drug is reordered by setting the Minimum value. The 

Minimum/Maximum values do not change once they are sent because the values are 

independent of usage. This is particularly useful for drugs that need to be overstocked or 

under-stocked.  

Potential Drawbacks of Min/Max Ordering 

Minimum and Maximum values have to be set manually for each drug record because dosage 

formats and usage will vary from product to product. Minimum and Maximum values do not 

change once they are set, so users must manually adjust min/max values during spikes or dips 

in product usage.  

Days Supply Pros and Cons 

When Days Supply ordering is activated, the Ordering tab of the drug record will have the 

Minimum and Maximum fields greyed out and the Days fields open. The Min/Max fields are 

now calculated values based on the day’s supply. You cannot directly manipulate the Min/Max 

fields and must instead base reorder points on the day’s supply they would like to stock.  

Potential Benefits of Days Supply Ordering 

With Days Supply ordering, reorder points are dynamic values that increase or decrease 

depending on how often the drug is dispensed within the days supply indicated. This is 

particularly useful for cyclical drugs like allergy medications that are dispensed frequently 

during some parts of the year, but less during others.  

Users do not have to manually input min/max values for each drug record because they will be 

calculated based on the days supply that is set globally.  

Potential Drawbacks of Days Supply Ordering 

The Minimum and Maximum fields are not open for manipulation as they are now calculated 

values; this means users have less control over the exact point the drug is placed on order.  
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The Minimum and Maximum values change depending on how frequently the drug is 

dispensed; therefore, this may be a problem for products the pharmacy wishes to overstock or 

under-stock.  

The Best of Both Worlds 

Since there are advantages to using both Min/Max Ordering and Days Supply Ordering, the 

system has created a drug specific configuration that allows some drug records to use Min/Max 

reorder points, while others use Days Supply reorder points.  

NOTE:  Generally, all drugs will default to use Days Supply Ordering, but users can manually 
override this configuration to use Min/Max Ordering for exception drug records.  

To override Days Supply Ordering with Min/Max Ordering: 

 Use the F5 - Drug search screen to call up the applicable drug record.  1.

 Select the Ordering tab.  2.

 Locate the Base Ordering On field and click on the down arrow to select Min/Max. Once 3.
Min/Max is selected, the Days fields will be greyed out and you Minimum and Maximum 
fields will open up for manual manipulation.  
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Sending a Drug Order 

 Click on Place Order from the Drug Order Form to call up the Create Purchase Order 1.
screen. 

 

 A purchase order (PO) number will automatically be assigned to the order if you enabled 2.
Auto Increment PO Numbers in File > Configuration > Store > Order. If this option is not 
enabled, enter a PO number in the PO Number field. Click OK or press Enter to proceed. 

 

If the vendor considers one or more items in your order to be a narcotic, enter the vendor-

specific narcotic code in the Narcotic Code field.  

NOTE: Click View Vendor to view the vendor settings. Details listed on this screen are for 
information purposes only and cannot be edited. 

 Click Create or press Enter on the keyboard to generate the order so that it can be sent 3.
electronically to the Vendor. 
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 Answer Yes when asked ‘Do you want to send the electronic order now?’ 4.

 

NOTE: Answering No will place the order into Pending Orders so that it can be sent at a later 
stage from Utilities > Drug Ordering > Communication with > [Vendor name]. 

 Click Start or press Enter from Drug Ordering > Communication with > [Vendor name]. This 5.
will begin the process of sending the PO to the vendor. 
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 As the purchase order is being sent to the vendor, the Activities portion of the screen will 6.
begin to populate with the status of actions being taken. 

 

 When the order has been transmitted successfully, click Finish or press Enter to close the 7.
communication screen. 
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Resending and Ordering 

You may need to resend an order if it does not transmit properly on the first try. 

 From the Alt-X Start screen, go to Utilities > Drug Ordering > Communicate With > 1.
[Vendor] > Recreate Purchase Order. 

 The communication form for the selected vendor will appear. Select Show Sent Orders. 2.

 Place a checkmark next to the order that needs to be re-sent. 3.

 Click Create Order or press Enter on the keyboard.  4.

 

If an existing order is still waiting to be sent a prompt will occur asking to append to that 

current order or to Overwrite the existing order, answer accordingly. 
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You is then prompted to confirm re-sending the order. Click Yes or Press Y on the keyboard. 

 

A final confirmation screen will appear with the new order file details. 

 

Receiving a Drug Order 

Once the pharmacy physically receives their drug order from the wholesaler, the order must be 

received into the Kroll Pharmacy Software to update On Hand values and Pricing. An order can 

be received electronically (i.e. based on the vendor’s invoice download) or manually (i.e., based 

on the purchase order generated by you).  

The process of retrieving invoice files consists of three tasks: 

 Checking for invoice files 

 Retrieving invoice files 

 Processing invoice files 

Checking for Invoice File(s) and Retrieving Invoice File(s) are done in sequence. The Processing 

Invoice File(s) task is executed after logging out of the vendor’s server. 
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Checking for Invoice Files 

Each vendor has a unique invoice file naming convention.  

Similar with other tasks, the information panel will show when the Checking for Invoice File(s) 

task is in progress.  

 

When the Checking for Invoice File(s) task is complete, the information panel will show a status 

of Completed, along with the number of invoice files that were found.  

 

If no files were found, the Retrieving Invoice File(s) task will be skipped since there are no files 

to retrieve. Later, the Processing Invoice File(s) task will be skipped as well.  
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Retrieving Invoice Files 

If invoice files were found during the Checking for Invoice Files task, the Retrieve Invoice File(s) 

activity will automatically initiate. As soon as each file is retrieved, the information panel will 

show the corresponding filename. You can follow the progress of each file being retrieved on 

the top progress bar; the bottom progress bar tracks what percentage of all invoices has been 

retrieved. 

 

The invoice files will be temporarily saved in the designated vendor directory. The invoices will 

be saved in this folder until they are updated into the Kroll system. 

 

If an invoice file was retrieved from the vendor’s server, but was not processed because you 

cancelled it, it will be picked up in the next communication process.  
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Processing Invoice Files 

If invoice files were found and retrieved, the Processing Invoice File(s) activity will be 

automatically initiated. At this point, the communication process will try to match information 

in the invoice file to a purchase order in Kroll. When the process finds a match between an 

invoice file and a Kroll PO, you will see a screen similar to the one below: 

 

The above screen contains a top panel and a bottom panel. The top panel shows a list of 

retrieved invoice files with associated PO numbers. As well, an information message is shown to 

the left of the PO number; this message will help you decide which file to process.  

There is a checkbox on the upper left hand side of the screen that helps you select or deselect 

all invoice files/POs in the list. As well, there is an indicator on the upper right hand side that 

indicates x of y PO(s) have been selected. 
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The bottom panel shows a left and right grid; the information displayed is related to one of the 

invoice files shown in the top panel. The left grid shows the information contained in the 

invoice file. The right grid shows all the items within a PO in Kroll. You can resize the panels to 

show more or less information.  

 

In the above screen, the invoice file on the left (i0002559) is associated with PO 2559 on the 

right. The invoice file contains only four items. The idea is to allow you to see information inside 

the invoice file compared to information in the PO before the file is processed. Clicking on any 

item on either side of the grid will highlight the corresponding item on the opposite side if 

available.  

Looking at the right-hand grid above, item 00148619 (NOVO-TRIMEL 40MG/5ML SUSP), which 

is highlighted in red, was ordered for one pack (Ord Qty column). Comparing with the left grid, 

we can see that the received quantity (Rcv Qty column) is also one pack, which means 

everything ordered was received. 
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Looking at the right-hand grid below, item 00407627 (PMS-FLUOROMETHOLONE 0.1%), which 

is highlighted in aqua, was ordered for four packs, but the invoice file indicates that the vendor 

only sent three packs. Take note of the floating yellow message that reads “Short-Partial 

quantity shipped”. 

 

Looking at the right-hand grid below, item 000481124 (APO-PROPRANOLOL 20MG), which is 

highlighted in aqua, is out of stock and nothing was shipped, although the left-hand grid 

indicates that one pack was ordered. Take note of the floating yellow message that reads 

“[Vendor name] Short (No Stock)”. 
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On the right-hand grid below, item 02170538 (PMS-CLARITHROMYCIN 500MG TABS) was 

ordered, but the invoice file on the left indicates that the vendor sent item 02170530 as a 

substitution. Take note of the floating yellow box that reads “Substitute for 02170538 – 

substitution”. The vendor will only send substitutions for customers that provide consent to do 

so. 

 

When the Processing Invoice File(s) task does not find a matching PO in Kroll, you must decide 

what to do with the invoice. You will see a screen similar to the one below.  
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There are three options to choose from: 

 Treat as no stock received: This option will receive the invoice file, taking into 
consideration that no equivalent PO exists in Kroll; however, no on-hand quantities will 
be updated; only catalog prices will be updated, if necessary. This option should be used 
when an order was placed outside of the Kroll application for items that do not have 
inventory and prices monitored within Kroll (e.g., OTC items).  
 

 Treat like non-PO receive: This option will receive the invoice file, taking into 
consideration that no equivalent PO exits in Kroll, and the process will update the on-
hand quantity and prices for associated drug packs, if available. This option should be 
used when an order was placed outside of the Kroll application for items that have 
inventory and prices monitored within Kroll (e.g., Rx order sent directly from the 
vendor’s website).  
 

 Skip this PO: This option means the invoice file will not be processed and will remain 
outstanding. 
  

To set a default action for this option, go to Utilities > Drug Ordering > Edit Vendor List > 

[Vendor name] > Receiving and select the appropriate option from the Default Action when 

PO not found dropdown menu.  
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If you do not select an invoice file/PO equivalent, the invoice will sit in Utilities > Drug Ordering 

> Electronic Invoice Receiving with no Received date.  

 

Processing an invoice consists of four steps: 

 Update Purchase Order information in Kroll: In this step, the purchase order status will be 5.
set to “Received” or “Partially Received”. This step will not be executed when the file/PO is 
configured to be treated like a non-PO receive, or no stock received. 

 

 Update Drug Pack Prices: In this step, the system will look at the Receiving settings set in 6.
Utilities > Drug Ordering > Edit Vendor List > [Vendor name] > Receiving to determine if 
and where drug pack prices are updated. This step will not be executed when the file/PO is 
configured to be treated as “no stock received”.  
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 Adjust Drug Pack Inventory: In this step, the on-hand quantity of a drug pack will be 7.
adjusted if the following settings are in place: 

 Perform Inventory Adjustment in File > Configuration > Store > Order must be 
turned on.  

 No Inventory Adjustment in the Ordering tab on the Drug card must be turned off. 
This step will not be executed when the file/PO is configured to be treated as “no 

stock received”. 

 Update Catalog Prices: In this step, the system will look at the Catalog File Loading rules set 8.
in Utilities > Drug Ordering > Edit Vendor List > [Vendor name] to determine if and where 
drug pack prices are updated via the catalog.  
 

When the Processing Invoice File(s) task is complete, the status will show as Completed and 

the information panel will display the message “### End of Activities ###”. As well, two new 

buttons, Retry and Finish, will appear at the bottom of the communication screen to indicate 

that communication has finished. Click Finish or press Enter on the keyboard to close the 

communication screen. Click Retry or press CTRL+R to start another communication with the 

vendor. 
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New Rxs 

The prescription filling process is a well-defined series of steps that pharmacy users carry out to 

produce prescriptions for our patients. The Kroll Pharmacy Software is designed to work with 

the established prescription filling process to provide the safest, most efficient and reliable 

prescriptions and services to our patients. Different types of prescriptions are filled every day in 

the pharmacy (e.g., new Rxs, on hold Rxs, refill Rx, OTC to profile Rxs, professional service Rxs, 

etc.) and will be explained in the following sections. The steps for filling a new Rx are as follows:  

 Drop-Off 

 Input 

 Fill 

 Check 

 Release 

 Sell 

Drop-Off    

There are a number of fields and options available from the F11 - Drop-Off window. However, 

the following steps must be performed at the Drop-Off stage to ensure patient safety and to 

proceed to the next Rx Processing Stage in the system:  

a) Search and select a patient record  
b) Review the patient medication history  
c) Indicate a prescription due time (i.e., pick up time),  
d) Select a status for the prescription (i.e., Fill, Unfill, Not Disp, Stock Transfer)  
e) Scan the written prescription into the system  
f) Indicate the number of Rxs on the written prescription  

Pharmacy Assistants, Pharmacy Technicians, and Pharmacists can Drop-Off prescriptions into 

the system as follows:  

 From the ALT+X Start screen, click F11 - Drop-Off or press F11 on the keyboard. 1.

 The cursor will default to the Patient Search Field; search and select the applicable patient 2.
record (see Searching for a Patient from the F11-Drop Off Screen). Users should not 
continue the Drop-off process without entering a patient record.  

 Select a wait time from the Priority menu. If you want to enter a custom wait time, click the 3.
F2 button. Date and Time fields will appear, allowing you to enter custom wait time 
information. 
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The Delivery field will default to Pickup.  

 Once an Rx barcode sticker has been adhered to the written prescription, feed it into the 4.
document scanner and click the Import Script Image File button or select Select Script 
Image from the right navigation pane. If the prescription was faxed to the pharmacy, select 
Import Script Image from fax scan which allows you to select and attach a faxed image to 
the work order. 

 

 Once the image has been scanned into the system you can choose to Crop, Flip, Rotate 5.
and/or Fit to Window. Once the necessary changes have been made, click Save or press 
Enter on the keyboard to insert the image into the Drop-off screen.  

 Enter the number of medications on the written prescription in the # of Rxs On Page field. 6.
This will tell the system how many Rxs are associated with the Rx image.  
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 To Clear (i.e. delete) or Re-Scan a script image, select Clear Script Image from the right 7.
navigation pane. This will remove the existing image and allow you to re-scan the old image 
or scan a new image. 

 

 Select an Rx Status from the menu: 8.

 Fill: Process and dispense the Rx  

 Unfill: Put the Rx on hold  

 Not Disp: Mark the Rx as OTC to Profile  

 Stock Transfer: Mark the Rx as a stock transfer to another pharmacy  

 Enter any workflow-specific notes in the Note tab located near the bottom of the screen. 9.
The note will be displayed a t each Rx filling stage for the prescription.  

 

 Click Add to create the work order. The Rx will appear in the Workorder items pane. 10.
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 Repeat steps 10-11 for each Rx you want to add to the work order for that patient. When 11.
you are finished, click Finalize Work Order.  

 

Once Finalize Work Order is selected, a blank F11-Drop-Off screen will appear to allow another 

work order to be dropped. 

NOTE: If, for whatever reason, you are not able to scan the script image into the system, you 
can instead enter a Drug/Mixture, Doctor, Dispense Quantity, Days Supply, and Sig.  

Tracking a Work Order after Drop-Off    

Once a work order for a new Rx has been dropped off it will proceed to the Enter stage. You can 

access the F9-Workflow window from the ALT+X-Start screen by clicking F9-Workflow or by 

pressing F9 on the keyboard.  

The dropped order will appear in the Enter queue under the applicable due-time column. 

Additionally, there will be a list of Rxs in Progress on the lower half of the window for users to 

see which orders are coming up next in the selected queue. Entries on the lower half of the 

window are for information purposes only, users cannot change the work order due time on 

any of the entries listed. 
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Enter   

The Enter stage is where you enter prescription information such as Drug, SIG, Dispense 

Quantity, Intervention Codes, etc. into the system for processing. Extra care taken at this point 

will ensure that the work order passes through the Check quickly without having to make time 

consuming changes later on. Typically, Enter should be performed by a Pharmacy Assistant, but 

can also be performed by Licensed Technicians and Pharmacists.  

 Select F9 - Workflow from the Alt-X Start screen. 1.

 Click Enter to display the enter queue. 2.

 Click Get Work to view the work orders that need inputting. Work orders are always 3.
presented to you in priority sequence according to the due time assigned to the work order. 
Double-click the Rx you want to input. 

 

 The Create New Rx From To Do screen will appear. Search and select the appropriate drug 4.
record from the Drug/Mix search field and appropriate prescriber from the Doctor search 
field. 

 Enter dispensing information for the prescription:  5.

 SIG: Enter the Sig in the SIG field and the expansion will appear in read only format in 
the grey box below.  

 Disp Qty: Enter the dispense quantity for the prescription. 

 Days: Enter the day’s supply for the dispense quantity indicated.  

 Refills: Enter the number of refills on the prescription.  

 Auth Qty: The authorized quantity field will auto-populate if the Disp Qty and Refills 
fields are filled out. If the Auth Qty field is blank, enter the total authorized quantity for 
the entire prescription.  
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 Unlimited Refills Until: Place a checkmark next to this flag if the prescription has 
unlimited refills until a specific date.  

 When you are finished, click Save. 6.

 

The Rx will appear in the F12 screen. 
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F12 Screen Information Tabs 

Plans  

Users can select to exclude third party plans from the prescription, or change the order of 

billing from this tab (remove). The first plan listed is where the Rx is being billed to first; the 

second plan is where the Rx is billed to second, etc. 

 

Next Disp Qty  
Users can enter a new Dispense Quantity for the next refill (this is especially useful for trial 
prescriptions where the first order has a lower dispensing quantity than the next).  
 
Min Interval  
This field is used for narcotic prescriptions to prevent refilling until a specified number of days 

have elapsed.  

The bottom field is used for entering prescription comments; enter a free form comment and it 

will be saved with the prescription record.  
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Pricing 

The Pricing tab displays information regarding the pricing strategy used to calculate the Rx. 

Pricing strategies are set by home office and cannot be modified; however, if a pricing needs to 

be overridden, users can place a checkmark next to the Manual Price flag which will open up 

the Cost, Markup, Fee, Mix Fee and SSC fields for manual manipulation (Manual Pricing should 

only be used in emergency situations; incorrectly priced prescriptions should be reported to the 

Pharmacy Support Helpdesk so the root cause of the pricing issue is resolved at the root).  

 

Dates 

 

 Rx Start Date: This field will automatically be populated with the date the Rx was 
processed.  

 Rx Stop Date: Optionally enter a stop date for the prescription. Users will not be able to 
fill the prescription past the stop date unless it is removed.  

 Written Date: This field will be automatically populated with the date the Rx was 
processed, but can be overridden to whatever date the prescription was actually 
written.  
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 Rx Expiry Date: This field will be auto-populated depending on the drug schedule, the 
province the Rx was processed in, and the Written Date. 

 Drug Expiry Date: You can optionally enter a drug expiry date for the prescription. If a 
date is entered here, it will be printed on the vial label so that the patient can also see 
the drug expiry. This option is especially useful for liquid antibiotics.  

 Ingest Date: This field is used to record the ingest date for methadone prescriptions.  

Comments 

Comments can be quickly added under the Plans tab, however inserting an entry from the 

Comments tab allows you to activate certain configurations for the comment and allows you to 

enter more than one comment entry to the prescription.  

To add a comment, click Ins or press the Insert key on your keyboard. 
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The Rx Comment window will appear. Select a Topic and enter the comment in the space 

provided.  

 

In addition to the regular comment options of Show On Rx, Alert, and Print On Hardcopy, there 

are two additional comment options:  

 Keep Comments for Refill: When this option is checked, the comment will also be saved 
for any refills against the prescription.  

 Keep Comments for Copied Rxs: When this option is checked, the comment will be 
copied to a new prescription record if the original is copied. 
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Indications 

 

The Indications tab allows you to identify which condition the prescription is treating. When 

you click Ins or press Insert on your keyboard, a list of ICD- 10-CA and/or FDB conditions will be 

displayed. 

 

Highlight the indication you want to apply to the prescription and click Select. 
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Images 

The Images tab displays the script image that was scanned during Drop-Off. Click View Image to 

view the scanned image and + to add a new image. 

 

Other 

The Other tab indicates if Doctor Authorization has been received and if a Narcotic report will 

be printed for the Rx. A space to insert a comment is also provided. 
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Fill 

 Call up the F9 - Workflow screen and select the Fill queue.  1.

 All Rxs ready to be filled will be displayed. Click Get Work to view the next work order that 2.
needs to be filled. 

 The Fill Rx screen will be displayed. Scan the UPC or enter the DIN located on the stock 3.
bottle. 

 

 Enter the dispensed quantity in the Qty field. 4.

 If a balance owing is required, click the Owe button. If the order can be fulfilled, click 5.
Packaged to continue. 
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Check    

The Check stage must be performed by a pharmacist or licensed technician. Check is the final 

check that is made before the prescription is bagged and filed away in the pickup drawers. At 

this point, you should be looking at the filled prescription and verifying that against the written 

prescription and the electronic drug image displayed on the screen.  

 Call up the F9 - Workflow screen and select the Check queue.  6.
 All Rxs ready to be verified will be displayed. Click Get Work to view the next work order 7.

that needs to be verified. 
 The Check screen will be displayed. Verify that the packaged prescription matches the 8.

electronic drug image and can select one of the following:  
a) Save for Later: Returns you to the F9 - Workflow screen.  
b) Cancel Rx: Reverses the prescription and marks it as Cancelled in the patient 

profile. Cancelled Rxs can be filled again later. 
c) Reject: Rejects the Rx and sends it to the previous stage while still maintaining 

the work order priority sequence.  
d) Trouble: Removes the Rx from the work order priority queue.  
e) Approve: Packaged prescription that match the electronic drug image.  

 

 



  Kroll Windows 10 User Manual  

 

309 
 

Pickup 

The prescription pick up stage includes the following steps: 

 Verifying the identity of the person picking up the prescription(s).  

 Identifying the number of prescriptions that need to be retrieved from the Pickup bins. 

 Identifying the location of a prescription.  

 Identifying what stage of the prescription filling process an Rx is at.  

At this stage you can either create an OTC to profile record for patients purchasing OTC 

products, or check the status of prescriptions for those picking up. 

Creating an OTC to Profile Record for New and Existing Patients  

 Log into the Pickup application and select OTC from the top right corner of the screen. 1.

 

 Enter one of the following search criteria in the drug search field: 2.

f) Brand/Generic Name, Strength/Pack Size (e.g. Apo-Metformin, 500/360)  
g) DIN (5-8 digits)  
h) UPC (11-12 digits)  
i) A period (.) and the Drug Quick Code (e.g. TYLE1)  
j) #symbol and the Catalog Item Number (e.g. #78945)  
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 Use the arrow buttons to locate the correct product. Double-click the product or highlight it 3.
and click Select. 

 

 Repeat steps 2-3 for each product you want to add. If there are no other products to add, 4.
click Next.   
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 The patient search screen will appear. Search for the patient by entering one of the 5.
following patient search criteria:  

a) Last Name, First Name (e.g. “Doe, Jane” OR “doe,j” OR “Doe” OR “,Jane”)  
b) A period (.) and the Patient Quick Code (e.g. “.DoeJ”)  
c) 7 or 10 digit phone number (e.g. 800-263-5876 or 263-5876)  
d) A number sign (#) and the +Third Party Billing number (e.g. #123456789)  
e) An asterisk (*) to search ALL patients in the database  

 

 If the patient already exists, highlight the patient and click Select. If it is a new patient, click 6.
Insert and complete the patient fields. Click Save.  
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 The pickup confirmation screen will appear. If all the information on the screen is correct, 7.
click Confirm from the top right corner. If you need to make any changes, click Back or Start 
Over. You may enter a stop date, if necessary. 

 

NOTE: Clicking Confirm may produce DUR actions for the pharmacist to resolve.  
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Prescription Pickup  

  Log into the Pickup application and click the Pickup icon located in the top right corner.  1.

 

 In the patient search field, enter one of the following patient search criteria:  2.
a) Last Name, First Name (e.g. “Doe, Jane” OR “doe,j” OR “Doe” OR “,Jane”)  
b) A period (.) and the Patient Quick Code (e.g. “.DoeJ”)  
c) 7 or 10 digit phone number (e.g. 800-263-5876 or 263-5876)  
d) A number sign (#) and the +Third Party Billing number (e.g. #123456789)  
e) An asterisk (*) to search ALL patients in the database  

 Once the patient’s information is confirmed, highlight the information and click Select in the 3.
top right corner.  
 

 

 The patient’s medication history will appear, indicating what stage of the Prescription Filling 4.
Process the medications are in. For example, none of Jane Doe’s medications are ready for 
pick up and are in the Input stage.  
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To pickup prescriptions ensure they have a green check mark, then click Pickup [x] Item. 

 

 [Blank]- Indicates Identification is required to pickup this Rx 

 Counsel Patient – Indicates this prescription requires the pharmacist to counsel the 
patient. 

 Refrigerated – Indicates this prescription can be found in the refrigerator 

Refill Rx    

Refill Rxs can be filled for patients who have already had their previous prescription filled at the 

same pharmacy location. Typically, refill information is entered when the prescription is initially 

filled, and patients can choose if they want to enrol in the Refill Reminder program, which 

notifies them when their prescription refills are ready. See the Auto Fill Functionality user guide 

on our website for more information about this program. 

From the F3 - Patient Screen    

 Select F3 - Patient from the Alt-X Start screen.  1.

 Enter one of the following patient search criteria and click Search:  2.

a) Last Name, First Name (e.g. “Doe, Jane” OR “doe,j” OR “Doe” OR “,Jane”)  
b) A period (.) and the Patient Quick Code (e.g. “.DoeJ”)  
c) 7 or 10 digit phone number (e.g. 800-263-5876 or 263-5876)  
d) A number sign (#) and the +Third Party Billing number (e.g. #123456789)  
e) An asterisk (*) to search ALL patients in the database 

 Double-click the patient record. The F3 - Patient screen will display. 3.

 Select Refillable Rxs from the right navigation pane. 4.
 

http://www.kroll.ca/userguides/9.1%20Auto%20Fill%20Functionality.pdf
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 Highlight the medication(s) that the patient would like to refill and tag them using the 5.
spacebar and either right click on the patient profile or click on Extra Functions and select 
Add to Rx to Do List.  

 Select a Due time for the work order. This will add the prescription to the Enter queue.   6.

 

 Complete the Input, Filling, and Check stages described in the New Rxs section. 7.

Unfill Rx (On Hold)    

There can be many reasons why patients may not need some of their prescriptions filled at 

Drop-Off. For documentation purposes and convenience these prescriptions will be put on hold 

and referred to as Unfilled Rxs. An Unfill Rx will pass through Drop-Off, Enter, and Check of the 

Rx processing steps.  
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From the F11 - Drop-Off Screen   

With Rx Number 

 From the ALT+X Start Screen, click F11- Drop-Off or press F11 on your keyboard. 1.

 Enter the prescription number in the Refill Rx Number field and click Lookup. 2.

 

 The Rx will populate on the F11 - Drop-Off screen. Enter a Due time. This will add the 3.
prescription to the Enter queue.   

 Click Add to add the Rx to the Workorder Items list.  4.
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Click Finalize Work Order to move the prescription to adjudication. If any DUR messages are 

present they will first need to be resolved by the pharmacist before the prescription moves to 

the filling queue.  

Without Rx Number 

 Call up the F11- Drop-Off screen and perform a patient search.   1.

 Select Refillable Rxs from the right navigation pane.  2.

 The patient profile for the patient will be displayed. Use the spacebar to highlight the Rx(s) 3.
you want to refill and click F - Refill or press the F key on your keyboard. 

 

 The Rx(s) will appear in the Workorder Items list on the F11 - Drop-Off screen. If you want 4.
to edit any of the information in the Rx, double-click the Rx entry from the list. The Rx 
information will populate in the F11 - Drop-Off fields. Make the necessary changes and click 
Update. 
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 Click Finalize Work Order. 5.

Modify Rx 

Once a prescription has been processed, there are some fields that can be modified and some 

that cannot. For those fields that can be modified, namely prescription comments, refills, unit 

dose activation, and other fields that do not have clinical or financial impact, you can modify 

the prescription to edit those fields.  

Method 1: From the F3 - Patient Screen 

 Select F3 - Patient from the Alt-X Start screen and perform a patient search. Double-click 1.
the patient record.  

 The patient profile for the selected patient will be displayed. Select All Rxs from the right 2.
navigation pane. 

 Use the spacebar on your keyboard to tag the Rx(s) you want to modify. Click M - Modify or 3.
press the M key on your keyboard. 

 

 The Rx will appear on the F12 screen in Modify mode. Modify any of the editable fields 4.
(dispense quantity, authorize quantity, interchangeable drugs, and unit dose information). 

 When you are finished, click F12 - Save Changes. 5.
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Method 2: From the Alt-X Start Screen 

 Enter the Rx number in the Universal Search field and click Modify Rx. 1.

 

 The Rx will appear on the F12 screen in Modify mode. Modify any of the editable fields 2.
(dispense quantity, authorize quantity, interchangeable drugs, and unit dose information). 

 When you are finished, click F12 - Save Changes. 3.

Copy Rx 

The Copy Rx function allows you to copy information from an existing prescription to a new 

prescription. This function is often useful when the doctor renews a patient’s existing 

medications and there is no change in dosage or SIG. It is not recommended to use this function 

when there are changes in dose, SIG, or prescriber because when a prescription is copied, a link 

is created between the new and old prescriptions. The original prescription that was copied will 

automatically have a status of “Inact (Copied)” and cannot be transferred out.  

Method 1: From the F3 - Patient Screen 

 Select F3 - Patient from the Alt-X Start screen and perform a patient search. Double-click 1.
the patient record.  

 The patient profile for the selected patient will be displayed. Select All Rxs from the right 2.
navigation pane. 

 Use the spacebar on your keyboard to tag the Rx(s) you want to modify. Click F - Refill or 3.
press the F key on your keyboard. If there are no remaining refills for the Rx, a prompt will 
appear asking if you want to copy the Rx to a new number. Click Yes. 
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 The Rx will appear on the F12 screen as a New Rx. Select a Due time and make any 4.
necessary changes to the prescription.  

 When you are finished, click F12 - Fill Rx. 5.

 Complete the Input, Filling, and Check stages described in the New Rxs section for each Rx 6.
you have selected. 

Method 2: From the F11 - Drop-Off Screen 

 Call up the F11-Drop Off screen and perform a patient search. Enter a Due time.  1.

 Select All Rxs from the right navigation pane.  2.

 The patient profile for the patient will be displayed. Use the spacebar to highlight the Rx(s) 3.
you want to copy and click Y - Copy To New or press the Y key on your keyboard. 

 

 The Rx(s) will appear on the F11 - Drop-Off screen. The Rx is # [x] on page [x/x] indicates 4.
how many Rxs are about to be copied. Click Add to add the Rx to the Workorder Items list. 
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NOTE: Prescriber, drug, and dispensing information will be copied from the old Rx record but 
can be modified if necessary. 

 Repeat step 4 for each Rx you have selected to copy. When you are finished, click Finalize 5.
Work Order. 

 Complete the Input, Filling, and Check stages described in the New Rxs section for each Rx 6.
you have selected. 

Cancel Rx 

Cancelling a prescription means reversing a prescription which includes reversing claims sent to 

third party plans. You may need to cancel prescriptions for various reasons. For example, a 

change in dispensing quantity, wrong SIG inputted; patient does not want the prescription 

anymore. 

Method 1: From the F3 - Patient Screen 

 Select F3 - Patient from the Alt-X Start screen and perform a patient search. Double-click 1.
the patient record.  

 The patient profile for the selected patient will be displayed. Select All Rxs from the right 2.
navigation pane. 
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 Use the spacebar on your keyboard to tag the Rx(s) you want to modify. Click C - Cancel or 3.
press the C key on your keyboard.  

 

Depending on the type of prescription you are cancelling the system will prompt you with 

different messages for cancelling the prescriptions.  

Method 2: From the Alt-X Start Screen 

 Enter the Rx number in the Universal Search field and click Cancel Rx. 1.

 

 A prompt will appear asking if you are sure you want to cancel the Rx. Select Yes. 2.

Inactivate Rx 

Prescriptions should be inactivated if patients are no longer using certain medications as a part 

of their medication therapy. Prescriptions are automatically inactivated when they are copied 

to a new prescription number or if they are transferred out of the pharmacy; otherwise any Rx 

that needs to be inactivated will need to be done manually. 

 Select F3 - Patient from the Alt-X Start screen and perform a patient search. Double-click 1.
the patient record.  

 The patient profile for the selected patient will be displayed. Select All Rxs from the right 2.
navigation pane. 
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 Use the spacebar on your keyboard to tag the Rx(s) you want to modify. Click I - Inactivate 3.
or press the I key on your keyboard. 

 

 The Inactivate Rx(s) window will appear, displaying the selected Rx(s). Each Rx will have a 4.
status indicating if it is eligible to be inactivated. If the Rx information is correct, click 
Inactivate Eligible Rxs.  

 

 You will be prompted to enter an optional reason for inactivating the Rx. Click Save to 5.
continue. The status of the prescription will be show a status of ‘Inact’ in the patient profile.  

 

NOTE: Prescriptions will automatically become inactive if they are copied or have been 
transferred to another pharmacy. 
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Reactivate Rx 

Introductory paragraph.  

 Select F3 - Patient from the Alt-X Start screen and perform a patient search. Double-click 1.
the patient record.  

 The patient profile for the selected patient will be displayed. Select All Rxs from the right 2.
navigation pane. 

 Use the spacebar on your keyboard to tag the Rx(s) you want to modify. Select Extra 3.
Functions > Reactivate Rx. 

 

 The Reactivate Rx window will appear, displaying the selected Rx(s). Each Rx will have a 4.
status indicating if it is eligible to be reactivated. If the Rx information is correct, click 
Reactivate Eligible Rxs.  
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Not Dispensed Rx 

Creating an OTC to profile record for patients is known as Not Dispensed Rxs in the system. The 

term not dispensed is used because these prescriptions are not dispensed by the pharmacist. 

Rather they are over-the-counter medicines that are taken by the patient and therefore 

included in the patient profile for drug interaction analysis. 

Drop-Off 

 From the ALT+X Start screen, click F11- Drop-Off or press F11 on your keyboard. 1.

 Search for the patient in the patient search field and select a Due time. If there are any 2.
counseling notes written in regards to the OTC product it should be scanned into the system 
via the document scanner.  

 Set the Rx status to Not Dispensed.  3.

 Enter the name of the pharmacist on duty in the Doctor field.  4.
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 Once all the relevant information has been entered, click Add to add the work order to the 5.
Workorder items list. 

 

 Click Finalize Work Order.  6.

Enter    

The Enter stage is where you enter prescription information such as Drug, SIG, Dispense 

Quantity, Intervention Codes, etc. into the system for processing.  

 Select F9 - Workflow from the Alt-X Start screen. 1.

 Click Enter to display the enter queue. 2.

 Double-click the Not Dispensed Rx record. 3.

 The F12 screen will appear, displaying the Rx details entered at Drop-Off. Enter any 4.
remaining Rx information (Dispense Quantity, Intervention Codes, etc.).  

If you want to enter a stop date, click the Dates tab and enter an Rx Stop Date. For stores 
connected to a Drug information System, entering stop dates for Not Dispensed/OTC to 
profile Rxs may be required. 
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 Click F12 - Fill Rx or press the F12 key on your keyboard. 5.
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Fee for Service Rx 

Fee for service prescriptions are prescriptions billed to third parties for professional service 

rendered by the pharmacist to the patient. For example, some Fee for Service prescriptions can 

be prescription adaptation services, medication reviews, refusals to fill, smoking cessation etc. 

Since services are not physically tangible and do not involve the dispensing of a dug product, 

some elements of prescription processing may be eliminated. Fee for service prescriptions 

should always be filled after the service has been provided to the patient. 

Drop-Off 

 From the ALT+X Start screen, click F11- Drop-Off or press F11 on your keyboard. 1.

 Search for the patient in the patient search field and select a Due time.  2.

 Set the Rx status to Fill. 3.

 Once all the relevant information has been entered, click Add to add the work order to the 4.
Workorder items list. 
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 Click Finalize Work Order.  5.

Enter 

Fee for Service “drug records” typically have a DIN or Pseudo DIN used for billing, but do not 

have a UPC, counseling, drug monograph, or ordering tabs because these do not apply for 

services rendered to a patient.  

 Select F9 - Workflow from the Alt-X Start screen. 1.

 Click Enter to display the enter queue. 2.

 Double-click the Rx record. 3.

 The F12 screen will appear, displaying the Rx details entered at Drop-Off. Use the Drug 4.
Search field to search for and select the applicable professional service. 

In some cases, depending on the selection made in this field, the system will send a Special 
Services Code, Intervention Code, Rx prefix, etc. to third parties as a part of billing 
requirements. 

NOTE: The Drug Price Group field may have a strategy applied to the drug record to instruct 
the system to use a specific pricing strategy for prescriptions filled for the service. 

 Enter the name of the pharmacist who provided the professional service in the Doctor field.  5.

 To view any intervention codes or special service codes that will be submitted to third 6.
parties as part of the claim, select Plan Information from the right navigation pane. The Rx 
Plan Information window will appear.  
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Click OK to close the Rx Plan Information screen. 

 Enter any remaining Rx information and click F12 - Fill Rx or press the F12 key on your 7.
keyboard. 

 

Transfer Rx    

Prescriptions can be transferred into or out of the pharmacy. In both cases, information 

regarding the transfer should be recorded in the system. 

Transferring an Rx from Another Store 

Transfers received from other pharmacies are treated as new prescriptions and must go 

through the same stages as a new prescription. 

Drop-Off 

 From the ALT+X Start Screen, click F11- Drop-Off or press F11 on your keyboard. 1.

 Perform a patient search. 2.
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 Feed the transfer report into the document scanner and click Import Script Image File. 3.

 Click Add to add the work order to the Workorder items list. 4.

 Click Finalize Work Order. 5.

Enter 

 Select F9 - Workflow from the Alt-X Start screen. 1.

 Click Enter to display the enter queue. 2.

 Double-click the Rx record. 3.

 The F12 screen will appear, displaying the Rx details entered at Drop-Off. Select Transfer Rx 4.
From Another Store from the right navigation pane.  

 The Transfer Rx from other store screen will appear. In the Search for a store field, begin 5.
typing the name of the originating pharmacy. If a matching pharmacy is located, either 
double-click the entry or highlight the entry and press the Enter key on your keyboard. 

 

a) If a matching pharmacy cannot be found click, New to insert a new transfer pharmacy 
record. Complete the Create Store form and click OK. 

 Enter the name of the pharmacist on duty in the Pharmacist Name field and enter any 6.
available Rx information in the Rx information from other store fields. 
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 Click OK. 7.

 Complete the remaining Rx fields and click F12 - Rill Rx. 8.

Transferring an Rx to Another Store  

 Call up the F3 - Patient screen and perform a patient search. Double-click the patient 1.
record. 

 Select All Rxs from the right navigation pane.  2.

 Use the spacebar to tag the Rx(s) you want to transfer.  3.

 Select Extra Functions > Transfer Rx to Another Store. 4.
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 The Transfer Out Rx(s) screen will appear. In the Search for a store field, begin typing the 5.
name of the pharmacy you want to transfer the Rx to. If a matching pharmacy is located, 
either double-click the entry or highlight the entry and press the Enter key on your 
keyboard. 

 

a) If a matching pharmacy cannot be found click, New to insert a new transfer pharmacy 
record. Complete the Create Store form and click OK. 

 Enter the name of the pharmacist on duty in the Pharmacist Name field. 6.

 Click Transfer Out Eligible Rxs. 7.

 A prompt will appear asking if you want to print the Transfer Report. Answer Yes or No 8.
accordingly. 

 The Rx will show a status of Inact (Transferred Out) in the patient profile. 9.
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Rx with LU Code/ Section / SSC / Special Auth #    

In Ontario, some prescriptions require supplementary plan information to facilitate billing; this 
can take the form of a Limited Use Code, Section 8 Intervention code, Special Authorization, or 
special service code. Some of these supplementary items will be added to the system 
automatically; for example, DA and DB interventions. Other supplementary items need to be 
added manually. 

Drop-Off 

 From the ALT+X Start screen, click F11- Drop-Off or press F11 on your keyboard. 1.

 Perform a patient search. 2.

 Feed the transfer report into the document scanner and click Import Script Image File. 3.

 Click Add to add the work order to the Workorder items list. 4.

 Click Finalize Work Order. 5.

NOTE: There is no field for entering supplementary plan information in the F11 - Drop-Off 
screen. This must be done at the Enter stage. 

Enter 

 Select F9 - Workflow from the Alt-X Start screen. 1.

 Click Enter to display the enter queue. 2.

 Double-click the Rx record. 3.

 The F12 screen will appear, displaying the Rx details entered at Drop-Off. Enter the drug, 4.
prescriber, and dispensing information as usual. Click F12 - Fill Rx. 

 If an ODB plan exists in the patient record and the drug has a Limited Use Code, a prompt 5.
will appear asking how you want to bill the drug. Select Bill to ODB with a Reason Code. 
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 The Limited Use Product Form will appear. Select the appropriate limited use code and click 6.
OK. 

 

If you accidentally bypassed the Limited Use prompt or if you want to add an intervention code, 
SSC, or Special Authorization number to the prescription, select Plan Information from the right 
navigation pane. 

The Rx Plan Information screen will open, displaying a separate tab for each plan listed in the 
patient profile. If the drug in the Rx is a Limited Use drug, click F2 next to the Reason Code field 
to view all codes associated with the drug. Re-select the code and click OK. 

The Claim Type, Real Time Plan flag, and Pseudo DIN fields are automatically populated and 

should not be changed. Once all necessary Plan Information has been set, click OK or press 

Enter on the keyboard to continue. Proceed to move the prescription to the next Rx processing 

stage. 
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 Click F12 - Fill Rx. 7.

Merges 

Drug merging in Kroll allows users to combine two different patient, drug, or prescriber records 

into a single, unified record. This section explains how to perform patient merges, drug merges, 

and prescriber merges.  

Patient Merges 

 From the Alt-X Start screen, go to Utilities > Merge > Patients. 1.

 The Transfer Patient Profiles Form will appear. Perform a search for the patient record you 2.
want to keep in the New Patient to be transferred TO field. The patient’s address 
information will populate. 
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 Perform a search for the patient record you want merged in the Old Patient to be 3.
transferred FROM field. The patient’s address information will populate. 

 

 Click Transfer. 4.

 A prompt will appear asking if you are sure you want to merge the two patients. Answer 5.
Yes. 

 Click Cancel to close the Transfer Patient Profiles Form.  6.
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Drug Merges 

 From the Alt-X Start screen, go to Utilities > Merge > Drugs. 1.

 The Merge Drugs Form will appear. Enter the drug names in the respective New Drug to be 2.
merged TO and Old Drug to be merged FROM fields and click Lookup. 

 

 From the list of search results, select the drug you want to merge to and click Select. Click 3.
Select again. 

 From the list of search results, select the drug you want to merge from and click Select. 4.
Click Select again. 

 Both drugs will populate on the Merge Drugs Form. Click Transfer. 5.
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 A prompt will appear asking if you are sure you want to merge the drugs. Select Yes. 6.

 

 The Merge Pack Size form will appear asking you which drug pack you want to keep and if 7.
you want to merge the on-hand quantities for both drugs. Select From Drug to retain the 
drug pack for the drug you merged from, or To Drug to retain the drug pack for the drug 
you merged to.  

Place a checkmark next to Merge On Hand Quantities if you want the on-hand quantities 
for both drugs to be merged.  

 

 A prompt will appear to confirm the number of prescriptions that were transferred to the 8.
new drug, and ask you if you want to delete the old drug from the system. If you select Yes, 
the old drug will be deleted and you will be left with the drug you merged to. If you select 
No, the drug you merged from will remain in the system. 
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Prescriber Merges 

 From the Alt-X Start screen, go to Utilities > Merge > Doctors. 1.

 The Merge Doctors Form will appear. Perform a search for the prescriber record you want 2.
to keep in the New Doctor to be transferred TO field. The prescriber’s address information 
will populate. 

 

 Perform a search for the prescriber record you want merged in the Old Doctor to be 3.
transferred FROM field. The prescriber’s address information will populate. 

 

 Click Transfer. 4.
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 A prompt will appear asking if you are sure you want to merge the two prescribers. Answer 5.
Yes. 

 Click Cancel to close the Merge Doctors Form. 6.

Patient Credit Cards 

To ensure the privacy and security of patient credit card information in accordance with 

Payment Card Industry (PCI) compliance, Kroll has designated an area in the software for 

entering such information. Permission settings within the system can limit access to this area to 

certain groups of individuals within the pharmacy. 

You must belong to a user group that has the Allow Credit Card Password Management 

permission enabled in order to manage patient credit cards. Refer to the Permissions section to 

enable this permission setting.  

Creating a Credit Card Access Password 

 From the Alt-X Start screen, go to Utilities > Credit Card Password Manager. 1.

 The Credit Card Password Manager window will appear. Click Create new Credit Card 2.
Access Password. 
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 The Create New Credit Card Password form will appear. Enter the credit card password in 3.
the New Password and Verify New Password fields and click OK. 

 

NOTE: Passwords must be at least seven characters in length and contain both alpha and 
numeric characters.  

 The Credit Card Password Manager window will show an Expiry date of three months from 4.
today’s date. Click Close to exit the window.  

 

Recording a Patient Credit Card 

 Call up the patient profile and go to Patient > View Credit Cards. 1.
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 The Patient Credit Card List screen will appear. Click Ins or press the Insert key on your 2.
keyboard. 

 

 The Patient Credit Card Information form will appear with the patient’s address 3.
information prepopulated. Select a Card Type and complete the Card Number, Expiry Date, 
and Cardholder Name fields. Click Save. 
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If you want to add a debit account rather than a credit card account, select Debit from 
the Debit Type menu and complete the Bank Number, Transit Number, and Account 
Number fields. Click Save. 

 

 Enter the credit card password in the Password field and click OK. 4.

 

 The credit card will appear in the Credit Cards list in the Patient Credit Card List screen. 5.
Click Close to exit. 

 

Modifying a Credit Card Record 

 Call up the patient profile and go to Patient > View Credit Cards. 1.

 The Patient Credit Card List screen will appear. Select the credit card you want to modify 2.
and click F2 or press the F2 key on your keyboard. 
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 Make the necessary changes to the patient’s credit card information and click Save. 3.

 Click Close to exit the Patient Credit Card List screen. 4.

Deleting a Credit Card Record 

 Call up the patient profile and go to Patient > View Credit Cards. 1.

 The Patient Credit Card List screen will appear. Select the credit card you want to modify 2.
and click Del or press the Delete key on your keyboard. 

 A prompt will appear asking if you are sure you want to delete the credit card record. 3.
Answer Yes. 

 Click Close to exit the Patient Credit Card List screen. 4.

Reports 

Reports can be accessed from the Alt-X Start screen under the Reports menu; patient reports 

are available under Reports > Patient, and can also be accessed from the F3 - Patient screen in 

the Reports menu. The following reports are supported in Kroll 10: 

Patient 

 AR Taxes Breakdown Report 

 ATC Report 

 AutoMed Report 

 Compliance Label 

 Creatinine Clearance Report 

 Dispill Report 

 DistriMedic Report 

 Drug Interaction Analysis Report 

 EcoloPharm EcoPill Report 

 FlexRx Label Report 

 MAR Pak Report 

 Medical Expense Invoice 

 Medical Expenses 

 Medical History 

 Medication Reconciliation Report 

 Medication Sheet 

 MRx Label Report 
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 MTS OnDemand 

 PACMED Report 

 Passtime Summary 

 Patient (Comment Report) 

 Patient CSV Dump 

 Patient Drug Summary Report 

 Patient Encounters Report 

 Patient Listing Report 

 Patient Mailing List Report 

 Patient Medical Conditions 

 Patient Medication Chart 

 Patient Profile Report 

 Persa-Kit 

 Plain Paper MAR 

 Shipping Report 

 SynMed Report 

 Tax Receipt 

Rx 

 Adjudication Totals 

 Claims Invoice 

 Compound Prescription Audit Report 

 Daily/Monthly Totals 

 Daily/Weekly Workload Report 

 DTC Report 

 DUR Letter Report 

 DUR Report 

 Electronic Hardcopy 

 Expanded Scope of Practice Report 

 Future Usage Report 

 Hardcopy Report 

 IMS Report 

 Laser Label Report 

 Narcotic Control Record 

 Narcotic Rx Request Report 

 NIHB Claims Invoice 

 Plan Billing Summary 

 Plan Breakdown 

 Plan Discount Report 

 Plan Summary 

 Prescription Sales Analysis Report 
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 Price Strategy Summary 

 Print Script Image Report 

 Profit/Loss 

 Refills Due 

 Rx (Comments Report) 

 Rx Breakdown 

 Rx Canada Report 

 Rx for Drug/Doctor Groups 

 Rx Stop/Expiry/Inactivated/Copied 

 Rx Summary 

 Rx Totals Report 

 Rx Transfers Report 

 Rxs in Bins 

 Special Services Fees Report 

 Therapeutic Class Report 

 Time Distribution Report 

 Undeliverable Rxs Report 

 Will Call BIN Report 

 Workflow Daily Sales Report 

 Workflow DUE Report 

Drug 

 Active Drug Listing Report 

 Drug (Comments Report) 

 Drug Future Orders Report 

 Drug Inventory History Report 

 Drug Inventory Listing Report 

 Drug Listing Report 

 Drug Price Change Report 

 Drug Purchases Report 

 Drug Usage Report 

 Drug Utilization Audit Report 

 Generic Sales Analysis Report 

 Inventory Report 

 Mixture Listing Report 

 Narcotic Report 

Doctor 

 Doctor (Comments Report) 

 Doctor Listing Report 

 Doctor Rx Filled Report 

 Patient / Primary Prescriber Ratio List 
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Nursing Home 

 Active Drug Listing Report 

 Nursing Home (Comments Report) 

 Nursing Home Drug Usage Report 

 Nursing Home Drug Utilization Report 

 Nursing Home Listing/Info Report 

 Nursing Home Passtime Report 

 Nursing Home Patient Listing Report 

 Nursing Home Patient Statistics 

 Standing Orders Recall Report 
 
Administration 

 AR Adjustments Audit Report 

 Field Modification History Report 

 Paid Same Report 

 Patient Network Audit Report 

 Pharmacy Business Analysis Report 

 Pre-Authorized Charges Report 

 Rx Counseling Report 

 Rx Reprint / Modify Report 

 Submitted / Received Difference 

 User Information Report 

 Workflow Business Summary Report 
 
Other 

 AR (Comments Report) 

 Bin / Totes Report 

 Comments Report 

 Dayforce Data Report 

 Delivery Order Summary Report 

 Mailing List Report 

 Medication Review Summary Report 

 Network vs Adjudication Totals 

 Pre-Authorized Charges Report 

 Price Tree Report 

 Security Audit Report 

 Sig Code Listing 

 ToDo Report 

 Weekly Comparison Report 
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Old 

 Old Daily Totals 

 Old Dispill (Style 1) Report 

 Old Dispill (Style 2) Report 

 Old Monthly Totals 

Reports can also be accessed by clicking Reports > Search and typing in any part of the report 

name. 

Common Daily Reports 

This section outlines the most commonly used daily reports in Kroll. 

End of Day Report 

The End of Day Report provides a snapshot of the prescription totals for the day.  

 To generate this report, go to File > Exit or press Alt + F + X on your keyboard. 1.

 A prompt will appear asking if you want to print the End of Day Report. Select Yes. 2.

Sample End of Day Report: 

 

Network Totals Report (Adjudication Totals From Network)  

At the end of the day, a Network Totals Report will communicate real time to the third party 

plans providing the totals of the day for those plans. The Day End Report and Network Totals 

Report should balance. 
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You will be prompted to generate the Network Totals Report after generating the End of Day 

Report. 

Sample Network Totals Report: 
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Common Weekly Reports 

This section outlines the most commonly used weekly reports in Kroll. 

Adjudication Totals Report 

The Adjudication Totals Report represents what Kroll has recorded as being paid by the third 

parties (unlike the Network Totals Report, the Adjudication Totals Report does not 

communicate real time to the third party plans).   

 To generate this report, go to Reports > Rx > Adjudication Totals. 1.

 The Adjudication Totals Report form will appear.  2.

 In the Selection tab, use the Date Range, Starting, and Ending fields to specify a date 
range. Click the F2 button next to the Plans field to select the plans you want included in 
the report (optional). 

 Click the Options tab to specify the report parameters. Use the Group By options to 
specify how the report will be organized. 

 

 

 Click Preview to preview the report or Print to generate a printout of the report.   3.
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Sample Adjudication Totals Report: 

 

Daily/Monthly Totals Report 

The Daily/Monthly Totals Reports summarizes the total dollar values for the date range 

specified on either grouping them daily or monthly based on your selections in the report. It is 

important to note that this is a fill-based report, meaning it will only reconcile with other fill-

based reports. 

 To generate this report, go to Main Menu > Reports > Rx > Daily/Monthly Totals. 1.

 The Daily/Monthly Totals Report form will appear.  2.

 Use the Date Range, Starting, and Ending fields to specify a date range.  

 Click the F2 button next to the Patient Groups field to select the patient groups you 
want included in the report (optional).  

 If you want to generate the report for specific patients only, select the Patient button 
and click Add. Perform a patient search for each patient you want included in the 
report.  
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 If you want to generate the report for specific nursing homes only, select the Home 
button and click Add. Select the Home and applicable Ward and click OK. Repeat this 
step for each home you want included in the report. 
 

 

 Click Preview to preview the report or Print to generate a printout of the report.   3.
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Sample Daily/Monthly Totals Report: 
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Plan Summary Report 

The Plan Summary Report summarizes the total dollar values generated for all plans including 

cash within a specified date range. 

 To generate this report, go to Reports > Rx > Plan Summary. 1.

 The Plan Summary Report form will appear.  2.

 Use the Date Range, Starting, and Ending fields to specify a date range.  

 Click the F2 button next to the Patient Groups field to select the patient groups you 
want included in the report (optional).  

 If you want to generate the report for specific nursing homes only, select the Home 
button and click Add. Select the Home and applicable Ward and click OK. Repeat this 
step for each home you want included in the report. 

 

 

 Click Preview to preview the report or Print to generate a printout of the report.   3.
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Sample Plan Summary Report: 

 

Other Common Reports 

This section outlines the other most commonly used reports in Kroll. 

Claims Invoice Report 

The Claims Invoice Report captures the prescriptions filled to non-real time plans (i.e., manual 

billing plans).  

 To generate this report, go to Reports > Rx > Claims Invoice. 1.

 The Claims Invoice Report form will appear. 2.

 Use the Date Range, Starting, and Ending fields to specify a date range.  

 Click the F2 button next to the Patient Groups field to select the patient groups you 
want included in the report (optional).  

 If you want to generate the report for specific patients only, select the Patient button 
and click Add. Perform a patient search for each patient you want included in the 
report.  

 If you want to generate the report for specific nursing homes only, select the Home 
button and click Add. Select the Home and applicable Ward and click OK. Repeat this 
step for each home you want included in the report. 



  Kroll Windows 10 User Manual  

 

357 
 

 Click the Options tab to specify the report parameters. Use the Group By options to 
specify how the report will be organized. 
 

 

The Options tab determines how the report is generated. The most common fields that should 

be enabled are described below: 

Print Cost, Fee & Markup 
This is required when manually submitting to a plan in order for them to pay. 

Print Total 
The plan wants to see this information. 

Print Prev Paid/3rd Party Pays 
This is important to the manual bill plan if a previous online plan has paid any of the amount of 

the claim. 

Print Co-pay 
This is also important to the manual bill plan if there is a preset deductible for that plan. (i.e. 

the manual plan pays 80% and the patient pays 20%). 
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Show Sub-plans Instead of Plans 
This covers if the plan is a manual bill plan of another for example: I create a manual bill plan 

under the Assure plan, it then becomes a sub plan of Assure. 

Include Same-Range Cancels 
This is important to include in case the prescription has been cancelled and then rebilled. The 

manual billed plan will want to see the cancel for that number and then the rebill with the new 

Rx number. 

Include Items Where Plan Pays $0.00 
Best to include this amount so that it picks up any of the plans where we have said bill 

manually. 

Include Data for Real-Time Plans 
We want to include the data of real time plans that may have paid a portion of the prescription 

previously or we have said to bill manually. 

 Click Preview to preview the report or Print to generate a printout of the report.   3.

Sample Claim Invoice Report (Claims): 
 

 
 
The second page printed for the report shows the total number of Rxs billed, reversed, and the 
net amounts due. It also includes the cost, markup, fee total, copay, and third party amounts. 
This is typically kept for pharmacy records. 
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Sample Claim Invoice Report (Plan Summary): 

 
 
The last page is the Report Summary. This page is typically kept by the pharmacy to track what 
they have submitted. 
 
Sample Claims Invoice Report (Report Summary): 
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 Narcotic Report 

The Narcotic Report is used to track the reportable and forced reportable drugs that have been 

dispensed by the pharmacy.  

 To generate this report, go to Reports > Drug > Narcotic Report. 1.

 The Narcotic Report form will appear.  2.

 Use the Date Range, Starting, and Ending fields to specify a date range.  

 Click the F2 button next to the Drug Schedule field to select the drug schedule(s) you 
want included in the report (optional).  

 Use the Show menu to specify if you want the report to show All Rxs, Rxs with Doctor 
Authorization, or Rxs without Doctor Authorization. 

 Use the Sort By menu to specify if you want the report sorted by Date, Brand/Date, 
Generic/Date, or Patient/Date. 

 Place a checkmark next to the options you want applied to the report.  
 

 

 Click Preview to preview the report or Print to generate a printout of the report.   3.
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Sample Narcotic Report:  
 

 

Profit/Loss Report 

The Profit/Loss Report is used to identify profit and loss margins. This report can print all Rxs for 

a specific profit and loss amount or percentage for date range selected.  It will also identify 

discounts provided by users during the adjudication process.   

 To generate this report, go to Reports > Rx > Profit/Loss.  1.

 The Profit/Loss Report form will appear. 2.

 Use the Date Range, Starting, and Ending fields to specify a date range.  

 Click the F2 button next to the Plans field to select the plans you want included in the 
report (optional).  
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 Click the Options tab to specify the report parameters. 
 

 

The Options tab determines how the report is generated. The most common fields that should 

be enabled are described below: 

Print Same Day Cancels 
When enabled, this option will include Rxs that were cancelled on the same day they were 

filled. 

Exclude Cancelled Rxs 
When enabled, this option will exclude cancelled Rxs from the report. 

Show Discount 
Enable this option to include any discounts that were given to the prescriptions by you during 

the adjudication process. 

Show Initials 
Enable this option to include users Initials who filled the prescription 

Include Fee in Rx Total Calculation 
Enable this option if you wish to include the Fee in total $ calculations. 

Summary Only 
Enable this option to print a summary (no details) of the options enabled. 
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Print Rxs where the Profit Amount > than XX 
Enable this option to open up fields to include profile, loss or discounts, amounts or 

percentages that are >, <, =, >=, or <= than a specific dollar amount. 

Print Rxs where Total > than 0 
Enable this option to include Rxs where the total is >, <, =, >=, <=, than XXX (any given dollar 

amount). 

Print only Rxs with Manual Price 
Enable this option to include only the prescriptions that have been setup with a manual price 

override. 

Fee for Service 
Enable this option to include Rxs flagged as Fee for Service, exclude Rxs flagged as Fee for 

Service or only include Rxs flagged as Fee for Service. 

 Click Preview to preview the report or Print to generate a printout of the report.   3.

Sample Profit/Loss Report: 

 

Patient Medical History Report 

The Patient Medical History Report prints the contents of the patient’s patient profile. 

 To generate this report, go to Reports > Patient > Patient Medical History. 1.

 The Patient Medical History Report form will appear. 2.
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 Use the Date Range, Starting, and Ending fields to specify a date range.  

 Click the F2 button next to the Patient Groups field to select the patient groups you 
want included in the report (optional).  

 If you want to generate the report for specific patients only, select the Patient button 
and click Add. Perform a patient search for each patient you want included in the 
report.  

 If you want to generate the report for specific nursing homes only, select the Home 
button and click Add. Select the Home and applicable Ward and click OK. Repeat this 
step for each home you want included in the report. 

 Click the Options tab to specify the report parameters. 

 

The Options tab determines how the report is generated. The most common fields that should 

be enabled are described below: 

Print Store Logo 
Enable this option to print your store logo on the report. 

Print Billing Info 
Enable this option to include patient billing information such as the patient plan and billing 

number. 

Include Inactive Rxs 
Enable this option to include prescriptions that are inactive for the patient.   
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Display Refills 
Enable this option to group refills together.  

Print Disclaimer 
Enable this option to print a disclaimer at the bottom of every page or the option to only print 

the disclaimer at the end of the report. 

 Click Preview to preview the report or Print to generate a printout of the report.   3.

Sample Patient Medical History Report: 
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Patient Tax Receipt Report 

The Patient Tax Receipt Report prints the totals amount prescription dollar spent and is 

commonly used for tax purposes. This is not a detailed report as Revenue Canada only requires 

the total dollars spent and not the Rx details. 

 To generate this report, go to Reports > Patient > Tax Receipt. 1.

 The Patient Tax Receipt form will appear.  2.

 Use the Date Range, Starting, and Ending fields to specify a date range.  

 Click the F2 button next to the Patient Groups field to select the patient groups you 
want included in the report (optional).  

 If you want to generate the report for specific patients only, select the Patient button 
and click Add. Perform a patient search for each patient you want included in the 
report.  

 If you want to generate the report for specific nursing homes only, select the Home 
button and click Add. Select the Home and applicable Ward and click OK. Repeat this 
step for each home you want included in the report. 

 Click the Options tab to specify the report parameters. 

 

 Click Preview to preview the report or Print to generate a printout of the report.   3.
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Sample Patient Tax Receipt Report: 

 

Rx for Drug/Doctor Group Report 

The Rx for Drug/Doctor Groups report is used to find a particular dispense for a specific drug, 

doctor, drug group, or doctor group. This report is especially useful for drug recalls. 

 To generate this report, go to Reports > Rx > Rx for Drug/Doctor Groups. 1.

 The Rx for Drug/Doctor Groups Report form will appear.  2.

Selection tab: 

 Select All active Rxs to generate the report for all currently active Rxs, or Rxs filled to 
specify a Date Range, Starting date, and Ending date.  

 Use the Rx Lot Number field to specify what lot numbers you want included in the 
report (optional). 
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 Click the F2 button next to the Plans field to select the plans you want included in the 
report (optional). 
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Patient tab: 

 If you want to generate the report for specific patients only, select the Patient button 
and click Add. Perform a patient search for each patient you want included in the 
report.  

 If you want to generate the report for specific nursing homes only, select the Home 
button and click Add. Select the Home and applicable Ward and click OK. Repeat this 
step for each home you want included in the report. 

 Click the F2 button next to the Patient Groups field to select the patient groups you 
want included in the report (optional).  

 Click the F2 button next to the Provinces/States field to select the provinces or states 
you want included in the report (optional). 
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Drug tab: 

 Click the F2 button next to the Drug Groups field to select the drug groups you want 
included in the report (optional).  

 Click the F2 button next to the Drug Schedule field to select the drug schedules you 
want included in the report (optional).  

 Click the F2 button next to the Drug Departments field to select the drug departments 
you want included in the report (optional).  

 If you want to generate the report for specific drugs only, click the Add button below 
the Drug field. Perform a drug search for each drug you want included in the report. The 
Remove button will remove individual items from the Drug list, and the Clear button will 
remove all items from the Drug list. 
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Doctor tab: 

 Click the F2 button next to the Doctor Groups field to select the doctor groups you want 
included in the report (optional).  

 If you want to generate the report for specific prescribers only, click the Add button 
below the Doctor field. Perform a prescriber search for each prescriber you want 
included in the report. The Remove button will remove individual prescribers from the 
Doctor list, and the Clear button will remove all prescribers from the Doctor list. 
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Options tab: 

 Click the Options tab to specify the report parameters. 

 Use the Group By options to specify how the report will be organized. 

 Select Include Fee For Service Rxs, Exclude Fee For Service Rxs, or Only Fee For Service 
Rxs to specify how you want the report to handle Fee For Service Rxs. 
 

 

The Options tab determines how the report is generated. The most common fields that should 

be enabled are described below: 

Print Unfills 
Include all Unfills (Rxs placed on Hold) in the report 

Print Not Dispensed 
Include all Rxs marked as Not Dispensed (i.e. OTC Rxs) 
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Print Inactive 
Include all Rxs that have a status of Inactive 

New Rxs only 
This option will only print new prescriptions 

Show Drug 
This will print the drug name  

Show Lot# 
If you maintain lot numbers in your drug cards this will include them on the report 

Show Rx Details 
When this option is enabled it will print the Rx quantity, the status, the first fill, remaining 

quantity, authorized quantity and the current fill date. 

Financial Breakdown 
This option will include all financial details of the prescription, for example:  Actual Acquisition 

Cost, Effective Markup, Markup Percentage, Fees, Special Services Code Fee, Total of the 

prescription (including the previous amounts), and Gross Profit Percentage along with the Co-

Pay amount. 

Separate Special Services Fee 
With this option enabled, it will separate the SSC field (Special Services Fee Field) from the 

other cost fields.  

Print Sig Codes 
With this option enabled, it will print with the sig code for the prescription. 

Sort by Province/State 
When this option is enabled, it will sort by Province or State. 

Page break on new Prov/State 
With this option enabled, it will print all patients in the same province or state that are grouped 

together on a separate page. 

Show Patient Address Information 
When selected this will include patient address and telephone number 

Show Extended Patient Information 
When enabled, it will print Nursing Home, Ward, and Postal Code information. 

Show Room and Bed Number 
If a patient is in a Nursing Home, it will include the Bed Number assigned to that patient. 
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Show extended Doctor Information 
When this option is selected it will then include doctors License number, phone number and 

address. 

Checked by 
With this option enabled, it will print a signature line found at the bottom of the report. 

Group by options 
This option allows you to group the report either by Drug (which works well if you have 

selected more than one drug), Patient (works well also if you have selected more than one 

Patient) or by Rx # (which will group in chronological order of dispense by Rx number). 

Page Break 
This allows you to have select items print on separate pages, like the page break on new 

prov/state you may also choose to have a separate page to print for each of the following: 

Nursing Home, Ward, Doctor, Patient or Room. 

Fee for Service 
This gives you the option to include fee for service items or not include them. 

Sort By 
This sort option is only enabled when grouping by patient.  If you sort by Patient are presented 

with the following sort options: 

 Doctor/Home/Ward/Patient 

 Doctor/Home/Ward/Room/Bed 

 Doctor/Patient 

 Home/Doctor/Patient 

 Home/Ward/Doctor/Patient 

 Home/Ward/Patient 

 Home/Ward/Room/Bed 

 Patient 

 Click Preview to preview the report or Print to generate a printout of the report.   3.
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Sample Drug/Doctor Groups Report: 
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Drug Inventory Listing Report 

The Drug Inventory Listing Report prints a list of drugs and their inventory values and the 

details are based on the options you choose.  This report can be run to show a total value of 

inventory in the pharmacy or a line for each drug. 

 To generate this report, go to Reports > Drug > Drug Inventory Listing Report. 1.

 The Drug Inventory Listing Report form will appear.  2.

Selection tab: 

 Click the F2 button next to the Groups field to select the drug groups you want included 
in the report (optional).  

 Click the F2 button next to the Price Group field to select the price groups you want 
included in the report (optional).  

 Click the F2 button next to the Manufacturer field to select the manufacturers you want 
included in the report (optional).  

 Click the F2 button next to the Schedule field to select the drug schedules you want 
included in the report (optional).  

 Click the F2 button next to the Default Vendor field to select the vendors you want 
included in the report (optional).  

 Click the F2 button next to the Tiers field to select the drug tiers you want included in 
the report (optional).  

 Click the F2 button next to the Departments field to select the department groups you 
want included in the report (optional).  
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Options tab: 

 Select Active, Inactive, or Either from the Pack Status section to specify what drug packs 
will be included in the report. 

 Select Less Than Zero, Equal To Zero, and/or Greater Than Zero from the On Hand (per 
pack) section to specify what on-hand values will be included in the report. 

 
 
Include ‘No Inventory Adjustment’ Packs 
This will print all drugs not flagged for inventory adjustment (i.e. during the “Receive “process).  

Show Only Packs not Dispensed Since XXX 
If this option is enabled with a date, it will only include drugs that have not been dispensed 

(filled) by the date entered. 

Print Packs with an Inventory Value Greater than XX 
Enable this option to print all drugs with an inventory value greater than i.e. 500.00 (the report 

would not include drugs with an inventory less than $500.00) 

Show Only Drugs with an Onhand Qty Greater than XX Days Supply 
When enabled, this report will print any values greater or less than the days supply selected. 
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Show Inventory Total Only 
If enabled, only an inventory value will print, not a detailed list. 

Show only Drugs Excluded from Kroll Price Updates 
When enabled, this will present a list of drugs that have been excluded in Kroll price updates.  

This is determined from a flag in the Drug Card ‘Only allow manual price changes’ 

Sort By 
Select the sorting option you desire, i.e. sort by Brand Name: 

Options 2 tab: 

 

Show Quickcode 
Enable this option to print any quickcode assigned to a drug.  When selected there is also an 

option to then sort by quickcode. 

Show Manufacturer 
Enable this option to print the manufacturer of the drug 
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Show Din 
Enable this option to print the drug identification number 

Show Pack Size 
Enable this option to include the drugs pack size  

Show Acquisition Cost 
Enable this option to print the acquisition costs of the drugs  

McKesson 
Enable this option to include the dollar value listed in the McKesson field of the drug card 

KF 
Include this option to include the dollar value listed in the KF field of the drug card. 

ODB BAP 
Enable this option to include the ODB BAP value (Ontario Only) 

ODB MAC 
Enable this option to include the ODB MAC (Ontario Only) 

Show On-Hand Min 
Enable this option to include the min on-hand value (this appears when inventory control is set 

to min/max) 

Show On-Hand Max 
Enable this option to include the max on hand (this appears when inventory control is set to 

min/max) 

Show Days Supply 
Enable this option to include the days’ supply set inventory control (this appears when 

inventory control is set to days’ supply) 

Show Average Daily Usage 
Enable this option to include the average daily usage  

Show Brand and Generic Names 
Enable this option to print the brand and generic names of the drugs  

Show UPC 
Enable this option to include the UPC.  It will include the UPC for each individual drug. 

Show Last Used Date 
Include this option to print the last time the drug was filled in a prescription 
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Show Central Maintenance Flag 
Include this option to print when a drug is centrally maintained. 

Show Blank Line after On-Hand Quantity 
Enable this option to present a line after each on hand value. This is often used to record the 

number of tablets counted during fiscal inventory process. 

 Click Preview to preview the report or Print to generate a printout of the report.   3.

Sample Drug Inventory Listing Report: 

 

Drug Inventory History Report 

The Drug Inventory History Report gives a historical snapshot of drug inventory values based on 

the options you choose. 

 To generate this report, go to Reports > Drug > Drug Inventory History. 1.

 The Drug Inventory History Report form will appear.  2.

Selection tab: 

 Select All active Rxs to generate the report for all currently active Rxs, or Rxs filled to 
specify a Date Range, Starting date, and Ending date.  

 Click the F2 button next to the Manufacturer field to select the drug manufacturers you 
want included in the report (optional).  

 Click the F2 button next to the Drug Groups field to select the drug groups you want 
included in the report (optional).  
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 Click the F2 button next to the Drug Schedule field to select the drug schedules you 
want included in the report (optional).  

 Click the F2 button next to the Drug Pricing Groups field to select the drug pricing 
groups you want included in the report (optional).  

 Click the F2 button next to the Inventory Changes field to select sources of inventory 
change you want included in the report (optional).  
 

 

Selection 2 tab: 

 Click the F2 button next to the Drug Tiers field to select the drug tiers you want included 
in the report (optional).  

 Click the F2 button next to the Drug Departments field to select the drug departments 
you want included in the report (optional).  
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 If you want to generate the report for specific drugs only, click the Add button below 
the Drug field. Perform a drug search for each drug you want included in the report. The 
Remove button will remove individual drugs from the Drug list, and the Clear button 
will remove all drugs from the Drug list. 
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Options tab: 

 

Print each drug pack on a new page 
When selected each pack size will print on a separate page.  

Show DIN 
When enabled, this will include the Drug Identification Number of the drug(s) selected. 

Show Schedule 
When enabled, this option will include the drug schedule. 

Show Reportable 
When enabled, this option will indicate if the reportable flag on the drug card. 

Show Acq Cost 
When enabled, the drug acquisition cost will be included. 

Show Primary Vendor’s Item Number 
When enabled, this will include the drugs primary vendor item number. 
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Show Secondary Vendor’s Item Number 
When enabled, this will include the drugs secondary vendor item number. 

Show dollar value of Units moved 
When enabled, this will include the dollar value of the units moved. 

Show Manufacturer 
Enable this option to include the manufacturer’s short code, for example APX for Apotex. 

Show Brand/Generic Type 
Enable this option to print the type of drug, for example:  Generic Multi Source, Generic Single 

source, Brand, Brand single source, or Brand Multi source. 

Show reason for Inventory Change 
When enabled, this option will print the reason for the change in inventory, at the time you 

made the change. 

 Click Preview to preview the report or Print to generate a printout of the report.   3.

Sample Drug Inventory History Report: 

 

Rx Totals Report 

The Rx Totals Report prints the number of new Rxs, repeat Rxs, total Rxs, and percentage totals 

based on your selected report options.  

 To generate this report, go to Reports > Rx > Rx Totals. 1.

 The Rx Totals Report form will appear.  2.
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Selection tab: 

 Use the Date Range, Starting, and Ending fields to specify a date range.  

 If you want to generate the report for specific patients only, select the Patient button 
and click Add. Perform a patient search for each patient you want included in the 
report.  

 If you want to generate the report for specific nursing homes only, select the Home 
button and click Add. Select the Home and applicable Ward and click OK. Repeat this 
step for each home you want included in the report. 

 Click the F2 button next to the Patient Groups field to select the patient groups you 
want included in the report (optional).  

 Click the F2 button next to the Plans field to select the drug plans you want included in 
the report (optional).  
 

 

Doctor tab: 

 Click the F2 button next to the Doctor Groups field to select the doctor groups you want 
included in the report (optional).  
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 If you want to generate the report for specific prescribers only, click the Add button 
below the Doctor field. Perform a prescriber search for each prescriber you want 
included in the report. The Remove button will remove individual prescribers from the 
Doctor list, and the Clear button will remove all prescribers from the Doctor list. 
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Drug tab: 

 Click the F2 button next to the Drug Price Groups field to select the drug price groups 
you want included in the report (optional).  

 Click the F2 button next to the Drug Groups field to select the drug groups you want 
included in the report (optional).  
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Users tab: 

 Click the F2 button next to the Users field to select users you want included in the 
report (optional).  

 Click the F2 button next to the User Groups field to select user groups you want 
included in the report (optional).  
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Options tab: 

 

The Options tab determines how the report is generated. The most common fields that 

should be enabled are described below: 

Summary Only 
Enable this option to print only a summary of the information you have selected for the report. 

Show Address Information 
Enable this option to include the patient or doctor address.  

Show Percentages of Total 
Enable this option to include the percentage of the total Rxs and the total dollar value. 

Print NH-Inactive Patients 
Enable this option to include inactive Nursing home patients.  
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Print Deceased Patients 
Enable this option to include patients who have been set as deceased within the time frame of 

the report. 

Print Discharged Patients 
Enable this option to include patients who have been discharged from a Nursing Home within 

the time frame of the report. 

Include unfilled Rxs  
Enable this option to include unfilled Rxs in the Rx count of the report. 

Group By 
Enable any one of these options to group together on the report. 

Show 
When All is selected, the report will include All Rxs. When Top XX is selected the report will 

only include the top amount indicated. 

 Click Preview to preview the report or Print to generate a printout of the report.   3.

Sample Rx Totals Report: 
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Price Tree Report 

The Price Tree Report provides all the pricing information setup in the Kroll system, including 

pricing strategies, patient price groups, drug price groups, and the pricing strategies attached to 

the plans.    

 To generate this report, go to Reports > Other > Price Tree Report. 1.

 The Price Tree Report form will appear.  2.

 Place a checkmark next to the items you want included in the report. 
 

 

 Click Preview to preview the report or Print to generate a printout of the report.   3.
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Sample Price Tree Report: 
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Sig Code Listing Report 

The Sig Code Listing Report prints all sig codes set up in your Kroll system. 

 To generate this report, go to Reports > Other > Sig Code Report. 1.

 The Sig Code Listing Report form will appear.  2.

 Select a Language from the dropdown menu. 

 Select a Sort by option. If you select Token, the actual sig code will be printed on the 
report (i.e., BID). If you select Text, the sig code definition will be printed on the report 
(i.e., ‘twice a day’). 

 Place a checkmark next to Show equivalent default language translations on the 
Options tab if you want the report to show the English translation if another language is 
selected on the Selection tab. 

 

 

 Click Preview to preview the report or Print to generate a printout of the report.   3.
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Sample Sig Code Listing Report: 
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Future Usage Report 

The Future Usage Report prints the prescriptions due for refill within a specified time frame. 

This is helpful when preparing medication orders specifically for inventory you do not readily 

keep on hand.  

 To generate this report, go to Reports > Rx > Future Usage Report. 1.

 The Future Usage Report form will appear. 2.

Selection tab: 

 Use the Date Range, Starting, and Ending fields to specify a date range.  

 If you want to generate the report for specific patients only, select the Patient button 
and click Add. Perform a patient search for each patient you want included in the 
report.  

 If you want to generate the report for specific nursing homes only, select the Home 
button and click Add. Select the Home and applicable Ward and click OK. Repeat this 
step for each home you want included in the report. 

 Click the F2 button next to the Patient Groups field to select the patient groups you 
want included in the report (optional).  
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Selection 2 tab: 

 Click the F2 button next to the Plans field to select the drug plans you want included in 
the report (optional).  

 Click the F2 button next to the Drug Groups field to select the drug groups you want 
included in the report (optional).  

 Click the F2 button next to the Manufacturer field to select the manufacturers you want 
included in the report (optional).  

 Click the F2 button next to the Default Vendor field to select the vendors you want 
included in the report (optional).  

 Click the F2 button next to the Drug Departments field to select the drug departments 
you want included in the report (optional).  

 Click the F2 button next to the Patient Auto Refill Status field to select the auto refill 
statuses you want included in the report (optional).  

 Click the F2 button next to the Patient Auto Refill Notification field to select the auto 
refill notification methods you want included in the report (optional).  
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Options tab: 

 Select the parameters you want applied to the report. 
 

 

 Click Preview to preview the report or Print to generate a printout of the report.   3.
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Sample Future Usage Report: 

 

Compliance Label Report 

The Compliance Label Report works in conjunction with the Unit Dose feature found at the 

prescription level. This report allows you to create compliance labels for 7-day pill packs that 

can be affixed onto a Jones Box compliance package, thus replacing the need to print a label for 

every Rx.   

 To generate this report, go to Reports > Patient > Compliance Label. 1.

 The Compliance Label Report form will appear. 2.

Selection tab: 

 The Effective Date field will default to today’s date; however, you may enter the 
effective date of the first package. 

 Enter the number of cycles you want to run the report for in the # of Weeks field. 

 If you want to generate the report for specific patients only, select the Patient button 
and click Add. Perform a patient search for each patient you want included in the 
report.  

 If you want to generate the report for specific nursing homes only, select the Home 
button and click Add. Select the Home and applicable Ward and click OK. Repeat this 
step for each home you want included in the report. 
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 Click the F2 button next to the Patient Groups field to select the patient groups you 
want included in the report (optional).  
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Selection 2 tab: 

 Select All Rxs if you want all Rxs in the patient profile to be included in the report. If you 
want to specify what kind of Rxs are included, select Show only or Exclude and an Rx 
type from the dropdown menus.  

 Place a checkmark next to Include unfills if you want the report to include all Unit Dose 
unfills in the patient profile included in the report. This is especially helpful if you have 
copied to a new number and put a prescription on hold. 

 Place a checkmark next to Include ward stock if you want the report to include Rxs 
marked as ward stock for nursing home patients. 

 Click the F2 button next to the Cards field to select the cards you want included in the 
report (optional). This is used for prescriptions that have been separated by a card 
number.  

 Place a checkmark next to Show only meds filled on and enter a date if you want the 
report to show Rxs filled on a particular date only. 
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Options > General tab: 

 The Pass Time fields are populated by default but can be changed (i.e., Breakfast, Lunch, 
Dinner, Bedtime). 

 Use the Panels section to specify the number of panels you want printed on each page. 
This is particularly important if you have pre-defined compliance labels in a 2, 4, o4 6-
panel layout.  

 Use the X Offset and Y Offset controls to adjust the layout of the report; X Offset 
controls left justification and Y Offset controls vertical alignment.  

 Place a checkmark next to Print Compliance Checklist if you want the report to include a 
check list for packaging the compliance packages. 

 Use the Sort By field to specify how you want the report to be organized. 

 Use the Med Sort field to specify the order in which the compliance label will be 
printed. 
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Options > Header tab: 

 Swap Patient and store info: This option changes the position of the patient and store 
information on the report. 

 Print family doctor: This information comes from the patient card ‘Family Doctor’ field.  
If a family doctor is selected on the patient it will print the family doctor on this report. 

 Replace patient addr. With NH info:  Replaces the patients address with the Nursing 
home information 

 Print effective date: This option prints the date the compliance package is effective 

 Print Card Numbers: This option prints the card numbers assigned in the Unit Dose 
section of the prescription. 

 Print “Page x of y”: This option prints for example page 1 of 1 on the top right corner of 
the report. 

 

 

  



  Kroll Windows 10 User Manual  

 

405 
 

Options > Body tab: 

 The options available on this tab depend on the selected Panel style. The screenshot 
below show the options available for Style 1. Select the options you want included in 
the report. 

 

 

 Click Preview to preview the report or Print to generate a printout of the report.   3.
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Sample Compliance Label Report; 2 panels: 

 

4 panels: 
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6 panels: 

 

Report Discrepancies Explained 

Report discrepancies may occur when multiple systems are used to measure various pharmacy 

metrics. This section explains how to identify and resolve discrepancies, and how to minimize 

these discrepancies in the future.  

Fill Date vs. Adjudication Date 

An Rx has different date components. The fill date is obvious – there is one fill date for an Rx 

and this fill date may have been backdated. However, for each plan associated with the Rx, an 

adjudication date is also available.  

For real time plans, the adjudication date is returned by the third party. For paper plans, the 

adjudication date is typically equal to “today”. A singe Rx could have two or more real time 

third party plans whereby the adjudication date fall under different days and each of those can 
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even be different than the actual fill date. This can be especially true with Rx’s that are 

backdated – the fill date may be set to an earlier day, but the adjudication date is still “today”. 

In most but not all cases, the fill date and the adjudication date will match. It is those 

exceptions that can appear to throw off certain reports. 

When attempting to compare one report against another, always look at the report header – it 

will indicate if the report is based on fill or adjudication date. Never compare a fill date report 

against an adjudication date report. They might match up, but over a large period, they likely 

will not.  

Note that most Rx-based reports use the fill date and most plan-based reports use the 

adjudication date.  Kroll’s Plan Summary Report is a bad one for dates. Retail clients wanted to 

be able to count the number of Rx’s filled for each plan. Therefore, this is effectively an Rx-

based report but broken down by plan, which is usually based on adjudication date. As a single 

Rx can contain multiple plans, we can only count the Rx once. Therefore, the Rx is attributed to 

either the first paying plan or the primary plan (based on a user option). Never use this report 

to compare against other plan-based reports. It will never appear to balance. Note the 

disclaimer on the bottom of this report, “...do not use this report to reconcile your third party 

claims...” 

Reversals and Net Totals 

All of our reports will include explicit “Reversal” amounts and subtract them from the forward 

amounts to provide a “Net Totals” value. Typically, if an Rx is filled and reversed within the 

report date range, it will simply not be included in the totals. When you do see a “Reversal” 

amount, it will be for an Rx that was reversed during the report period but was originally filled 

prior to the report period.  A script that was filled in January and reversed in February will 

appear as a forward claim when printing a report with a January period; will appear as a 

reversal when printing a report with a February period; but will simply not appear at all if 

printing a report that encompasses the entire January/February period. 

Most reports will designate these prior period reversals as “Reversals” or “Prior Day Reversals”, 

all of which should be read as “prior period” reversals. Note that the Adjudication Totals Report 

is different in that it separates reversals into “same day” and “prior day” reversals. Even if this 

report is run for a monthly period, any Rx reversed on a day other than the day it was filled will 

be counted in the “Prior Day” column.  This report works this way as it is intended to match 

exactly with the values returned by real time third party plans when requesting on-line daily 

summaries. If you run this report and compare it against another adjudication date-based 
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report, the reversals count may appear differently as all other Kroll reports are using the entire 

report date range to determine if a reversal fell outside of the entire range. 

Backdates 

Please be aware that if you run a fill date-based report immediately at the completion of a 

period and then at a later date, rerun that report for the same date range, it may not match the 

original report, this is caused by backdates. A backdate is the only way that a report run in the 

past can effectively be changed in the future. 

When reconciling one report against another, especially with fill-based reports, always use 

reports that are printed on the same date and approximately at the same time – never try to 

balance a fill-based report printed at the end of March with another report for the same period 

range but printed at the end of April.  If you have specific reporting periods and an Rx is 

backdated to a previous period, you might want to manually record this Rx on a form so it can 

be properly reconciled.  The Kroll database records the real date (today) when a backdate takes 

place and this is noted on some reports. 

Note that adjudication date-based reports are not affected by backdating. You cannot change 

today’s date. No matter what date you backdate the Rx, today is always the adjudication date 

for this Rx’s plan (unless the real time third party should happen to return a different date such 

as for a script filled after midnight, Eastern Time.) 

Claims Invoice Report 

Net Amount Representation 

For retail purposes, when submitting a claim to a third party insurer, some request that the 

amount billed on the invoice be inclusive of the local patient co-payment amount; others 

require the amount to exclude the co-payment. 

The same two claims are shown below, one with and the other without the co-payment 

amount included in the Net column. 
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By default, the Kroll system will include the co-payment amount in the Net column as most 

third parties request it this way. This Net amount is also shown in the summary sections of this 

report. However, please note that all other Kroll reports always show the amount being billed 

to that third party exclusive of the local patient co-payment. If any one of your third parties are 

set to the default and you attempt to match up the report summary of the Claims Invoice 

report against another report showing the amount billed to the third party, the amounts will 

not appear to match when co-payments are involved! 

If your paper plan(s) require the non-default operation – the net amount should not include the 

co-payment value – please contact Kroll for assistance to set up each third party to use the 

Paper Claim- Net Amount reporting option for each individual plan affected.  Only if all third 

party plans are set to the non-default setting will the report’s grand total Net amount balance 

with other plan-based Kroll reports. As this is unlikely, you will not be able to match the Net 

amount on this report with that on other reports 

Claims Invoice Report Options 

If the Group By option is set to None, all claims will be printed on the same page ordered by fill 

date.  Grouping by patient is used if you require claims for a single patient to appear on a page 

by itself. Group ID will order claims by the patient’s Group ID entered under their third party 

plan.  You should ensure the option Include data for real-time plans is not checked. There are 

other reports that would be more efficient to report real-time plan totals such as the 

Adjudication Totals report.  Also, by using the above option, the report grand totals should then 

match with other Kroll reports that break out paper claims totals assuming there are no tertiary 

plans billed as noted in the next section. 
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Tertiary Plans Imbalances 

For each third party claim, we will provide the various dollar values such as Cost, Mark up, Fees 

and Totals if those items have not been hidden via the options on the report form. However, 

those values are entities of the Rx as a whole. If the same Rx should have another plan that is 

being billed during the same pass of this report, we will also show that plan the same Rx Cost, 

Markup, Fee and Total. For each plan, we will subtotal these amounts and then, for the overall 

report summary, each plan is shown and the grand total for the report is the sum of all these. 

If you had only a single Rx for $100 that was billed to two different plans, both of which are 

included in this report, then the subtotal for each plan will show the $100 Rx total, and one 

claim. However, the report grand total will show each plan’s subtotal and add these together to 

produce a grand total of $200 and 2 claims when in fact, the true total Rx cost is only $100 and 

involves only a single Rx. This anomaly in this report’s grand totals is unavoidable and will make 

the grand total of this report to not balance with other reports. 
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Reconciling 

Reconciling is the process of balancing one report against another. For fill date-based reports, 

you can run the following on the same day for any range and all should balance: 

 Daily/Monthly Totals 

 Rx Breakdown 

 Rx Totals 

 Profit/Loss 
 

When explicitly broken out, always look at the Net amounts. For adjudication date-based 

reports, run the following: 

 Plan Breakdown (do not check any of the “Exclude” options) 

 Adjudication Totals (do not exclude “zero-amount” claims) 

Claims Invoice (best to Exclude items where plan pays 0.00 and NOT Include data for real-time 

plans as this helps to eliminate most tertiary plan billing that will misrepresent the grand totals 

as noted above) 

Plan Breakdown breaks out the online plans versus manually billed plans as well as providing a 

grand total. Adjudication Totals will also provide the same kind of breakdown. Claims Invoice 

report, assuming you have used the options noted above, will show a grand total that should 

match the Manual Plans amount of the two other reports. 

Summary 

Please be aware of the following key points noted above when attempting to reconcile reports: 

 Never compare fill date-based reports with adjudication date-based reports. When in 
doubt, look at the report header that shows which date is being used.   

 Never use the Plan Summary Report in comparing with other reports. 

 Always compare reports printed on the same date – look at the “Printed On” date on 
the report header. 

 Be aware of how previous-period reversals are reported – always use the “Net” amount 
columns when comparing reports. 
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Configuration 

This section explains each of the configuration settings that are available in the Kroll Windows 

application. The configuration screens are accessed via File > Configuration. 

 

Store Level & Head Office Configuration  

At first glance, the Store-level and Head Office-level configuration screens are identical. There 

are some small differences, however, especially for chain locations.  

In the Head Office configuration screen, right click the settings to lock them down. This greys 

out the setting so it cannot be changed at the store level. This is used to enforce business rules 

for chains that want stores to have the same level of access to the settings. 

 

  



  Kroll Windows 10 User Manual  

 

414 
 

General  

The following section describes the configuration settings available on the General tab. 

 

Allow User Colours – Allows the use of custom colour settings within windows.* 

Allows Column Configuration – Allows users to change the appearance of the preset columns 

in the F3, F5 and F7 cards. * 

Enable NH / Batch – Allows users to access to the basic nursing home module, allowing 

customer to use batch filling, as well as plain paper MARs and TMRs.  

Default language – The language that all patient cards will default to. Users have the ability to 

change this to another language within individual patient cards. 

Default country – The country that all patient and doctor cards will default to. Users have the 

ability to change this to another country within individual patient and doctor cards. 
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Next Regular Rx Num – The next prescription number the system will use when filling a regular 

prescription. 

Next Narcotic Rx Num – The next prescription number the system will use when filling a 

narcotic prescription. 

IMS – Used for an interface between companies outside of Kroll. If the store takes part in IMS 

reporting, the account information will be obtained by IMS and entered here.  

Fiscal Week Starts On – A fiscal week is set by a store; the day the store determines their 

financial week starts on.  

HST, PST – Tax- related; most Rxs are non taxable, however veterinary prescriptions are 

taxable, as well as some charges to AR accounts might need to have taxes charged.  

GST Number – The government sales tax number for tax purposes. 

Always Show Scan – Enables the ‘Scan’ button for searches, which saves all changes and 

returns the user to the search screen. 

Prompt to exit when closing fill application – A prompt will appear asking if the user is sure 

they want to exit. As well, users will have the option to print the Day End Label and the 

Network Totals. * 

Use Unit Dose Packaging – Allows uses to choose unit dose packaging on the patients card 

level, we are then able to set types of unit dose, cycles medication is to be filled, as well as set 

up specific strategies for pricing on unit dose prescriptions. * 

Defaults Area Code – Allows users to use a set area code. If this is set and a patient, doctor, 

etc., is added, 7-digit phone numbers will automatically have this area code prefixed.  

Store Information – Your pharmacy’s information; prints on headers and reports. 

Display Window When Services Are Down – Displays a prompt message upon launching Kroll 

indicating that a service is not working. Works in conjunction with the Kroll Reporting Service. 

Use automatic capitalization – Capitalizes the first character of each word when filling out a 

form.* 

Enabled Ctrl-PrintScreen to Print Screenshot – Allows use of the printscreen function.* 
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Patient  

The following section describes the configuration settings available on the Patient tab. 

 

Provincial Plan – Select your province so the F3 Patient card recognizes the correct province.  

Provincial plan label – Displays the default plan name on the F3 - Patient screen. 

Quick Code Label – Allows for F3 - Patient searches using a period followed by a quick code. 

This can also be sued to store reward card numbers. 

Prompt to Create AR account For NH Patients – Allows for prompting when creating an AR 

account for nursing home patients.  

Defaults Delivery Charge – If your pharmacy always charges a certain amount for delivery, 

enter that amount here so when the delivery option is select it will charge the same amount 

each time.  
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The following options allow you to choose how cancelled, inactive, stopped, and expired 

prescriptions are treated in the patient profile: 

 Hide Cancels in All Patients Profiles  

 Hide Cancels in the “Active” (Shift F5) Profile  

 Hide Expired Rx’s in the “Active” (Shift F5) Profile  

 Hide Stopped Rx’s in the “Active” (Shift F5) Profile  

Ignore Provincial Plans In Patient Scan – Excludes provincial plans when searching for a patient. 

Ignore Clinical Plans In Patient Scan – Excludes clinical plans when searching for a patient. 

Prompt for Patient Privacy Consent – Displays a patient privacy consent message when 

entering information in a patient profile; this message will display until the pharmacy has 

recorded whether the patient has given consent to record their information locally and/or on 

the network. Users can choose Unknown, Written, Verbal, or No Consent. Once an option is 

selected the privacy consent message will not display again for that patient.  

Require Patients privacy consent to fill Rx – Forces you to respond to the patient privacy 

consent message before being able to fill a prescription. 

Prompt To Add New or Modified Plans to Existing Rxs – Displays a prompt on the F12 screen 

when a new plan has been entered into the patients profile and has not been used for previous 

Rxs. 

Enable bill to by default on first new alternate address – Automatically bills the patients AR 

account to the alternative address entered on the F3 screen.  

Prompt to print labels when inactivating Rxs from the patient profile or Rx screen – Displays a 

prompt asking if you want to print a label set with inactivating an Rx.  

Default Unit Dose Strategy – If the unit dose feature is enable in File > Configuration > Store > 

General, you can specify what pricing strategy is defaulted when Unit Dose is select on the F3 

screen.  

Initially display the following tabs when showing a patient for retail patients / for nursing 

home patients – Allows you to customize the patient profile for easier accessibility.  

Automatically close auto fill batch if successful – Closes the batch fill window once batch is 

completed.  
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Require patient gender on patient card – Forces you to to add the gender to the patient card 

before it is saved.  

Require postal code on patient’s card – Makes the postal code field on the patient card 

mandatory. 

Prompt for Options after scanning a script from the patient card – Prompts users to specify 

user options when attaching and saving a script image. 

Prompt to complete delivery order – Prompts you to complete a delivery order when 

applicable.  

Prompt to select allergy ingredients when selecting FDB medication names – Prompts  you to 

select allergy ingredients when you select FDB medication names. 

Creatinine Clearance Equation – Select one of the following, depending on how creatinine 

clearance is calculated:  

b) Using body weight  
c) Using IBW (ideal body weight)  
d) Using adjusted body weight  

Include copied patient in original patient’s family – Select Always, Never, or Prompt. Patients 

will be linked from the F3 screen depending on the option selected. 

Quick Code type – Choose which program the quick code represents. 

Show items in network profile from the last [x] months – Allows you to set the amount of 

time, in months, that items will appear network profile window. 

Retain Highlight in Patient Profile – Any Rxs highlighted in the patient profile will remain 

highlighted after you have modified them. 
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Drug  

The following section describes the configuration settings available on the Drug tab. 

 

Fee Per Minute for Mixtures – Allows a default monetary value to be entered that will be 

charged for each minute that is selected to prepare a mixture. This must be entered in cents.  

Don’t Charge Mixture fees for mixtures less than or equal to [x] minutes – Allows you to 

default that any mixtures that take under a certain amount of time to make.  

Percentage of Mix Fee to be added to the upcharge – Allows you hide/mask part of the mix fee 

in the markup of the Rx.  

Prompt when absolute value of On Hand, Min Qty or Max Qty is greater than 500000 – Allows 

you to correct any error in numerical value. If the value in any of the three fields mentioned is 

greater than six digits, you will get an exception error when doing an automatic order.  

There are 5 user cost fields on the drug with in KrollWin. One is automatically assigned as 

purchase price; the next four can be manipulated in the below fields, depending on what 
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vendor is used or provincial pricing these fields can vary. Below is a sample of what you might 

see in an Ontario pharmacy.  

 User Cost 0 Label – McKesson  

 User Cost 1 Label – K&F  

 User Cost 2 Label – ODB (BAP) – This is locked down for Ontario  

 User Cost 3 Label – ODB (MAC) – This is locked down for Ontario  

(BAP = Best available Price MAC = Maximum Allowed Cost)  

OTC Price Group – Allows you to specify a default drug price group to apply to all drugs that are 

classified as an OTC schedule.  

Automatically assign Fake DINS to new drugs / Next DIN to be assigned – Allows you to select 

a DIN range. This is only used when a DIN is not entered. If a drug product has a DIN, ensure it is 

entered in the F5 drug screen.  

Prompt to create DIN Link if Din changes – When a DIN on a drug card changes, this option will 

link the DINs under Edit > Din Links on the F5 screen. This ensures the old DIN references the 

drug when searching for a drug by DIN.  

Show All Drug Pack Tiers in Scan by default – Allows for multiple tiers to be shown when 

searching for drugs in the F5 screen.  

Use Secondary Drug Pack Tiers For Mixture Pricing – Allows the system to choose the 

secondary tier to price mixtures. * 

Check for Interchangeability Preference – Checks the drug database for interchangeable drugs 

in the system.  

Allow changes to mixtures with Rx usage – Allows you to make changes to the mixture card 

with each Rx.  

Default Mixture Time Set – Allows you to default what mixture will automatically be applied to 

the mixture card, depending on Rx quantity  

Only update On Hand Qty when merging a drug pack into a CM drug pack – On hand 

quantities will only be updated if you merge into a centrally maintained drug pack otherwise it 

will not work.* 

  



  Kroll Windows 10 User Manual  

 

421 
 

Rx  

The following section describes the configuration settings available on the Rx tab. 

General  

 

Days Before an Rx expires – This is broken down in five different sections. In some provinces, 

this is automatically populated because the provincial legislation states that an Rx expires after 

a specified number of days. The breakdown is Regular, Narcotic, Controlled, Targeted, and Birth 

Control. Typically, Narcotic, Controlled, and Targeted are set with an expiry.  

Use Narcotic Numbers – Allows for a separate set of number range for narcotic prescriptions.  

Prevent Fill if Rx Expired – Prevents users from filling a prescription if it has expired.  

Force Days Supply – Forces users to enter a days’ supply before completing an Rx.  

Prevent Fill if Rx Stopped – Prevents users from filling a prescription if the Rx has been 

stopped. 
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Blank Days Supply when Quantity changes – Forces you to re-enter the days’ supply when the 

quantity dispensed changes.  

Force Oral / Written – Forces users to specify whether the prescription was oral or written on 

the F12 screen  

Max Refills for Narcs – Specifies how many refills a narcotic Rx are allowed. 

Copy stop date when copying an Rx – When an Rx is copied to a new number, the stop date is 

also copied.  

Allow Fill if Plan is Expired – Allows the pharmacy to  send an Rx to the drug plan even if the 

drug plan is marked as expired on the F3 screen. 

Prevent Fill if Drug expired– Prevent users from filling an Rx if the drug is expired. 

Prevent adding refills to Rxs that have already been refilled – Prevents users from changing 

the authorized quantity on an Rx once the Rx has already been filled.  

OR ONLY allow adding refills on same day as first fill – Allows users to change the authorized 

quantity only on the day the Rx was originally filled. 

Inactivate Old Rx When Copying if New Rx is Unfilled – Inactivates the old Rx and prevents it 

from being filled when a new Rx is brought to the pharmacy.  

Automatically Call Doctor when adding Repeats – Adds the Rx to the ToDo queue so the 

doctor is called when adding repeats to an existing Rx. 

Enable “Returned Recycled Rx Drug Inventory” function – Allows you to return drugs back to 

inventory. This is only available in some provinces. 

Default Product Selection – There are five options that can be selected: None, 1 - Prescribers 

Choice, 2 - Patients Choice, 3 - Pharmacists Choice, 4 - Existing Therapy. The option is defaulted 

to None in Ontario; however, in some provinces this is defaulted to Existing Therapy.  

Show Pack Size form – Displays a prompt message on the F12 screen when there is more the 

one pack size that is active on the drug card that belongs to the same tier.  

Show Search hints in Rx Form –Shows the yellow hint boxes when filling on the F12 screen 

under the patient, drug, and doctor forms.  

Tab Stop on Rx Drug Pack and Doc Location – Hitting the tab button while filling an Rx will cycle 

through fields  and stop on drug pack and doctor location. 
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Clear Ingest Date When refilling or Copying a Methadone Rx – Clears the ingest date when 

filling Methadone prescription so a new ingest date can be entered.  

Create Refill Reminder if Methadone Ingest Dates Skip Days – Creates a refill reminder and a 

refill to do item whenever there is a gap in the patient’s ingest date. 

Use Narcotic numbers and Rx Num prefix for Targeted drugs – Uses narcotic numbers for 

targeted prescriptions.  

Warn 90 days to warn before Rx expires – Defaulted to 90, however this can be changed.  This 

option shows a yellow yield sign on the Rx screen if the prescription is going to expire within the 

allotted number of days.  

Warn if patient is over 65 and is not set up for provincial plan – Displays a warnings when the 

patient is 65 years or older and does not have a provincial plan in the patient profile.  

Display Price Change Notifications – Displays a prompt message if the last Rx had a manual 

price and you need to decide if they want to use the old manual price or the new calculated 

price.  

Warn if a Refill Price changes by more than 5 percent (0 or blank does not warn) – Defaulted 

to 5 %; displays a warning message on the Rx screen when the price of the Rx has changed by 

more than the specified value.  

Check Profile for Drug on New Rx – Defaulted to Yes; scans the patient’s card to see if the 

patient has taken the drug before.  

Only show LUP warning if expiring in less than 120 days – Specifies the expiration range for 

LUP warnings. This defaults to 120 days but can be changed. 

Warn if days supply is less than 0 on refills for provincial plan (0=don’t warn) – Displays a 

warning if the days supply is less than zero on refills for a provincial plan. This is used if the 

provincial government will not accept certain a days’ supplies. 

Toggle the Unit Dose status when the Batch Fill Status changes –By default, this is set to N. 

Other options include Yes and Prompt. (This only works in profiles/batches and can be used to 

stop sending Rxs to Automed/Pacmed.)  

Enable refill reminder by default – Automatically enrolls patients in the refill reminder 

program. 
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Allow Rx Re-activations – Allows users to reactivate an Rx after it has been inactivated. This 

does not work if the Rx has been inactivated because it was copied over to a new number or 

transferred out to another pharmacy.  

Allow Patient/Drug/Doctor/Sig/Mixture changes – Each option can be further broken down by 

selecting Refills or Unfilled Rxs Only. This options allow users to customize what parts of the 

prescription can be changed. 

Allow Sig Changes after Rx Adjudication – Allows users to change the sig code for the Rx even if 

the Rx has already been adjudicated.   

Allow Auth Qty Changes after Rx Adjudication –Allows users to change the authorized quantity 

for the Rx post-adjudication. 

Allow free form Pseudo Din at Rx plan level – Allows user to add a free form DIN and plan 

information at the Rx level.  
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Pricing  

 

If Purch + [x] is greater than Cost + Markup then charge Purchase = [x] % – Enabled by default 

and set to 10%, however this value can be changed. 

Ignore for Provincial Plan – Ignores the configured markup costs for provincial plans. 

Apply the difference to the [Cost] – Select Cost, Markup, or Fee. Automatically adds a 

defaulted markup rolled into the selected area. 

Provincial Plan (Formulary Drugs)  – Allows users to set what plan is pulled for formulary drugs 

when filling the Rx. You can also choose the priority of this plan in relation to the Clinical 

Provincial Plan.  

Clinical Provincial Plan – Allows users to choose a clinical provincial plan and also select its 

priority in relation to the provincial plan. A clinical provincial plan only sends Rx data. 
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If Pat has Prov plan, but Rx is Cash, use Prov Plan Pricing – Uses the provincial pricing strategy 

instead of the cash strategy when dealing with patients that have a provincial plan but are 

paying for a cash Rx. 

Warn if there are lower priced formulary items – Warns users if there is a cheaper 

interchangeable product available.  

Only for provincial plan – Searches for lower priced formulary items for the provincial plan 

only.  

Warn if Gross Profit is less than [x] % – Warns users if the overall gross profit of the 

prescription is less than the selected figured.  

Prevent filling for Negative Gross Profit – Prevents users from filling the Rx if there is a 

negative overall gross profit.  

Allow Copay Adjustment after Adjudication – Allows users to alter the amount being charged 

to the patient by calling up the Rx in modify mode, right clicking on the copay/price amount 

beside cash total, and adjusting the copay amount. Users cannot charge more than the original 

copay returned by the plans.  

Warn if Drug Pack cost lever is older than [x] days – Displays a warning on the Rx warnings tab 

if the drug cost has not been updated since the specified number of days.  

Always use Formulary Cost Level if applicable / Don’t use formulary pricing if product sel. Is 

Patient or Doctor Choice – Changes the cost level pulled from formulary drugs to non-

formulary, allowing users to charge a higher or lower price point. If ‘Don’t use formulary 

pricing…’ is enabled, the formulary pricing strategy is overridden if the patient or doctor is 

selected on the Rx card. 

Prevent Filling if Drug Price Field is Blank – Prevents users from filling an Rx if your Drug Price 

Field is blank on the Rx card. 

When calculating Elston, use BAP + 10 % – Also known as the MI intervention. Allows users to 

apply for the Elston difference if the customer was losing money based on the amount allowed 

by the government is lower than the purchase price of the drug (Ontario only). 
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Prompting  

 

Prompt to use Drug Subs – Displays a prompt on the F12 fill screen asking if you want to use 

the drug sub, when there is a drug sub listed on the F5 drug card.  

Automatically use Drug Subs – Automatically uses the drug sub that is entered on the F5 drug 

screen. 

Use Drug Subs when Batching – Automatically uses the drug sub that is entered on the F5 drug 

card when the prescriptions are being sent through on a batch.  

Prompt if Doctor Refused Repeat When Cancelling Rx – Displaysa prompt on the F12 fill screen 

when cancelling an Rx. If users select Yes to indicate that the doctor has refused the repeat, the 

system will remove the any authorized quantity remaining from prescription.  

Prompt for Comments when Cancelling an RX – Displays a prompt on the F12 fill screen when 

cancelling an Rx asking the user to enter a reason why the Rx is being cancelled.  

Always require comment – Forces users to comply with the above option.  
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Prompt for Comments when Inactivating an Rx – Displays a prompt on the F12 fill screen when 

inactivating an Rx asking the user to enter in a reason why the Rx is being inactivated.  

Always require comment – Forces users to comply with the above option.  

Prompt for Patient Counselling on new Rx – Displays a prompt on the F12 fill screen asking 

users if they want to print the Patient Counselling information on new Rxs.  

Prompt to Batch Nursing home Rxs – Displays a prompt on the F3 patient card asking you to 

enter the patient’s prescriptions in a batch when they are entered into the nursing home.  

Prompt when not dispensing as drug’s Pack Size – Displays a prompt informing users that the 

Rx quantity is not a multiple of the drug packs size, if filling a prescription for drug that has 

dispensed as pack enabled on the F5 drug card and the Rx quantity is not a multiple of the drug 

pack size. Users can continue filling for this Rx quantity or multiply the Rx quantity by the pack 

size. If the user chooses to continue filling for the Rx quantity, they will be given the option to 

Split the quantity between different pack sizes, to switch to a different pack size or ignore.  

Prompt for repeats When Copying an Rx – Displays a prompt asking for the customer to specify 

the number of repeats for a new Rx.  

Prompt to Use Manual Price from Last Refill – Displays a prompt asking you to select one of 

two options when the previous fill had a manually entered price. Users are asked to use either 

the new price or the old price. 

Remove Manual Price for Batched Rxs – Automatically removes the manual price from any 

prescription that batched filled.  

Prompt if Doctor Authorization Received for Narcotic Rxs – Displays a prompt asking if you  

have received the doctor authorization for the narcotic Rx.  

Prompt if there is not enough inventory to fill the Rx – Displays a prompt warning users that 

there is not enough inventory on hand to fill the Rx. Users can choose to owe the patient, split 

the quantity between different pack sizes, switch to a different pack size, or ignore. This only 

functions when the ‘Allow Inventory Adjustment’ setting is enabled (Ordering tab). 

Prevent copying an Inactive Rx to a new number – Prevents users from copying an already 

inactive Rx.  

Show local patient profile on fill – Displays the patient’s local profile when F12 is clicked on the 

Rx screen. 
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Prompt to Copy “Mistake” Rxs to a New Number – Displays a prompt asking users if they want 

to copy mistake Rxs to a new number. 

Show thermal/dot matrix label config on autofill – Displays label configuration options for 

autofilled Rxs. 

Prompt to Print Script Image for 1st Fill of an Unfilled Rx – Prompts users to print the script 

image the first time an unfilled Rx is filled. 

Prompt for AADL Plan Information if SA number is NOT set – Prompt for AADL plan 

information if the Rx lacks a special authorization number. This only applies to certain drugs in 

certain jurisdictions. 

Force ODB Fee Restrictions – Forces ODB fee restrictions on Rxs filled using the ODB plan. 

Prompt if Was Undeliverable when Cancelling an Rx – Displays a prompt asking users if the 

reason they are cancelling an Rx iss because it is undeliverable. 

Prompt to copy workflow packaged info for cancel and refill Rxs – Prompts users to copy 

workflow packaged information for cancelled and refilled Rxs. 

Prompt to copy to new number if refilling an Rx with no repeats – Displays a prompt when 

calling up an Rx with no remaining quantity.  

Automatically Apply Elston for Eligible Products (Do not Prompt) – Automatically applies the 

MI intervention code if the Elston criteria is met. Do not turn this feature on without speaking 

with a supervisor or manager.  

Prompt for ODB Meds Check – Prompts users to print a Meds Check Report when the patient 

has met the criteria.  

Force ODB Fee Restrictions – Forces the ODB fee restriction guidelines when filling a 

prescription for more than two fills each month.  

Drug Programs – The following options should be enabled for stores using a drug information 

interface such as Rx Canada or Access Point.  

 Participate in the Rx Canada/Health Inform Program  

 Participate in the Xalatan Program - NOT USED ANY LONGER  

 Participate in Pharmacy Access Program  

 Use substation directories for Pharmacy Access  

 Enable Rx Canada Program (RxGateway)  
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 Enable Humira Pen & Progress Information  

 

Prompt to Enrol Patients in Refill Reminder or Auto Refill Program – Prompts users to enrol 

patients in the refill reminder or auto refill program with filing an Rx for the patient for the first 

time. 

Prompt to Enrol NH Patients in Refill Reminder or Auto Refill Program – Prompts users to 

enrol nursing home patients in the refill reminder or auto refill program with filing an Rx for the 

patient for the first time. 

Prompt to Enable Rxs for Refill Reminder and Auto Refill Program – Prompts users to enrol 

patients in the refill reminder and auto refill program each time an Rx is filled.  

Enrol Patients for Pickup Notification – Select Yes, No, or Ask. If Yes is selected, patients will be 

automatically enrolled in the pickup notification service; if No is selected, no action is taken; if 

Ask is selected, users will be prompted to ask the patient if they would like to enrol in the 

pickup notification service.  

Enrol NH Patients for Pickup Notification – Select Yes, No, or Ask. If Yes is selected, nursing 

home patients will be automatically enrolled in the pickup notification service; if No is selected, 

no action is taken; if Ask is selected, users will be prompted to ask the nursing home patient if 

they would like to enrol in the pickup notification service. 

Prompt for Due Date on autofill batches – Each Rx in the autofill batch will trigger a prompt for 

priority time. 

Prompt for Tx comment on autofill batches –The system will prompt you to enter a 

Transaction Comment for autofill batches. 

Save Route code from Rx as default value if no default value is set – Select Yes, No, or Ask. If 

Yes is selected, the route code from the Rx will always be used if there is no default; if No is 

selected, no action is taken; if Ask is selected, a prompt will appear asking users if they would 

like to use the route code from the Rx. 

Save Form code from Rx as default value if no default value is set – Select Yes, No, or Ask. If 

Yes is selected, the form code from the Rx will be used if there is no default; if No is selected, no 

action is taken; if Ask is selected, a prompt will appear asking users if they want to use the form 

code from the Rx. 

Automatically Apply Elston For Eligible Products – Bypasses the Elston prompt when the ACC 

and ODB BAP difference is greater than 8%. 
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Prompt for ODB MedsCheck – Prompts users to print the MedsCheck report when filling an Rx. 

Track ODB MedsCheck Rejection Reasons – Prompts users to specify a reason why the patient 

has refused MedsCheck. 

Allow ‘Never Prompt’ for ODB Med Checks – Allows users to forgo prompting for ODB 

MedsCheck. 

Nursing Home  

 

Check for Bad Cycles When Creating a Batch – Scans newly created batches for bad cycles.  

Allow Entering Pass Time Quantities if Unit Dose is Not Checked – Allows users to add pass 

times to the ATN box on the F12 screen if the Unit Dose feature is not being used.  

Exclude Non-Numeric Passtimes from Unit Dose Automatic Dispenser Daily Dosage 

Calculations – Excludes any non-numeric passtimes from the Unit Dose automatic dispenser 

daily dosage calculations. 
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Background Rx Filling 

 

Enable Background Rx Filling – Enables the background Rx filling feature. 

Autofill ToDo Rx in Background – Allows the background Rx service fill all ToDo prescriptions. 

Autofill ToDo Rxs at – Allows users to schedule a time when the background Rx service will 

begin filling ToDo items. 

Autofill ToDo Rxs by User – Allows users to select the user that the service will fill all the items 

as. 

Send ToDo/IVR Success /Failure Mail To – Use the menu to specify where ToDo and IVR 

success/failures are sent. 

Autofill IVR Rxs in Background – Enables the background Rx service to fill all prescriptions 

received by the IVR. 

Autofill IVR Rxs in Background When Store is Open – Tells the background service to only fill 

IVR prescriptions during store operating hours. 
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Autofill IVR Rxs in Background When Store is Closed – Tells the background service to only fill 

IVR prescriptions during hours the store is closed. 

Hold IVR Prescriptions for [x] Seconds Before Auto Filling – Allows users to set the amount of 

time the background Rx service will wait before filling prescriptions that came from the IVR. 

Autofill IVR Rxs by User – Allows users to select the user that the background Rx service uses to 

fill IVR prescriptions. 

Autofill Scheduled NH Batches in background – Forces background Rx service complete NH 

batches. 

Autofill Scheduled NH Batches by User – Allows users to select the user that the background Rx 

service uses to fill NH batches. 

Send NH Batch Success/Failure Mail To – Select the mail group the pharmacy sends NH batch 

success and failure messages to. 

Process Rx Status Updates in the background – Sends a status update query to Alberta Netcare 

S2S when a patient profile is called up.  

Process Profile Queries in the background  – Sends a patient profile query to Alberta Netcare in 

the following scenarios: 

 When viewing the local patient profile it launches the patient profile query.  

 On the Rx filling screen and the patient has not been filled in yet, as soon as the patient 

is filled in it sends the patient profile query in the background.  

 When a user searches for a patient and on the patient card hit F12 to fill a new Rx, it 

launches the patient profile query in the background.  

 When an Rx is being refilled from the start screen it launches the patient profile query in 

the background.  

Minimum query wait time – Specifies how long you are forced to wait for a profile query to 

complete (when applicable) before being allowed to cancel the request in order to proceed 

without viewing the network profile. 

Minimum Process Count – Specifies how many background sessions will be used (more 

sessions can increase speed because more requests can sometimes be processed at the same 

time, but more sessions consume more CPU and memory). 

Process Keep Alive Time – Specifies how long a background session stays running without 

receiving a command before it is terminated (longer means we don’t have to fire up new 
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sessions as often, which can make requests faster, but also means that more memory is being 

consumed during idle time).  

Send failure notifications to – Allows you to choose the mail group that will receive 

notifications. 

Workflow 

 

Workflow Selection Matrix – Allows users to select a preconfigured Workflow Matrix. 

Require Rx Due Date when Filling – Ensures a due date is required when filling a prescription. 

Require Data Re-verification when Modifying – Forces users to review data for any of the 

items selected in the list. 

Default Delivery Route Type – Allows users to specify a default delivery route type. Options are 

Mail Order/Courier, Pickup, and Store Delivery. 
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Enable “Store Delivery” Delivery Route Type – Ensures the delivery route type is available for 

selection in the Rx screen. 

Enable Mail Order/Courier Delivery Route Type – Ensures the delivery route type is available 

for selection in the Rx screen. 

Allow Workflow Queue Filtering – Allows users to filter Rxs by current workflow stage from the 

Workflow screen. 

Decode Barcode when Importing Script Images – Forces the background Rx service to decode 

any barcodes found in documents imported via the document scan utility.  

Prevent Script Image Reference reuse for [x] days – Allows users to set the number of days 

that must laps before a barcode image can be rescanned.  

Require Script Image Reference number for script images – Requires each Rx to have a 

barcode referenced script image. 

Show DIN On Packaging Screen – Shows the DIN on the Packaging workflow screen. 

Prompt for Clinical/Billing when cancelling and refilling an Rx – Prompts users to change billing 

or clinical data before cancelling an Rx. 

Allow Postponing Adjudication – Allows users to postpone adjudication when data 

transmission fails so it can be resent later. 

Require Script Image or reason for no Script Image on New Rxs – Requires that new Rxs have 

attached script images. A reason must be provided when no script image is available. 

Show “detached” script window when filling new Rxs – Superimposes the Rx screen when 

filling a new Rx. 

Use current time of day for Rx start time – The current time will be used as the Rx start time. 

Force Scanning Pickup Bin After Placing Every Rx – Requires users to scan a pickup bin when 

filling an Rx so it becomes associated with that bin. 

Show items picked up in last [x] hours – Allows users to set the number of hours picked up 

items will remain in the picked up window. 

Force Confirmation Scanning of Prescriptions – Requires users to scan the Rx barcode on pick 

up. 
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Track Person Picking Up Rxs – Requires that users ask the person picking up the Rx how they 

are related to the patient. 

Require Address of Person Picking Up Rxs (Rx for Themselves) – Requires users to obtain the 

address of the person picking up the Rx. 

Require Address of Person Picking Up Rxs (Rx for Someone Else) – Requires users to obtain the 

address of the person related to the patient who is picking up the Rx. 

Require Photo I.D . # of Person Picking Up Rxs (Rx for Themselves) – Requires that patients  

provide a photo ID number when picking up a prescription. 

Require Photo I.D . # of Person Picking Up Rxs (Rx for Someone Else) – Requires that persons 

picking up a prescription on behalf of a patient provide a photo ID number. 

Track Relationship When Person Picking Up Rxs for Someone Else – Requires users to specify 

the relationship to the patient when someone other than the patient picks up a prescription. 

Allow Patient Search by Scanning Rx Number Barcode – Allows users to perform a patient 

search by scanning an Rx barcode. 

Allow Pharmacist to Undo a Pickup up to [x] days ago – Allows users to set the maximum 

number of days after pickup a pharmacist can undo a pickup of a prescription. 

Enable Pickup/Undo Pickup from start screen – Enables the F10 pickup button at the start 

screen and the undo pickup option under the Utilities menu. 
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Counselling 

 

Allow editing counseling time – Allows users to edit counseling times when filling an Rx prior to 

saving the record. 

Users Permitted to Finalize Accepted Counseling (Pharmacist/Pharmacist Intern/Pharmacy 

Student/Licensed Technician/Pharmacy Tech Student/Pharmacy Assistant/IT Support) – 

Allows users to specify who can finalize accepted counseling. 

Visible Tabs (Hardcopy  Tab/Rx Tab/Financial Tab/Rx Images Tab/Workflow Tab/Packaging 

Tab) – Allows users to select the tabs that are visible during Rx verification. All tabs are enabled 

by default. 

Require Document Scan to Complete Paper Med Review – Require users to scan the Med 

Review document in order to confirm that you have completed the Med Review step. 

Enable Electronic Med Reviews – Enables electronic (paperless) medication reviews. 

Require Electronic Signature – Requires electronic signatures during the Rx verification steps.  
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On New Rx – Displays the counseling screen for new Rxs. 

Only flag if patient hasn’t had the drug in the last [x] days – Flags patients for automatic 

counselling after the patient has exceeded the set days since they last had the prescribed drug. 

On Refills – Displays the counseling screen for refills. 

On Drug Changes – Displays the counseling screen when a drug is changed. 

Allow User to Turn OFF Automatic Counseling for an Rx – Allows the pharmacist to opt out a 

patient for automatic counselling. 

CeRx 

 

Copy Sig Code when creating local Rxs from network Orders – Uses the Sig from the network 

order when a local Rx is created. 
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FDB 

FDB refers to the First Data Bank. First Data Bank provides Kroll with a database that has allergy 

and interaction checking, drug information leaflets and much more. We will explore each 

individual tab in the following pages.  

 

Drug-Drug Interactions – Checks for interactions between drugs.  

Max SL – Set the maximum severity level. Level 3 indicates low severity; level 1 indicates high 

severity. 

Drug/Disease Contraindications – Checks to ensure the prescribed drug will not adversely 

affect the patient’s existing medical conditions. 

Drug Side Effects – Displays any applicable drug side effects.  

Duplicate Therapy – Warns users if the patient is taking more than one of the same type of 

drug for the same therapy.  
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Allergy Checking – Checks for patient allergies when filling an Rx. 

Cross Sensitivity Check – Checks for patient drug sensitivity when filling an Rx. 

Ingredient Allergy Checking – Checks for patient drug ingredient allergies when filing an Rx. 

Check Interactions – Checks for drug interactions when filling an Rx. 

Only Check for New Rxs – Checks for drug interactions when filling new Rxs only. 

Don’t Check Rxs older than [x] Days – Specify the maximum number of days that can pass 

before Rxs are no longer checked. 

On Rx Analysis Force Confirmation – Requires users to enter their login credentials before 

completing an Rx. 
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Adjudication  

The following section describes the configuration settings available on the Adjudication tab. 

General  

 

Use the Cost/Markup/Fee parameters (on the Retail/Nursing Home tabs) if there are other 

plans – Uses the cost/markup/fee parameters set on the Retail and Nursing Home tabs if other 

drug plans are present. 

Prompt to rollback Copay for Last Rx Plan – Automatically sends the copay from the primary 

plan to the next plan, allowing users to adjust the final copay once the Rx has been sent 

through all plans.  

Always Prompt to rollback Copay for Provincial Plan – Displays a prompt asking if users want 

to waive part or all of the copay amount before it is sent to the next plan. 

 When rolling back Cost, Markup Fee and Copay Adjustments – Allows users to specify the 

sequence in which rollbacks are applied. 
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Automatically switch Routes when they are down – Marks the primary route as down in File > 

Configuration > Adjudication and automatically switches to the secondary route when the route 

is down.  

Allow marking fiscal plans down if there is only one route – Allows users to mark any financial 

plans down if only one route is available for adjudication. 

Allow marking clinical plans down if there is only one route – Allows users to mark any clinical 

plans down if only one route is available for adjudication. 

Ignore these warning Messages when batching DH, DI, and DJ (F2) – Ignores interventions 

when completing a batch. 

Ignore batched CeRx Issues with a severity less than or equal to – Select high, medium, or low. 

If an option is not chosen then the system will force users to correct any severity level that is 

returned during batching.  

Ignore batched NECST Issues with a severity less than or equal to – Select high, medium, or 

low. If an option is not chosen then the system will force users to correct any severity level that 

is returned during batching.  

Ignore these NECST warning Messages when batching DH, DI, and DJ (F2) – Ignores NECST 

warnings when completing a batch. 
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Retail/Nursing Home  

The Retail and Nursing Home tabs contain the same settings. Users must configure both tabs, 

depending on the settings that apply to the pharmacy. Users can select different values for 

retail Rxs and nursing home Rxs; the selected parameters will apply regardless of whether Rxs 

are filled manually or in a batch.  

 

If the Cost + Markup difference is < = $ 0 then discount the difference (0 or blank means Do 

Not Discount) – Differences between these two values will be passed on to the patient. The 

value must match the less than value in Fee + Mixfee Difference section 

If the Cost + Markup difference is > = $0.01 then force pharmacist to review (0 or blank 

always means pass the difference on to the patient) – Ensures any difference greater or equal 

to the amount specified will prompt the pharmacist to review the prescription. This is by 

default set to $0.01 . 
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If the Fee + MixFee difference is < = $ [x] then discount the difference (0 or blank means Do 

Not Discount) – Ensures differences between these two values will be passed on to the patient. 

The value must match the less than value for Cost + Markup section.  

If the Fee+MixFee difference is > = $[x] then force pharmacist to review (0 or blank means 

always pass the difference on to the patient) – The value must match the greater than value 

entered for the Cost + Markup section.  

Automatically Credit Copays if less than or equal to $[x] – Automatically waives the credit 

copay value to zero if the amount returned is equal or less than the preset amount.  

For CASH Rxs, only charge a fee for the first Refill of the month (for batched Rxs only) – Only 

applies to nursing home Rxs that are filled in a batch; allows users to fill the Rx multiple times 

throughout the month but only charges the fee to the first fill only.  
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Labels  

The following section describes the configuration settings available on the Labels tab. 

General  

The General tab allows users to configure the label settings for retail and nursing home Rxs.The 

Advanced settings allow users to define additional label mappings and create new stocks. This 

tab also contains controls for adjusting the printer offsets. 

 

Regular Labels (retail/nursing home) – Select the label types that the settings enabled on the 

Labels > General tab will ne applied to. 

Print Labels – Labels will be printed for generated for each Rx.  

Preview Labels – Displays a label preview before it is printed.  

Print laser labels on unit dose Rxs – Prints a laser label when unit dose is selected on the Rx.  
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Print labels for “not dispensed” Rxs – Select Always, Never, or Prompt. This controls whether 

labels are printed for not dispensed Rxs. 

Print labels for cancelled Rxs – Select Always, Never, or Prompt. This controls whether labels 

are printed for cancelled Rxs. 

Print labels for unfilled Rxs – Select Always, Never, or Prompt. This controls whether labels are 

printed for unfilled Rxs. 

Print labels for unfilled cancels – Select Always, Never, or Prompt. This controls whether labels 

are printed for unfilled, cancelled Rxs. 

First drug name – Select Brand, Description, Equivalent to, Generic, or None. This determines 

what prints as the first drug name on the vial label. 

Second drug name – Select Brand, Description, Equivalent to, Generic, or None. This 

determines what prints as the second drug name on the vial label. 

Print in colour – Allows for colour printing.  

Show profile and label reprints as filled – Shows a status of ‘filled’, rather than ‘reprint’ on the 

hardcopy. 

Bold first Drug Name – Bolds the first drug name on the vial label.  

Prefix second drug name – Prefixes the second drug name to the first drug name. 

Print Salutation with patient’s name – The salutation set on the F3 - Patient screen will show in 

the vial label. 

Print * after Rx num for robotic interface – If an Rx is filled by a robotic interface, pill counter, 

etc., the system with place an asterisks after the Rx number, which indicates that it is being 

filled by the machine.  

Switch Receipt and Counselling Labels – Switches the positions of the receipt and counseling 

labels.   

Show thermal label configuration on print – Displays a label configuration screen before labels 

are printed. 

Adjust printer label offsets – Allows users to adjust the printer offsets. 

The following options allow you to adjust just particular parts of the label: 
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 Warning label Left [x] mm  

 Dot Matrix label Left [x] mm  

 Hardcopy Top offset [x] mm  

 X Offset for Bottom Headers [x] mm – X offsite moves the label left (negative number) 

or right (positive number).  

 Y Offset for Bottom Labels [x] mm – Y offset moves the labels up (negative number) or 

down (positive number). 

Header – Enter the pharmacy’s address information as it should appear on laser labels.  

Print headers on NH laser Labels – Forces the system to print the free form header that is 

entered on vial label, receipt, and counselling position of the nursing home laser label.  

Print heads only on NH laser receipt –The free form header will only print on the nursing home 

laser label receipt.  

Print header only on NH laser receipt –The header will print only on receipts generated for 

nursing homes on a laser printer. 

Print headers on Ontario Standard labels –The header will print on Ontario Standard Labels. 

Print header on lower right label – The free form header will print on the wallet card.  

For Patient “label header” comments replace – Select None, Line 1, Line 2, and Line 3 or All.  
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Vial Label  

Please keep in mind that the options available on this tab will change depending on whether 

laser labels, dot matrix labels, or thermal printer labels are configured on the General tab. The 

options available for laser labels are described below. 

 

Print Original Rx number – Forces the system to print the original Rx number for each 

prescription filled in a chain.  

Print Pharmacist initials – Pharmacist initials will print on the vial label  

Print manual drug expiry (don’t use expiry dates) – A blank expiry label will print on the 

bottom of the vial label allowing you to enter a free form expiry date.  

Print Drug DIN (don’t use PDIN) – The DIN will print on the vial label, instead of the pseudo DIN 

that was used for billing.  

Print refills on label if zero – Prints refills as zero if the patient does not have repeats left on the 

prescription.  
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Print refill expiry – Prints the refill expiry date. 

Print qty remaining instead of refills – Prints the actual pill count in the refill position instead of 

the number of refills left.  

Print refill info on unlimited refills – Prints unlimited refills as well as the expiry date on vial 

label  

Bold Sig – Bolds the sig line on the vial label.  

Print native language if printing foreign sig – Prints the native language on the hardcopy if 

printing foreign sigs.  

Print English Child warning – Prints a warning along the left hand side of the vial label stating to 

keep out of reach of children in English.  

Print French Child warning – Prints a warning along the left hand side of the vial label stating to 

keep out of reach of children in French.  

Print narrow vials (my labels have pre-printed child warnings) – Applies to provinces where 

child warnings must be printed. This provides a narrow label to make room for the pre-printed 

child warning.  

Print watermark for Unfills – Prints a watermark going diagonally across the label that states 

unfilled. 

Watermark darkness [x]% – Allows you to adjust the darkness of the watermark.  

Print DOS – style vials –Allows you to print DOS style vial labels, which changes the look of the 

current vial label set up to the old style.  

Print vial labels for unfills – Allows you to have vial labels print for unfilled prescription. If 

disabled, system defaults to printing a hardcopy but no vial label.  

Always print 2 vial labels – Prints vial labels in sets of two. 

Always print on all vials on each page – All vial labels will be printed on for each label set; none 

will be left blank. 

Print pastimes on NH Laser Labels – Prints the passtime set on a regular label set if the patient 

is in a nursing home.  
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Use NH style vials for NH patients – Uses nursing home-style vial labels for nursing home 

patients. 

Print home name – Prints the home name on nursing home labels. 

Print ward name – Prints the ward name on nursing home labels. 

Print room – Prints the room number on nursing home labels. 

Print bed – Prints the bed number on nursing home labels. 

Print DIN – Prints the DIN on nursing home labels. 

 

Print Methadone label on vial 2 – A methadone label will print for methadone prescriptions so 

the signatures of the patient and the witness can be recorded. This prints on the second vial 

label.  

Print Pickup Signature label for Monitored Drugs – A pickup signature label will print for 

monitored drugs.  

Watermark darkness [x]% – Set the watermark opacity by percentile increments.  
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Hardcopy  

Please keep in mind that the options available on this tab will change depending on whether 

laser labels, dot matrix labels, or thermal printer labels are configured on the General tab. The 

options available for laser labels are described below. 

 

Hardcopy TxNum Prefix Rx – Enter the prefix that should appear before the Rx number on the 

vial label. This is typically set to ‘Rx’, although some provinces set this to ‘Tx’. 

Print store header on laser hardcopy – Prints the header that is configured in the Labels > 

General tab on the laser hardcopy. 

Printer watermark for Unfilled Rxs – Prints a watermark on the hardcopy for unfilled Rxs.  

Print transaction number on bottom of hardcopy – Prints the Tx number on the bottom of the 

hardcopy.  

Print fill time – Prints the time at which the Rx was filled.  

Print patient gender – Prints the patient’s gender on the hardcopy.  
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Print patient allergy and conditions – Prints any allergies or conditions that have been entered 

in the patient profile. 

Print patient DOB on thermal labels – Prints the patient’s date of birth on the thermal label.  

Print patient Quick Code (laser) – Prints the quick code that if one has been entered on the 

patient profile.  

Always print Brand and Generic drug names – Prints the drug’s brand name and generic name 

on the hardcopy.  

Print pack size and cost – Prints the pack size and the cost of the pack on the hardcopy.  

Print lot and drug expiry date – Prints the lot and expiry date that is entered on the F5 - Drug 

screen.  

Print pseudo DIN (dot matrix and thermal) – Prints the pseudo DIN in the DIN field on thermal 

and dot matrix labels. 

Print plan-specific DINs for mixtures – Prints the DIN that is entered on the Plans tab on the F5 

- Mixture screen.  

Show default vendors item number – The default vendor item number entered on the 

Ordering tab on the F5 - Drug screen will be printed on the hardcopy.  

Print drug location – Prints the location where the drug can be found, if the location is entered 

on the F5 - Drug screen.  

Print NH room –The patient’s nursing home room number will print on the hardcopy. 

Do not print hardcopy when electronic signatures enabled – Hardcopies will be disabled when 

a signature pad is configured. 

Include due date in Rx messages – The due date for the Rx will appear on the hardcopy. 

Print refill ‘days early/late’ message – Prints a message letting the pharmacist know if the refill 

is early or late.  

Print native language sig when printing foreign sig – Prints the sig on the hardcopy in the 

native language, even when printing a foreign language sig. 

Replace total with patient pays on dot matrix/ thermal labels –The patient pays amount will 

be printed on the label instead of the total cost. 
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Print patient, drug and doctor hardcopy comments – Prints the comments entered on F3, F5 or 

F7 screens when a comment is entered.  

On new Rxs – Prints the counselling message checkbox on the hardcopy for new Rxs.  

On refill Rxs – Prints the counselling message checkbox on the hardcopy for refill Rxs.  

Print hardcopy on second vial label – The hardcopy will print on the second vial label instead of 

in the usual position.  

Print watermark for cancelled Rxs – A watermark stating “cancelled” will print diagonally 

across the hardcopy. 

Print watermark for reprint Rxs – A watermark stating “reprint” will print diagonally across the 

hardcopy. 

Print sig status on hardcopy – “New” will print in front of the sig if it has been changed since 

the original fill.  

Print Gross Profit on hardcopy –The total gross profit will print on the hardcopy.  

Print NH Code – The nursing home code will print on the hardcopy. 

Print MedType – The MedType will print on the hardcopy. 

Print Ward Short Form Code – The Ward Short Form Code will print on the hardcopy. 

Print Pass Times – The pass times will print on the hardcopy. 

Hardcopy Rx Comment Priorities – Click to select the order in which Rx comments are printed. 
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Receipt  

 

Print “Official Receipt” at top – Prints ‘Official Receipt’ across the top of the laser receipt.  

Print initials – The initials of the user who filled the prescription will print on the receipt. 

Print patient address – Prints the address entered on the F3 - Patient screen on the hardcopy.  

Print Drug DIN (don’t use Pseudo DIN) – Prints the DIN on the receipt. This setting is required if 

the patient is using the official receipt to submit to a drug plan.  

Print doctor license – Prints the doctors license number that is entered on the F7 - Doctor 

screen.  

Print cost breakdown – Prints the markup and mix fees. 

Print gross and discount cost – Prints the cost of the drug and the discounted amount.  

Print gross and discount markup – Prints the gross and discount markup on the receipt. 
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Print gross and discount fee – Prints the gross cost of the Rx and the discounted amount.  

Print discounted amounts – Prints any discounted amount on the receipt.  

Print USD indicator on receipt and delivery invoice – Prints a USD indicator (U.S. dollars) on the 

receipt and invoice. 

Print days supply – Prints the days supply quantity on the receipt. 

Print third party breakdown – Prints the amounts that third party has paid on the receipt.  

Prompt to print third party messages – Prompts users to print third party messages on the 

receipt. 

Print owed messages of regular label set – Prints the owed amount on the bottom of the 

receipt, when an owing label is selected of the F12 screen.  

Print signature line – Prints a signature line at the bottom of the receipt for the pharmacist to 

sign.  

Print electronic signature from workflow action – Prints the pharmacist’s signature on the 

receipt when signed using the electronic signature pad.  

Print receipt on additional labels – Receipts will print when additional labels are printed.  

Receipt Free Form – Enter any additional information (store hours, specials, etc.) that you want 

printed on the bottom of the labels.  
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Other Labels  

Please keep in mind that the options available on this tab will change depending on whether 

laser labels, dot matrix labels, or thermal printer labels are configured on the General tab. The 

options available for laser labels are described below. 

 

Print Rx range on daily totals – Prints the Rx regular and narcotic range used for the day on the 

end of day totals.  

Print warning label to indicate no refills remaining – A warning (auxiliary) label will print 

warning that the patient no longer has repeats remaining.  

Print mixture component breakdown label – Prints a mixture breakdown when an Rx is printed 

and is a mixture.  

Show mixture components costs – The cost of each component in a mixture will be shown on 

the Drug Info Label. 
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Print Provincial card expiry label on dot matrix set – Prints the expiry date that is entered on 

the F3 card. This will only print on a dot matrix label set.  

Print free form labels to dot matrix printer – All free form labels will be sent to a configured 

dot matrix printer. 

Print user labels to dot matrix printer – All user labels will be sent to a configured dot matrix 

printer. 

Print “Controlled Partial Fill Pickup” label – The Controlled Partial Fill Pickup label will be 

printed after partially filling an Rx for a controlled drug.  

Laser Labels  

 

Print Tx label – Prints a transaction label on the label set. 

Print pictures – Prints any applicable images on the label. 

Print description with drug image – An image of the drug will print alongside the description on 

the label set.  

Print patient dialogue label – The patient dialog label will print on the label set. This label has a 

checklist to ensure all relevant topics are explained to the patient. 

Print patient cost difference label – The patient pays amount will print on the label set. 

Print Ontario-compliant counselling checklist – A counselling checklist will be printed on the 

hardcopy label.  

Audit Tracking position – Allows users to choose where audit/tracking information is located. 

Select Tx1, Tx2, or Hardcopy.  
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Audit / Tracking Label Box Wording – Enter the wording for each box as it should appear on 

the Audit/Tracking label. 

Print counselling on right margin for… – Select New Rxs and/or Repeat Rxs. Counseling 

information will print in the right margin for the selected Rx type(s). 

Print hardcopy comments on… – Select Allergies/Conditions label and/or Drug information 

label. Hardcopy comments will print on the selected label(s). 

Front card for warning label – Allows users to choose font cards for compatibility with different 

interfaces. 

Compliance label location – Select In Place of Counseling, On Second Label Set, or On Two 

Labels Above Counseling. This determines the compliance label location. 

Dose checking label location – Select Allergies/Conditions Label, Right Margin, Second Vial 

Label, or None. This determines where dose checking appears on the laser label. 

Drug message location – Select Add to patient counseling, Add to receipt, Replace patient 

counseling, or None. This determines where drug messages appear on the laser label. 

Workflow messages location – Select Append allergies/conditions, Append to hardcopy, 

Replace allergies/conditions, Replace patient counseling, Replace right-middle, Replace second 

vial, or None. This determines where workflow messages appear on the laser label. 
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Profile/Wallet Card  

 

Print Wallet card by default (can change on Rx) – Prints a wallet-sized patient profile on the 

bottom right hand side of laser label set.  

Don’t Print small profile when Print Wallet Card is off (laser only) – The patient profile will 

never print on the laser set, even if the option is select on the F12 screen.  

Print generic drug name – The generic name of the drug will print on the wallet card. 

Print Sig – Prints the Rx sig on the wallet card.  

Print refills remaining – Prints the number of remaining repeats per Rx on the wallet card.  

Include inactive Rxs – Inactive Rxs in the patient’s profile will print on the wallet card. 

Include Unfill Rxs – Prints any Unfilled Rxs from the patients profile on the wallet card. 
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Delivery/Privacy Label  

 

Always print delivery label – Prints a delivery label each time an Rx is filled.  

Print phone number – Prints the phone number listed as the first phone number in the patient 

profile.  

Print Rx number – Prints the Rx number on the delivery label.  

Print copay – Prints the copay on the delivery label. 

Print pending medication review notification – A pending medication review will print. 

Print signature line – Prints on the delivery label.  

Position – Use the privacy options to specify what items are printed on the privacy label: 

 Print Phone number  

 Print Patient Pays  

 Print third party amount  

 Print signature line  

Position – Allows users to control whether delivery/privacy labels are printed on the Right 

Bottom, Right Middle, Second Vial Label, or None. 
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Coupon  

The Coupon tab allows users to specify the X and Y offset, width, and height of printed 

coupons. Use the Load button to import a coupon image and adjust the parameters so it prints 

correctly. Note that the dollar value is set b y the image and cannot be changed without loading 

a new image. 

 

Print coupon –The coupon will print for New, Refill Rxs, or both. Use the Value (% of Rx price) 

field to set a value and the Minimum value field to set a minimum value.  

Override using plan settings based on – Select the criteria overrides using plan settings will be 

based on. Options include? 

 First non due plan  

 First override  

 First paying plan  

 First plan  

 Highest coupon value  

 Highest paying plan  

 Lowest coupon value  

 None 
 

Message – Enter any free-form text to be printed on the coupon. 
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Nursing Home  

 

Only Print regular label set for NH Rxs if regular labels > 0 – Prints a regular label set if NH 

regular labels are set to greater than zero on the F12 fill screen.  

Print full label set for NH Rxs (when print a regular label set) – Prints a full regular label set 

when print regular labels  

Print receipt for NH Rxs when patient pays > 0 – Prints a laser receipt when a nursing home 

patient pays is greater than zero.  

Always print receipt for NH Rxs (when printing a regular label set) – Prints a receipt when a 

full laser label set is printing.  

Print receipt with Ontario Standard labels – A receipt will be printed with the Ontario Standard 

Labels. 

Print 2 Tx labels for NH Rxs (when printing regular label set) – Prints 2 Tx labels when printing 

a full label set.  
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Print NH info on Allergies/Conditions Label – Prints the allergies and conditions when printing 

a laser label set.  

Print ManRex labels for unfilled Rxs – Prints a ManRex label for unfilled Rxs when ManRex 

labels are selected as label set for nursing home on file configuration label, general.  

Print pass times on ManRex labels – Prints the pastimes that are set on the F12 fill screen 

under ALT N, when ManRex labels are set for nursing home on file configuration label, general.  

Print Rx expiry on ManRex Labels – Prints the prescriptions expiry date on the ManRex label, as 

long as ManRex labels are set for nursing home in File > Configuration > Labels > General.  

ManRex label header – Enter the pharmacy’s address information as it should appear on 

ManRex labels. 
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Bar Codes  

The Bar Codes tab allows users to set up barcodes. Before doing so, users must know what type 

of system they are using, as not all POS systems are interfaced with Kroll. Once the barcode 

type has been selected, users can choose where they want the barcode to print. Typically, users 

choose to place barcodes on receipts and on privacy labels.  

 

The 2D Bar Coding section allows you to choose where the 2D barcodes will print.  
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Reports  

The following section describes the configuration settings available on the Reports tab. 

General  

 

Global Store Logo – For pharmacies who have their own store logo, they can create save a jpg 

file of their logo on the hard drive and if load it in this area it will print on any reports where the 

user has enabled an option to ‘print store logo’.  

Insert Row Breaks into Report – Adds blank space between rows on any given report.  

Reports Shading 0 % – Shading presents a visual shadow within the data to help separate the 

data so it is more visual and easier to read.  

Include cancelled Rxs on MAR/TMR forms – Cancelled Rxs will appear on Mar and TMR forms.  

Include cancelled Rxs on compliance reports – Cancelled Rxs will appear on the compliance 

reports.  
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Exclude full suspension period Rxs on MAR/TMR forms – Excludes full suspension period Rxs 

from MAR/TMR forms.  

Always show masked Credit Card Numbers – Masks credit card numbers on reports, etc. when 

credit card information is entered. 

Send scheduled report failure notifications to – Select which user on the Kroll mailing list will 

receive failure notifications.  

Kroll Care  

Kroll Care is also known as the patient information leaflet. This leaflet explains what the drug is 

used for, how the patient should take the medication, precautions, side effects, and so on.  

 

Automatic Kroll Care On New Rx – A Kroll Care leaflet will print for each new Rx.  

Only print if patient hasn’t had the drug in the last [x] days – A Kroll Care leaflet will print only 

if the patient has not had the medication in a specific amount of days (whatever value the user 

sets.)  
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Prompt to print for retail Rxs – Prompts to print a Kroll Care leaflet if you are filling for retail 

(non-Nursing Home Rx).  

On Refills – Prompts to print a Kroll Care leaflet if it is a refill Rx.  

Print for NH Rxs – Prompts to print a Kroll Care leaflet for Nursing Home Rxs (not commonly 

enabled)  

Print for Unit Dose Rxs – Prompts to print a Kroll Care leaflet for unit dose or compliance pack 

Rxs.  

Print for Autofill – Prompts to print a Kroll Care leaflet for any prescriptions that are 

automatically filled in a retail batch.  

Print Store name – Prompts to print the pharmacy name at the top of the Kroll Care leaflet.  

Print Store logo – Prompts to print the store logo at the top of the Kroll Care leaflet. 

Print drug picture – Prompts to print t a picture of the drug at the top of the Kroll Care leaflet. 

Print sig – Prompts to print the doctor’s directions at the top of the Kroll Care leaflet.  

Print pharmacists signature line – Prompts to print a signature line at the top of the Kroll Care 

leaflet. 

Hide patient last name – The patient’s last name will not print at the top of the Kroll Care 

leaflet.  

Hide entire patient name – The patient’s last name will not print the patient’s first or last name 

at the top of the Kroll Care leaflet. 

Duplex (if supported) – Duplex is an option that comes with some printers allowing the 

printout to print double sided.  

Print Rx Number instead of patient name – The patient’s name will print instead of the Rx 

number on the Kroll Care leaflet. 

The Offset settings are set to 0 mm by default but can be edited. These settings allow users to 

control the printing parameters. 

 Top Offset  

 Left Offset  

 Top Offset for Additional Pages  
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Delivery  

The options selected for the delivery order report will vary depending on the needs of the 

pharmacy.  

 

Print Delivery Order Report – Select Always, Never, or Only if > than $0.00. This determines 

when the Delivery Order Report is generated. 

Print Delivery Invoice Report – Select Always, Never, or Only if > than $0.00. This determines 

when the Delivery Invoice Report is generated. 

Print Credit Card on Delivery Order Report – Prints the patient’s credit card number on the 

Delivery Order Report.  

Print Credit Card on Delivery Invoice Report – Prints the patient’s credit card number on the 

Delivery Invoice Report.  

Print Drug Information on Delivery Order Report – Prints the drug name and drug information  

on the Delivery Order Report.  
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Print Store Logo on Delivery Invoice – Prints the store logo that is saved as the ‘global store 

logo’ in the General tab.  

Mark Delivery Order Shipped On Print – Marks the delivery order as ‘shipped’ upon printing 

the report. 

Delivery order Barcode – Select Delivery order number to print the delivery order number as 

the barcode number on the report, or None to print no number. 

Delivery Order Export – Creates a file which contains the information from the delivery order 

report.  

Delivery Order Export Folder – Select the folder where delivery order exports are saved. It is 

recommended that a shared network folder is used. 

Edit – Allows users to edit the information that will be printed on the Delivery Order Report.  
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Security  

The Security tab allows users to configure the level of security within the application. The 

selected options will vary according to store, chain, and province.  

 

Require Passwords – Requires that users enter a password when logging into Kroll. 

Min Password Length – The minimum number of characters required when a user creates a 

password.  

Min Password Age – The number of days that must pass before a password can be reused. 

Force Password Change after [x] Days – The number of days passwords remain valid. If this 

option is blank the system will not prompt to change a password.  

Prevent usage of [x] previously used passwords – The number of previously used of passwords 

that cannot be reused. 
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Disable User After [x] Failed Attempts (minimum 3) – The number of times a user can 

unsuccessfully enter a password before that user is disabled.  

Force password change for new user – Prompts the user to change their password the first 

time they log in, this is on by default. 

Enforce complex passwords – Allows users to choose the amount of numbers and symbols 

required to create a password.  

Blank Screen After [x] Minutes – The number of minutes of inactivity that must pass before the 

screen blanks out. 

Requires User ID for Every Rx – Requires that users enter their login credentials before filling 

an Rx. 

Require Password after no Activity in [x] Minutes – When the session is unattended for the 

specified number of minutes, users will be asked to enter their login credentials before the 

session can be resumed. 

Logging – Logs each of the functions users perform.  

Log Rx Reprints – Creates a log when an Rx is reprinted. 

Log Rx Modifies – Creates a log when an Rx is modified. 

Log On Hand Changes – Logs when users make changes to the on-hand quantity. 

Require user Login – Requires users to enter their login credentials before changing on-hand 

values. 

Only Log for Drug Schedules (blank logs all schedules) – Select the drug schedule(s) that will be 

logged.  

Log AR Modifications – Creates a log when AR settings are modified. 

Log AR Deletions – Creates a log when AR accounts are deleted. 

Log if Refill is [x]% Early or Late (0 does not log) – Creates a log when refills are early or late by 

the specified percentage. 

Log user information access and changes – Creates a log when user accounts are accessed and 

modified. 
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Restrict and Log running of reports for all patients – Creates a log and requires login 

credentials when reports are run for all patients. 

Log Handled Exceptions Until [dd/mm/yyyy] – The log handled exceptions expiration date. 

Interfaces  

The following section describes the configuration settings available on the Interfaces tab. 

POS/Robotic  

In this tab is where POS systems, Pill Counters, Pacmed, Automed etc are set up.  

 

The POS Interface section allows users to select an Interface Type from a drop down menu. 

There are 11 different interfaces to choose from. There is also a Transfer Type drop down 

menu which allows users to choose in which method files will be transferred. There are 3 

options which are FTP, SFTP, and Logical Drive. 
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Robotic Interface section allows users to select an Interface Type from a drop down menu. 

There are 14 different interfaces to choose from. There is also a Transfer Type drop down 

menu which allows users to choose in which method files will be transferred. There a few 

different options for Robotic Interfaces that are limited by which interface type the user have 

chosen. The types are FTP, DCOM, Winsock, and Logical drive. Users can also choose if they 

want the Robotic Interface to ignore filling NH or Unit Dose Rxs. Users can also have robotic 

interface data logged.  

Central Fill  

The Central Fill tab only appears if the Central Fill module had been enabled in the Kroll 

Configuration Parameters screen. Note that this is a billable module. The purpose of Central Fill 

is to allow users to process an Rx at one location and send it to Central Fill where it gets 

dispensed, packaged, and shipped back to the store, directly to the patient, or to a nursing 

home.  

 

Request Counselling – Prompts for counselling on the client side. 
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Request Rx Receipt – Prompts for a receipt. 

Allow Backorders – Allows Rxs to be filled even if there is insufficient drug quantity. 

Prevent Order if Rxs need verification – Prevents users from completing orders for Rxs that 

require verification. 

Prevent Order if not billed – Prevents users from completing orders if the order has not been 

billed/adjudicated. 

Request Invoice – Prints an invoice showing a successful transfer. 

Request Packing Slip – Requests the CF facility to include either an invoice and/or a packing slip 

with an order. 

Dynamically create orders when filling Rxs – Automatically creates a CF order to be sent to the 

CF host when filling an Rx. 

Prompt to Send Now – Prompts users to immediately send CF orders to the CF host. 

Default destination – Allows users to choose which central fill site will be pre-selected as the 

destination for data transmission.  

Prompt For CF Refusal Reason – Prompts users to enter a refusal reason when choosing to not 

send an Rx to the CF host. 

Prompt For Central Fill Patient Consent if Unknown – Prompts for patient consent if the 

patient consent is unknown. 

Central Fill Requires Patient Consent – A prompt will appear asking if the patient would like to 

participate in the central fill program 

Central Fill requires guardian consent for patient under age [x] – Allows users to set the age at 

which patients will need a parent or guardians permission to participate in the CF program. 

Pre-qualify Nursing Home Rxs for remote packagers – Makes all NH prescriptions eligible to be 

filled by a packager by default. 

Send to CF when Batching (if previously sent) – The system will reference the last time the Rx 

was sent to CF and then send it again when performing a batch fill. The drug must be eligible for 

CF. 
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Prompt to update CF order status before receiving – When receiving a CF order, users will not 

be able to receive the order unless they have updated the order status to a filled state. When 

updating the order status it will send a request to the CF host to find out what the status of the 

order is. 

Override Default Timeouts – Set the timeout parameters for Connection Timeouts, Send 

Timeouts, and Receive Timeouts. 

Outbound Communications  

The Outbound Communications interface works in conjunction with the IVR system (Voiceport 

and VoiceTech). In order for this to be activated, the pharmacy must be using the most recent 

version of the IVR system and the service will need to be installed. Currently, only the Rx Ready 

for Pickup and the Refill Reminder by phone services are used.  

 

  



  Kroll Windows 10 User Manual  

 

476 
 

Other  

The Other tab contains Enhanced PASI (Access Point) and External Interfaces settings. The 

External Interface settings contain several configurable third party interfaces, including 

MedECare, Catalyst, Clearscribe, ZoomMed, WebApi, and PointClickCare. Most of the interfaces 

in this tab are billable and are run through the Kroll Reporting Service Client. 
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Order  

The following section describes the configuration settings available on the Order tab. 

 

Perform Inventory Adjustment – Enables inventory tracking. 

Enable Automatic Ordering – Allows users to use automatic ordering. 

Default Ordering – Use the Base ordering on and Base minimum scripts on menus to specify 

the pharmacy’s reordering parameters. 

Allow “Base ordering On” override at drug pack level – Allows users to change ordering 

options on a drug card level.  

Auto Increment PO Numbers – Automatically assigns PO numbers to drug orders. 

Allow Non Po Receive – Allows users to receive all products into the system whether a PO was 

linked or not.  
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Base reorder on the inventory of the primary product –The primary product will be what is 

used to determine inventory level when there is an order grouping in place.  

Use catalogue CaseQty for linkage – The Case Qty set on the Ordering tab on the F5 - Drug 

screen will be used.  

Default supplier – Allows users to set the pharmacy’s default supplier. 

#of Days to Base Average Daily Usage and Average Script Quantity Calculations on (must be 

integer greater than zero) – default = 100 – The number of days the average usage will be 

calculated on.  

Show warning if Unresolved Purchase Order Greater than 0 days (Zero = do not show 

warning) – If a numeric value is set higher than 0 the system will warn when if a purchase order 

has not been received within the days that are set.  
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AR 

The AR module must be enabled in the Kroll Configuration Parameters screen. There is no 

charge for the AR module; however, pharmacy users should consult with a supervisor or 

manager before enabling it.  

These options should only be set and changed with the customer on the phone to determine 

which option is best suited for their location. 
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To Do  

The To Do tab works in conjunction with the To Do tabs on the Alt-X screen. It is recommended 

that users contact Kroll support before making any To Do configuration changes. 
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Adjudication Configuration 

Adjudication settings in Kroll allow you to configure how data is transmitted to third party 

insurance providers 

The Adjudication Configuration screen has five tabs across the top that allow you to configure 

different parts of the adjudication process. 

 

  



  Kroll Windows 10 User Manual  

 

482 
 

Hosts Tab 

The Hosts tab shows a list of providers and the routes used to communicate with them.  

 

Click Ins or press the Insert key on your keyboard to add a new host. Existing hosts can be 

edited by double-clicking the record or selecting F2.  
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Both actions will call up the Adjudication Host Edit Form where you can enter/edit the 

adjudication host details.  

 

 Name – Select a provider from the menu. 

 Route – Select an adjudication route from the menu. Ensure you select the appropriate 
route for the provider. 

 Sec Route – This is a secondary route that can be configured as the backup route of 
transmission. This is usually a dial-up connection. 

 BIN – Identification number that corresponds with the selected adjudication host. 

 Transmit Timeout – Enter the length of time in seconds that should pass before the 
adjudication service reports that the transmission has failed because it took too long. 

Click Save to save your changes. 
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Routes Tab 

The Routes tab shows the configured routes available to communicate with. It shows the name 

of the route, the type of connection it uses, and the phone number it uses to dial out if it is 

configured as a dial-up connection. The Is Down column indicates whether you should mark the 

route as ‘down’ after a failed adjudication attempt if the connection is not available. 

 

Click Ins or press the Insert key on your keyboard to add a new route. Existing routes can be 

edited by double-clicking the record or selecting F2.  
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Both actions will call up the Adjudication Route Edit Form where you can enter/edit the 

adjudication route details.  

 

 Name – Enter a name for the adjudication route. 

 Node Type – Select a node type from the menu. Options include TCP, Direct, SPDP, POS 
Service, and Dial-up. The selected node type may change the data fields in the 
configuration form. 

 Route Type – Select a route type from the menu. Options include Production, Testing, 
Development, Training, and Certification.  

 Protocol – Select a protocol type from the menu. The selected protocol may change the 
fields in the configuration form according to what is required for the protocols 
connection. 

Click Save to save your changes. 
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Nodes Tab 

The Nodes tab shows where each connection type will be routed for communication with third 

party providers. There are usually only two nodes present, though more can be added. Nodes 

are usually set to the system the adjudication service is hosted on. 

 

Click Ins or press the Insert key on your keyboard to add a new route. Existing routes can be 

edited by double-clicking the record or selecting F2.  

Both actions will call up the Node Edit Form where you can enter/edit the node details.  

 

 Station – Enter the name of your station. 

 Node Type – Select a node type from the menu. Options include TCP, Dial-up, Direct, 
and SPDP. The selected node type may change the data fields in the configuration form. 

 Priority – Select the order in which the node will be used. 

Click Save to save your changes. 
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Modems Tab 

The Modems tab shows a list of all pre-configured modems. Depending on the firmware used 

by the modem and a number of other factors, some configuration changes may be required. 

 

Click Add Modem to add a new modem, Edit Modem to edit an existing modem, and Delete 

Modem to remove a modem from the list. 
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Selecting Add Modem or Edit Modem will call up the Modem Edit Form where you can 
enter/edit the modem details. 

 
 

 Name – Enter the modem name. 

 Config cmd – Each modem has a unique configuration string. It is important that you 
enter the correct initialization string, as this determines if the configured modem will 
function. Websites such as Modem Help or Jay’s Page of of Modem Inits can assist in 
finding an initialization string if the string for the modem is unknown. 

 Hangup Cmd – This command is used to end the connection on the phone line, thus 
terminating data transmission. This field is usually set to ‘DTR’. 

Click OK to save your changes. 

CPHA Field Transfers Tab 

The CPHA Field Transfers tab determines what type of information is sent and in what field 

when an Rx is sent for adjudication.  

  

Click Ins or press the Insert key on your keyboard to add a new field transfer. Existing field 

transfers can be edited by double-clicking the record or selecting F2.  

  

http://www.modemhelp.org/inits/
http://www.west.net/~jay/modem/
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Both actions will call up the CPHA Field Transfers form where you can enter/edit the field 

transfer details.  

 

 When the Plan (Adj Host) is – Select the adjudication host the field transfer will be 
applied to. 

 And the Drug Price Group is – Select the drug price group that must be used in order for 
the field transfer to be applied. If you select <Any Price Group>, the field transfer will be 
applied regardless of the selected price group.  

 And this Plan is – Indicate whether the drug plan must be the primary or secondary plan 
in order for the field transfer to be applied. 

 and the Rx Primary Plan is – Indicate what Rx primary plan must be used in order for 
the field transfer to be applied. This option is only available when the ‘And this Plan’ is 
field is set to Secondary. 

 Send the ____ in the ____ field – Use these fields to indicate what piece of information 
should appear in what field. Options in the ‘Send the’ menu include Cost, Markup, Fee, 
and Mix Fee; options in the other menu include Do Nothing, Cost, Markup, Fee, and Mix 
Fee.   

Click OK to save your changes. 
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Hours of Operation 

Hours of operation can be configured by accessing File > Configuration > Hours of Operation. 

The Pharmacy Hours of Operation screen will appear. 

 

Use the dropdown menus next to each day to indicate whether the store is Open or Closed. 

Click Ins from the Holiday Hours section to set holiday hours. The Edit Pharmacy Holiday Hours 

of Operation form will appear where you can select a date, and open or closed status, and 

hours of operation for that day. 
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Permissions 

The Permissions settings in Kroll can be configured to allow or prevent access to certain areas 
within the software to specific user groups. Each user group can be assigned a unique set of 
permissions. Ensure you have set up one or more user groups before proceeding.  

Assigning Permissions 

 From the Alt-X Start screen, go to File > Configuration > Permissions and select the user 1.
group you want to set permissions for. 

 

 Enter your login credentials and click OK. 2.
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 Place a checkmark next to the actions you want to give the selected user group permission 3.
to perform. Click OK. 

 

Group Permissions Descriptions 

View Clinical Info – Controls whether you have access to view any patient related drug 

information. When unchecked, you will not have access to view patient allergies and 

conditions, patient profile, or F12 screen. You can access individual drugs and doctors, but not 

as it pertains to a specific patient. 

Allow Viewing Rx Screen – Allows you to access the F12 screen. 

View Patient – Allows you to search for and access patient profiles. If unchecked, you will be 

able to refill prescriptions but you will not be able to fill new prescriptions. 

Allow Patient Changes – Allows you to make changes to patient profiles. 

View Doctor – Allows you to search for and access doctor profiles. If unchecked, you will be 

able to refill prescriptions but you will not be able to fill new prescriptions. 

Allow Doctor Changes – Allows you to make changes to doctor profiles. 

View Drug/Mixture – Allows you to search for and access drug/mixture profiles. If unchecked, 

you will be able to refill prescriptions but you will not be able to fill new prescriptions. 

Allow Drug/Mixture Changes – Allows you to make changes to drug/mixture profiles. 
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Allow Drug Bases Changes – Allows you to make drug base changes. If unchecked, you will only 

be able to change variable drug information like pricing and on-hand quantities. 

Allow Adding New Drugs/Packs – Allows you to add and copy new drugs into the database. If 

unchecked, you will only have permission to add new pack sizes to existing drugs. 

Allow Drug Price Changes – Allows you to make drug price changes. 

Allow Drug Inventory Changes – Allows you to make changes to the on-hand and 

min/max/days fields. You will also be able to enable the No Inventory Adjustment and Disable 

Automatic Ordering flags on the F5 screen. 

Allow Custom FDB Changes – Allows you to make customized FDB changes to counseling 

messages, Kroll Care, and auxiliary labels. 

Allow Creation of Purchase Orders – Allows you to generate and send purchase orders. 

Apply Drug Inventory Counts – Allows you to generate cycle counts.  

View Financial Reports – Allows you to view the following financially sensitive reports: 

Patient Reports 

 Medical Expense 

 Patient Drug Summary 

 Patient Mailing List 

Rx Reports 

 Network Totals Adjudication Totals Claims Invoice 

 Compound Prescription Audit Report Coughlin Import 

 Daily/Monthly Totals 

 NIHB Claims Invoice 

 Plan Billing Summary Plan Breakdown Plan Discount Report Plan Summary 

 Prescription Sales Analysis 

 Price Strategy Summary Profit/Loss 

 Rx Breakdown 

 Rx for Drug/Doctor Groups Rx Summary 

 Rx Totals Report 

 Special Services Fee Report 

 Time Distribution Report 

Drug Reports 

 Drug Inventory Listing Report 

 Drug Listing Report 
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 Drug Price Change Report 

 Drug Usage Report 

 Generic Sales Analysis Report 

 Inventory Report 

Nursing Home Reports 

 Nursing Home Drug Usage Report 

 Nursing Home Drug Utilization Report 

Administration Reports 

 AR Adjustments Audit Report 

 Pre-Authorized Charges Report 

 Submitted/Received Difference 

Other Reports 

 Mailing List Report 

 Network vs. Adjudication Totals Pre-Authorized Charges Report Price Tree Report 

 Weekly Comparison Report Workflow Data Report 

Old Reports 

 Old Daily Totals 

 Old Monthly Totals 

View Non-Financial Reports – Allows you to view the following non-financial reports: 

Patient Reports 

 Active Drug Listing Report Compliance Label 

 Drug Interaction Analysis Report Eligibility/Physician List 

 Limited Use and Section 8 Expiry Report Limited Use Request 

 MAR Pak Report Medical Expense Invoice Medical History Medication Sheet 

 Patient (Comments Report) 

 Patient Encounters Report 

 Patient Limited Use Report Patient Listing Report Patient Medical Conditions Patient 
Medication Chart Patient Profile Report Persa-Kit 

 Plain Paper MAR 

 Plain Paper TMR 

 Section 8 Request 

 Shipping Report Tax Receipt 

Rx Reports 

 Daily/Weekly Workload Report 

 DUR Letter Report 
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 DUR Repot 

 Future Usage Report 

 Hardcopy Report 

 Narcotic Control Record 

 Narcotic Rx Request Report 

 Refills Due 

 Rx (Comments Report) 

 Rx Stop/Expiry 

 Rx Transfers Report 

 Therapeutic Class Report 

Drug Reports 

 Drug (Comments Report) 

 Drug Inventory History Report 

 Drug Utilization Audit Report 

 Narcotic Report 

Doctor Reports 

 Doctor (Comments Report) 

 Doctor Prescribed Med Report 

 Doctor Rx Filled Report 

 Patient/Primary Prescriber Ratio List 

Nursing Home Reports 

 Active Drug Listing Report 

 Nursing Home (Comments Report) 

 Nursing Home Passtimes Report 

 Nursing Home Patient Listing Report 

 Nursing Home Patient Statistics 

 Standing Orders Recall Report 

Administration Reports 

 User Information Report 

 
Other Reports 

 AR (Comments Report) 

 Comments Report 

 Delivery Order Summary Report 
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 ToDo Report 

Old Reports 

 Old Dispill (Style 1) Report 

 Old Dispill (Style 2) Report 

Allow Running Reports for All Patients – Allows you to run patient reports. 

View AR Information – Allows you to access the Patient AR Profile screen. 

Add AR Charges – Allows you to charge items to patients’ Accounts Receivable accounts.  

Edit/Delete AR Charges – Allows you to edit and delete charge items in patients’ Accounts 

Receivable accounts.  

Add AR Payments – Allows you to add payment items to the Payments tab on the patient’s 

Accounts Receivable profile.  

Edit/Delete AR Payments – Allows you to edit and delete payment items from the Payments 

tab on the patient’s Accounts Receivable profile.  

Run AR Reports – Allows you to access the AR Adjustment Audit Report and the AR Taxes 

Breakdown Report.  

View Credit Card Numbers – Allows you to view, add, delete, and edit patient credit card 

entries. 

Allow Credit Card Password Management – Allows you to access the credit card password 

manager, located in the Utilities menu.  

Allow Merges – Allows you to merge duplicate patient, drug, and doctor records. 

Allow Viewing History Records – Allows you to view history records from the Patient, Drug, and 

Doctor screens.  

Allow Use of Drug Update Utility – Allows you to update drug configuration and drug fields for 

multiple drug records at the same time.  

Allow Manual Communication Queue Changes – Allows you to manually change the 

communication queue. Only applicable to pharmacies with the Kroll Outbound Call Module 

(OCM). 
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View Deleted Faxes/Network Scans – Allows you to view deleted inbound/outbound faxes and 

network scans.  

Maintenance Permissions 

Change Plans – Allows you to access the Plans tab in the Plans/Pricing screen. 

Change Pricing – Allows you to access the Strategies, Strategy Exceptions, Drug Price Groups, 

Patient Price Groups, and Copay tabs on the Plans/Pricing screen. 

Change Master Lists – Allows you to access the menus in the Master Lists screen. 

Change Users – Allows you to access the Users and Groups screen. 

Change Sig Codes – Allows you to add, edit, and delete Sig codes from the Edit Sig Codes 

screen. 

Change Vendor List – Allows you to add, edit, and delete vendors in the Edit Vendor List screen. 

Change Nursing Homes – Allows you to add, edit, and delete nursing home information in the 

Edit Nursing Home List screen. 

Change Adjudication Config – Allows you to make changes to adjudication configuration. 

Change Head Office Config – Allows you to access the Head Office Configuration Parameters 

screen. 

Change Store Config – Allows you to access the Store-Level Configuration Parameters screen. 

Change Services Config – Allows you to access the Services Configuration screen. 

Change Workflow Config – Allows you to access the Workflow Configuration screen. 

Change Workstation Config – Allows you to access the Workstation Configuration screen. 

Change Central Fill Config – Allows you to access the Central Fill Configuration screen. This 

option is only available to pharmacies that use the Central Fill module. 

Change Province – Allows you to change the system’s default province. 

Change User Permissions – Allows you to access the Edit Permissions screens. 

Change Mail Distribution Lists – Allows you to edit mail distribution lists. 

Manager – Signifies that the user is in the Manager group. 
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Printers 

Printers can be configured by accessing File > Configuration > Printers. The Printer 

Configuration screen will appear, displaying all detected/installed printers. 

 

To edit a printer entry, double-click the printer name or highlight the printer name and click 

Edit. The Edit Printer Settings screen will appear. 
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 Emulation: Select from Laser, Thermal, Epson, Okidata, or Toshiba. Ensure you select 
the appropriate emulation for the printer you are setting up (e.g., do not configure 
thermal emulation for a laser printer). 

 Bar Code: Enter a barcode number that will be used to select a printer when filling an 
Rx. This will allow you to print vial labels using a scanner.  

 Label Offsets: Use the label offsets controls to adjust label alignment.  

 Tray options: The displayed printer trays depend on your printer hardware. Double-click 
an entry or highlight an entry and click Edit to edit a tray. The Edit Tray Settings form 
will appear. Select a paper size for the tray and click OK. 

 

Printer Stocks 

Printer stocks can be configured by accessing File > Configuration > Printer Stocks. The Edit 

Printer Stocks screen will appear. 

 

Click Ins to add a new printer stock or F2 to edit an existing printer stock. The Edit Printer Stock 

form will appear. 

 

 Description: Enter a descriptive name for the printer stock. 
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 Document Type: Select a document type. Options include Laser label, Dot matrix label, 
Thermal label, and Report. Once you select a document type, the Label Style menu will 
appear. 

 Label Style: The available label styles depend on your selected document type.  

Click OK when you are finished. 

Services Configuration 

Services configuration can be set by accessing File > Configuration > Services Configuration. 

The Services Configuration screen will appear. 

 

Specify where each service is located by entering the name of the host computer in the Host 

field located below each service type. Ports can be changed for each service if the service has 

been set up to operate on a port that is different from the default ports.  
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Workstation Configuration Parameters  

This section describes the various configuration settings that are available in File > 

Configuration > Work Station > This Workstation. 

Label Printers 

This section describes the configuration settings available on the Label Printers tab. 

 

F2  – Allows you to modify the settings of each configured printer.  

Ins – Allows you to add a new printer and configure stocks and trays. 

Del – Allows you to delete the configured printers. 

PCL Commands – Allow you to set tray options that are sent as RAW PCL commands to the 
printer.  

Edit Printer Definitions – Allows you to manage the following printer types: IE, Laser, Thermal, 
and Oki Data. Also allows you to configure custom barcodes that allow scanning from handheld 
devices to initiate automatic printing. You can also modify the offsets to move labels left/right 
and up/down. 
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Other Printers 

This section describes the configuration settings available on the Other Printers tab. 

 

Report Printer – Allows you to configure the printer that will be used for printing reports. Select 

a Printer and Tray from the menus. 

Kroll Care Printer – Allows you to configure the printer that will be used for printing Kroll Care 

leaflets. 
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Input Devices 

This section describes the configuration settings available on the Input Devices tab. 

 

Scanner – Allows you to configure a scanner for importing documents and images. 

Resolution – Allows you to configure the dots per inch for higher and lower resolution scans. 

The default is 100DPI. 

Mode – Allows you to specify whether documents and images are scanned in grey scale, black 

and white, or colour. Set to grey scale by default. 

 JPEG Quality – Allows you to compress the image without compromising the quality of the 

image. Maximum is 50%. Set to 40% by default. 

Iterative Crop – Allows for expansive cropping options for more precise image cropping.The 

cycle is repeated several times until the image border is no longer visible or minimally visible. 

Brightness – Allows you to modify the lighting on the scanned image. 

Contrast – Allows you to adjust the sharpness of colours of the scanned image. 

Saturation – Allows you to adjust the intensity of the scanned images colour. 
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This Scanner auto-crops the image – Auto-crops scanned images once they are imported into 

the system. 

Camera – Allows you to configure a camera device. 

Resolution DPI – Allows you to configure the dots per inch from a picture taken from the 

camera. Default is 300DPI. 

JPEG Quality – Allows you to compress images without compromising the image quality. Set to 

80% by default. 

Signature Tablet – If you have signature tables configured in the Kroll Device Helper, a list of 

configured signature tablets will appear in the menu. Select a configured signature tablet and 

click Identify. This will ensure you are prompted to sign the electronic signature when patient 

or pharmacist signatures are required. 

Labels 

This section describes the configuration settings available on the Labels tab. 

 

The Labels tab allows you to configure a custom label header, which overwrites what is 

configured in File > Configuration > Store. Use the controls to specify the Font, Font Size, and 

make the text bold (B), italic (I), or underlined (U). 
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Print Test Page – Prints a test page so you can preview the custom label header. 

Backup 

This section describes the configuration settings available on the Backup tab. 

 

Warn if backup file is older than 2 days – Displays a warning when you logs into Kroll for the 

first time to inform you that the configured backup is older than two days. 

Backup Location – Allows you to configure the file to be backed up each day. 
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General  

This section describes the configuration settings available on the General tab. 

 

Blank screen after [x] minutes – Allows you to specify how many minutes should pass before 

the touch pickup station is locked. 

Use on-screen keyboard in touch mode – Allows you to use the on-screen keyboard to input 

entries. This setting is enabled by default.  

Launch Kroll Device Helper on Startup – Automatically launches the Kroll Device Helper when 

Kroll is launched. 

Auto-detect Devices – Automatically detects barcodes on scanners and signature pads. 

Client Type – Allows you to configure the current environment. If the user environment is using 

the device locally then Windows Thick client should be enabled. If you are using an RDP with a 

Simply Core USB Redirector to redirect the USB device to the RDP environment, then Thin 

Client (Simply Core USB Redirector) should be used. If you is using RDP with Fabulatech USB 

Redirector to redirect the USB device to the RDP environment, then Thin Client (Fabulatech USB 

Redirector) should be used. If you are using RDP with Wyse TCX to redirect the USB device to 

the RDP environment, then Thin Client (Wyse TCX) Redirector should be used. 
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Workflow 

This section describes the configuration settings available on the Workflow tab. 

 

Workflow Queues to Enable on Startup – Displays a list of workflow queues that you can assign 

to the Dashboard of a particular station. The station is only allowed to action upon queues that 

have been enabled.  
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Who to Call Phone List 

If you encounter problems using Kroll, refer to the phone list below. Kroll offers specialized 

support depending on the equipment involved. 

Equipment Supported by Contact 

Workstations 

 
 

Kroll 866-285-4457 

Printers 

 
 

Kroll 866-285-4457 
 

Fax Machines 

 
 

Kroll 866-285-4457 
 

IVR Servers 
 

Kroll 866-285-4457 
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Kroll Helpdesk Information 

Head Office – Toronto 
220 Duncan Mills Road Suite 201 
Toronto, Ontario 
M3B 3J5 
Tel: 416-383-1010 
Toll Free: 1-800-263-5876 
Fax: 416-383-0001 
support@kroll.ca 
 

Western Canada – Edmonton 
#313, 9622 – 42nd Avenue NW 
Edmonton, Alberta 
T6E 5Y4 
 

Eastern Canada – Dartmouth 
33 Ochterloney Street, Suite 260 
Dartmouth, Nova Scotia 
B2Y 4P5 
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